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Product Basics

See these sections to learn about the basic features of your product.

Setting Up the Control Panel

Product Parts Locations

The Sleep Timer

Epson Connect Solutions for Smartphones, Tablets, and More
Using AirPrint

Using Google Cloud Print

Setting Up the Control Panel
See these sections to set up the control panel for use.

Control Panel Buttons and Lights
Using the LCD Screen

Adjusting Control Panel Position
Changing LCD Screen Language
Turning Off Control Panel Sounds
Turning Off Auto Selection Mode
Turning On Quiet Mode

Parent topic: Product Basics

Control Panel Buttons and Lights

5 =
<[k

1  The & power button and the ® power light
2  The m home button
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3 The LCD screen

The up and down arrows (you can also scroll by swiping up and down on the LCD screen with
your finger)

5 The @ CD button
The 3 back button
The ¢ start button

Parent topic: Setting Up the Control Panel

Using the LCD Screen

1  Displays the screen name
2  Displays product status information; tap the icons to display additional menus or information
3 Swipe this area of the LCD screen to scroll up and down

To view a list of the icons and a description of their use, select Help > Icon List.
Parent topic: Setting Up the Control Panel

Adjusting Control Panel Position

You can adjust the position of the control panel to make it easier to access. Raise or lower it to the
desired angle as shown.
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Note: The control panel rises and the output tray slides out automatically when printing starts.
Parent topic: Setting Up the Control Panel

Changing LCD Screen Language

You can change the language used on the LCD screen.
Press the & home button, if necessary.
Press the left or right arrow button and then select Setup.
Scroll down and select Basic Setup.
Scroll down and select Language.
Select a language.

o gk w b

Press the # home button to exit.
Parent topic: Setting Up the Control Panel

Turning Off Control Panel Sounds
You can turn off the sound heard when you press buttons on the control panel.
Press the 4 home button, if necessary.
Press the left or right arrow button and then select Setup.
Select Printer Setup.
Select Sound.
Select Button Press.
Select the Off setting.
Press the # home button to exit.

No gk ow NP
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Parent topic: Setting Up the Control Panel

Turning Off Auto Selection Mode

Auto Selection Mode changes the menu options on the LCD screen automatically depending on the
action you perform. For instance, loading a memory card displays memory card-related menu options on
the screen. You can turn off this feature from the product's control panel.

Press the # home button, if necessary.

Press the left or right arrow buttons and select Setup.
Scroll down and select Guide Functions.

Select Auto Selection Mode.

a M w DN

Turn off the desired options displayed on the screen.
Parent topic: Setting Up the Control Panel

Turning On Quiet Mode

You can reduce the noise the product makes by turning on the Quiet Mode option.
Note: Turning on this setting may reduce print speed.

Press the # home button, if necessary.

Press the left or right arrow buttons and select Setup.
Select Printer Setup.

Scroll down and select Quiet Mode.

Select On.

Press the # home button to exit.

o 0k bR

Parent topic: Setting Up the Control Panel

Product Parts Locations
See these sections to identify the parts on your product.

Product Parts - Top
Product Parts - Front
Product Parts - Inside
Product Parts - Back
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Parent topic: Product Basics

Product Parts - Top

Automatic Document Feeder (ADF)

Edge guide

ADF paper support

ADF output extension

ADF output tray

ADF cover

CD/DVD tray (shown removed and in storage position)

N o o0~ WDN P

©
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1
2

Rear paper feed slot
Paper support

Parent topic: Product Parts Locations

Product Parts - Front

D O~ WN P

Control panel

Output tray

Cassette 1 (upper cassette)
Cassette 2 (lower cassette)
Front cover

Cassette edge guides
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Document cover

Scanner glass

Memory card access light

Memory card slot

# USB Type A port for external devices

a b~ W N P

Parent topic: Product Parts Locations

Product Parts - Inside
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1  Scanner unit
2 Print head/ink cartridge holder

Parent topic: Product Parts Locations

Product Parts - Back

AC inlet
Rear cover
LAN port
LINE port
EXT port
USB port

D O~ W N P

Parent topic: Product Parts Locations

The Sleep Timer

The product enters sleep mode if it is not used for a period of time. You can adjust the time period before
sleep mode, but increasing the time reduces the product's energy efficiency.

Changing the Sleep Timer Setting From the Control Panel
Changing the Sleep Timer Setting - Windows
Changing the Sleep Timer Setting - Mac OS X

Parent topic: Product Basics
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Changing the Sleep Timer Setting From the Control Panel
You can use the product's control panel to change the time period before the product enters sleep mode.
1. Press the # home button, if necessary.
2. Press the left or right arrow button and then select Setup.
3. Select Printer Setup.
You see this screen:

Printer Setup

CD/DVD Alignment

Thick Paper

Sound
'—#

4. Press the up or down arrow buttons to select Sleep Timer.
You see this screen:

Sleep Timer

Iminutes

Sminutes

10minutes
'—lﬁu
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5. Press the up or down arrow buttons to select the time period you want before the product goes to
sleep.

6. Pressthe # home button to exit.
Parent topic: The Sleep Timer

Changing the Sleep Timer Setting - Windows
You can use the printer software to change the time period before the printer enters sleep mode.
1. Do one of the following:
» Windows 8: Navigate to the Start screen, right-click the screen, and select Devices and
Printers. Right-click your product name and select Printing Preferences.

e Windows 7: CIickE]' and select Devices and Printers. Right-click your product name and select
Printing Preferences.

* Windows Vista: Click E‘ and select Control Panel. Click Printer under Hardware and Sound,
right-click your product name, and select Printing Preferences.

* Windows XP: Click Start and select Printers and Faxes. (Or open the Control Panel, select
Printers and Other Hardware if necessary, and select Printers and Faxes.) Right-click your
product name and select Printing Preferences.

Click the Maintenance tab.
Click the Printer and Option Information button.
You see the Printer and Option Information screen:
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Option information has already been stored, Therefore, you do not need to
enter any information.

[] chedk paper width before printing
(] Thick paper and envelopes

[ ] [cme

4. Select the time period you want before the product goes to sleep as the Sleep Timer setting.
5. Click Send.

6. Click OK to close the open program windows.

Parent topic: The Sleep Timer

Changing the Sleep Timer Setting - Mac OS X
You can use the printer software to change the time period before the printer enters sleep mode.
1. Do one of the following:

* Mac OS X 10.6/10.7/10.8: In the Apple menu or the Dock, select System Preferences. Select
Print & Fax or Print & Scan, select your product, and select Options & Supplies. Select Utility
and select Open Printer Utility.

» Mac OS X 10.5: In the Apple menu or the Dock, select System Preferences. Select Print & Fax,
select your product, and select Open Print Queue. Select Utility.

2. Select Printer Settings.
You see this screen:
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8 0 Epson Printer Utility 4

@

Buy Epson Ink

10 minutes

Cancel | Apply |

3. Select the time period you want before the product goes to sleep as the Sleep Timer setting.
4. Click Apply.

5. Close the Printer Settings window.

Parent topic: The Sleep Timer

Epson Connect Solutions for Smartphones, Tablets, and More

You can print documents, photos, emails, and web pages from your home, office, or even across the
globe. You can use your smartphone, tablet, or computer. Epson offers these solutions to print and scan

from anywhere: Epson Email Print, Epson iPrint Mobile App, Epson Remote Print, and Epson Scan to
Cloud.

Using Epson Email Print

Using the Epson iPrint Mobile App
Using Epson Remote Print

Using Epson Scan to Cloud

Parent topic: Product Basics
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Using Epson Email Print

With Epson Email Print, you can print from any device that can send email, such as your smartphone,
tablet, or laptop. Just activate your product's unique email address. When you want to print, attach a
PDF, Microsoft Office document, or photo and send an email to your product.

1. Set up your product for network printing as described on the Start Here sheet.

2. Ifyou did not already set up Email Print when you installed your product software, visit
epson.com/connect to learn more about Email Print, check compatibility, and get detailed setup
instructions.

3. Send an email with attachments to your product's Email Print address.

Note: Both the email and any attachments print by default. You can change these printing options by
logging into your Epson Connect account.

Parent topic: Epson Connect Solutions for Smartphones, Tablets, and More

Related topics
Wi-Fi or Wired Networking

Using the Epson iPrint Mobile App

Use this free Apple and Android app to print to nearby Epson networked products. The Epson iPrint
Mobile App lets you print PDFs, Microsoft Office documents, photos, and web pages over a wireless
network. You can even scan and save a file on your device, send it as an email, or upload it to an online
service such as Box, Dropbox, Evernote, or Google Drive.

1. Setup your product on a network as described in this manual. See the links below.

2. Visit epson.com/connect to learn more about Epson iPrint and check the compatibility of your mobile
device.

3. Download Epson iPrint from the Apple App Store or Google Play.

4. Connect your mobile device to the same wireless network that your product is using.
5. Print from your mobile device to your Epson product.

Parent topic: Epson Connect Solutions for Smartphones, Tablets, and More

Related topics
Wi-Fi or Wired Networking
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Using Epson Remote Print

With Epson Remote Print software on your Windows computer or laptop, you can print to an Epson
Email-enabled product anywhere in the world.

1. Visit epson.com/connect to learn more about Remote Print and how to download the software.
2. Download and install the Remote Print software.

3. Obtain the email address and optional access key of the Epson product you want to use for printing,
and enter this address during Remote Print setup.

4. Select the print command in your application and choose the Remote Print driver for your Epson
product.

Parent topic: Epson Connect Solutions for Smartphones, Tablets, and More

Related topics
Wi-Fi or Wired Networking

Using Epson Scan to Cloud

The Epson Scan to Cloud service sends your scanned files to a destination that you have registered with
Epson Connect.

1. Setup your product for network printing as described on the Start Here sheet.

2. Visit epson.com/connect for instructions on registering an account and your product with Epson
Connect.

3. After registering, sign in to the Epson Connect web page with the email address and password you
selected.

4. Select Destination List for Scan to Cloud.
5. Click Add, then follow the instructions on the screen to create your destination list.

6. When you're ready to scan, select the setting for the Scan to Cloud service on your product control
panel.

Parent topic: Epson Connect Solutions for Smartphones, Tablets, and More

Related tasks
Starting a Scan Using the Product Control Panel

Related topics
Wi-Fi or Wired Networking
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Using AirPrint

AirPrint allows you to wirelessly print to your AirPrint-enabled product from iPhone, iPad, and iPod touch
running the latest version of iOS.

1. Set up your product for wireless printing as described on the Start Here sheet.

2. Connect your Apple device to the same wireless network that your product is using.
3. Print from your iPad, iPhone, or iPod touch to your product.

Parent topic: Product Basics

Related topics
Wi-Fi or Wired Networking

Using Google Cloud Print

With a Google Account, you can print from your Apple or Android device to your Epson product. You can
also print from Chromebooks and the Google Chrome browser without drivers or cables.

If you are setting up your product for the first time, set up your Epson product for network printing as
described on the Start Here sheet.

Note: Make sure your Epson printer and computer are connected to the same network before starting
the Google Cloud Print setup.

If your product is already on your network, follow these steps:

1. Connect your device to the same network that your Epson product is using.
Print a network status sheet.

Locate your product's IP address on the network status sheet.

Enter the IP address into the address bar of a web browser.

a r w DN

Select the Google Cloud Print Services option.

Note: If you don't see the Google Cloud Print Services option, turn your product off and back on. If
the option still doesn't appear, select the Firmware Update option and follow the on-screen
instructions to update your product.

Click Register.
7. Select the check box to agree to the Usage Advisory and click Next.
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8. Click OK to launch the sign-in page.
A separate browser window opens.

9. Enter your Google Account username and password and click Sign in, or, if you don't have an
account, click Sign up for a new Google Account and follow the on-screen instructions.

10. Click Finish printer registration to complete setup and print a test page.

Your product is how linked to your Google Account and can be accessed from any Chromebook,
computer, Apple or Android device with internet access. Visit Epson Support for more information on
using Google Cloud Print, or the Google Cloud Print website for a list of supported apps.

Parent topic: Product Basics

Related tasks
Printing a Network Status Sheet

Related topics
Wi-Fi or Wired Networking
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Wi-Fi or Wired Networking

See these sections to use your product on a Wi-Fi or wired network.

Wi-Fi Infrastructure Mode Setup

Wi-Fi Direct Mode Setup

Wi-Fi Protected Setup (WPS)

Wired Network Setup

Printing a Network Status Sheet

Changing or Updating Network Connections

Wi-Fi Infrastructure Mode Setup

You can set up your product to communicate with your computer using a wireless router or access point.
The wireless router or access point can be connected to your computer over a wireless or wired network.

Wireless router or access point

Epson product

Computer with a wireless interface

A W N P

Computer
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5 Internet

6  Ethernet cable (used only for wired connection to the wireless router or access point)

Selecting Wireless Network Settings From the Control Panel
Parent topic: Wi-Fi or Wired Networking

Selecting Wireless Network Settings From the Control Panel
You can select or change wireless network settings using your product control panel.

To install your product on a wireless network, follow the instructions on the Start Here sheet and install
the necessary software from the product CD. The installer program guides you through network setup.

Note: Breakdown or repair of this product may cause loss of fax and network data and settings. Epson is
not responsible for backing up or recovering data and settings during or after the warranty period. We
recommend that you make your own backup or print out your fax and network data and settings.

Press the m home button, if necessary.
Select Wi-Fi Setup.
You see this screen:

Wi-Fi Setup

Wi-Fi/Hetwork Status

Wi-Fi Setup Wizard

Push Button Setup (MPS)
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3. Select Wi-Fi Setup Wizard.

Note: If you need to disable the wireless network to set up your product on an Ethernet network,
scroll down and select Disable Wi-Fi instead. Then follow the instructions on changing to a wired
network connection in this guide.

4. Select the name of your wireless network or enter the name manually.

Note: To enter the wireless network name manually, scroll down and then select Other Networks.
Use the displayed keypad to enter your network name, as described in the next step.

5. Enter your wireless password (or network name and then password) using the displayed keypad.

Enter Password

] st || 2 pEC 3 rer

4 L™ B Space

8 9wz €34

i — Done

Note: The network name and password are case sensitive. Be sure to correctly enter uppercase and
lowercase letters, and numeric or special characters.

« Press the touch screen buttons repeatedly to scroll through characters.
* Press g or =a to move the cursor.
* Press 1 Symb. to enter symbols.
« Press kA to delete the previous character.
6. Press Done when you're finished entering your password.
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7. Confirm the displayed network settings and select Proceed to save them.
Note: If you need to change a setting, press the 3 back button.

8. If you want to print a network setup report, press the ¢ start button. (Otherwise, select Done.)

If the network connection is successful, a Wi-Fi antenna icon with blue connection bars is displayed
in the upper-left corner of the LCD screen.

UL ~ Home
Print
Copy Photos

Parent topic: Wi-Fi Infrastructure Mode Setup
Related topics
Changing or Updating Network Connections

Wi-Fi Direct Mode Setup

You can set up your product to communicate directly with your computer or another device without
requiring a wireless router or access point.
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1 Epson product
2 Computer with a wireless interface
3  Other wireless device

Your product automatically selects one of these modes to communicate with your computer or device:

Access point mode
If your product is not already connected to a wireless network, it enters access point mode and the
product itself acts as the network access point for up to 4 devices. When operating in this mode, your
product displays an AP connection symbol on the LCD screen.

Peer-to-peer mode
If your product is already connected to a wireless network, it enters peer-to-peer mode and
disconnects from any other networks. This also disables any other product features requiring access
to the Internet. When operating in this mode, your product displays a Direct or D connection symbol
on the LCD screen.

Note: To disconnect a peer-to-peer mode connection, release the connection to your product from
your computer or other device. Your product will reconnect to the previously used network.

Enabling Wi-Fi Direct Mode
Parent topic: Wi-Fi or Wired Networking

Enabling Wi-Fi Direct Mode

You can enable Wi-Fi Direct mode to allow direct communication between your product and computer or
other devices without a wireless router or access point.

1. Pressthe & home button, if necessary.
2. Select Wi-Fi Setup.
You see this screen:
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Wi-Fi Setup

Wi-Fi/Hetwmork Status

Wi-Fi Setup Wizard

Push Button Setup (WPS)

Scroll down and select Wi-Fi Direct Routerless Setup.
Select Connection Setup.
Select Change Password, then select OK.

Note: If you have already connected devices or computers to your product via Wi-Fi Direct, they will
be disconnected when you change the password.

Enter your Wi-Fi Direct password.

Note: Your password must be at least 8 and no more than 22 characters long.
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Enter Password

= __
£ FEr 3 oeF

b o apace

i g Y vz &3

— Done

« Press the touch screen buttons repeatedly to scroll through characters.
* Press g or =a to move the cursor.
* Press 1 Symb. to enter symbols.
» Press k= to delete the previous character.
7. Press Done when you finish entering your password.
You see this screen:

Wi-Fi Direct Routerless Setup

Connecting via Wi-Fi Direct
mode... Select the Wi=Fi
network (S510) below to

establish a connection
to this printer.

8. Scroll down to view the SSID (Wi-Fi network name) and password.
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9. Use your computer or wireless device to select the Wi-Fi network name (SSID) displayed on the
LCD screen, then enter the password shown.

10. Press the # home button to exit.

You see either an AP or Direct connection symbol on the LCD screen and should be able to print
directly to your product from your computer or device.

Note: If the AP or Direct connection symbol is not displayed on the LCD screen, Wi-Fi Direct mode
is not enabled. Repeat these steps to try again.

Parent topic: Wi-Fi Direct Mode Setup

Wi-Fi Protected Setup (WPS)

If your network uses a WPS-enabled wireless router or access point, you can quickly connect your
product to the network using Wi-Fi Protected Setup (WPS).

Note: To check if your router is WPS-enabled, look for a button labeled WPS on your router or access
point. If there is no hardware button, there may be a virtual WPS button in the software for the device.
Check your network product documentation for details.

Using WPS to Connect to a Network
Parent topic: Wi-Fi or Wired Networking

Using WPS to Connect to a Network

If you have a WPS-enabled wireless router or access point, you can use Wi-Fi Protected Setup (WPS) to
connect your product to the network.

1. Pressthe & home button, if necessary.
2. Select Wi-Fi Setup.
You see this screen:
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Wi-Fi Setup

Wi-Fi/Hetwmork Status

Wi-Fi Setup Wizard

Push Button Setup (WPS)

3. Select Push Button Setup (WPS).
Follow the instructions on the LCD screen to complete WPS setup.

If the network connection is successful, a Wi-Fi antenna icon with blue connection bars is displayed
in the upper-left corner of the LCD screen.

UL Home
Print
Copy Photos

Parent topic: Wi-Fi Protected Setup (WPS)

Wired Network Setup

You can set up your product to communicate with your computer over a wired network by connecting it to
the router or hub using an Ethernet cable.
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Epson product

Ethernet cable

Ethernet hub

Computers with a wired network interfaces
Router

D OB~ WN P

Internet
Parent topic: Wi-Fi or Wired Networking

Printing a Network Status Sheet

You can print a network status sheet to help you determine the causes of any problems you may have
using your product on a network.

1. Pressthe & home button, if necessary.
2. Select Wi-Fi Setup.
You see this screen:
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Wi-Fi Setup

Wi-Fi/Hetwmork Status

Wi-Fi Setup Wizard

Push Button Setup (WPS)

3. Select Wi-Fi/Network Status.
You see a screen like this:

Wi-Fi/Network Status _
Printer Hame : PH=T990=D30000

Connection : Wi-Fi-6172.58bps

Signal Strength : Excellent

Obtain IP Address : Auto

Note: If you are connected to a network wirelessly, the signal strength is also displayed.

4. Select Status Sheet, then press the ¢ start button to print the network status sheet.
(Select Cancel if you want to cancel the operation.)

Examine the settings shown on the network status sheet to diagnose any problems you have.

Parent topic: Wi-Fi or Wired Networking
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Changing or Updating Network Connections
See these sections to change or update how your product connects to a network.

Accessing the Web Config Utility

Changing a USB Connection to a Wi-Fi Connection
Changing a Wi-Fi Connection to a Wired Network Connection
Connecting to a New Wi-Fi Router

Disabling Wi-Fi Features

Parent topic: Wi-Fi or Wired Networking

Related tasks
Selecting Wireless Network Settings From the Control Panel

Accessing the Web Config Utility

You can select your product's network settings and confirm its operating status using a web browser.
You do this by accessing your product's built-in Web Config utility from a computer or other device that is
connected to the same network as your product.

1. Print a network status sheet.
2. Locate the IP Address for your product that is listed on the network status sheet.

3. Onacomputer or other device connected to the same network as your product, open a web
browser.

4. Enter your product's IP address into the address bar.
You see the available Web Config utility options.
Parent topic: Changing or Updating Network Connections

Changing a USB Connection to a Wi-Fi Connection

If you have already connected your product to your computer using a USB connection, you can change
to a Wi-Fi connection or add a Wi-Fi connection to print wirelessly.

1. Do one of the following:

« If you want to use only a Wi-Fi connection, disconnect the USB cable from your product. With
Windows, also uninstall your product software.

* If you want to add a Wi-Fi connection in addition to a USB connection, leave the USB cable
connected to your product.
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2. Download your product software from the Epson website, or install it from the CD that came with
your product using the instructions on the Start Here sheet.

Parent topic: Changing or Updating Network Connections

Changing a Wi-Fi Connection to a Wired Network Connection

If you have already connected your product to your computer wirelessly, you can change to a wired
network connection if necessary.

Disable your product's Wi-Fi features.

2. Connect one end of an Ethernet network cable to the product's LAN port.

3. Connect the other end to any available LAN port on your router or access point.

4. Download and install your product software from the Epson website, or install it from the CD that
came with your product.

5. Follow the on-screen instructions to install the software.

6. When you see the Select Your Connection screen, select Wired network connection.

7. Ifyou see a Select Setup Option screen, select Setup printer for the first time.

8. Continue following the rest of the on-screen instructions.

Parent topic: Changing or Updating Network Connections

Connecting to a New Wi-Fi Router

If you change the wireless router you have been using on your network, you can update your product's
Wi-Fi connection to the new router.

1. Do one of the following:
* Windows: Uninstall your product software.
* Mac OS X: Go to the next step.

2. Download your product software from the Epson website, or install it from the CD that came with
your product using the instructions on the Start Here sheet.

Parent topic: Changing or Updating Network Connections

Disabling Wi-Fi Features

You may need to disable your product's Wi-Fi features if you change your network connection type or
need to solve a problem with your network connection.
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Note: Before disabling Wi-Fi features, make a note of your product's SSID (network name) and
password, and any network settings selected for the Epson Connect services you may use.

1. Pressthe & home button, if necessary.
2. Select Wi-Fi Setup.
You see this screen:

Wi-Fi Setup

i-Fi/Hetwork Status

Wi-Fi Setup Wizard

Push Button Setup (WPS)

3. Scroll down and select Disable Wi-Fi.
4. Select Yes to disable Wi-Fi.
Parent topic: Changing or Updating Network Connections
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Loading Paper

Before you print, load paper for the type of printing you will do.

Loading Paper in Cassette 1 (Upper Cassette)
Loading Paper in Cassette 2 (Lower Cassette)
Loading Paper in the Rear Paper Feed Slot
Loading Envelopes

Paper Loading Capacity

Available Epson Papers

Borderless Paper Type Compatibility

Paper or Media Type Settings

Loading Paper in Cassette 1 (Upper Cassette)
You can load photo paper and other media in these sizes in the upper paper cassette:
* 3.5x5inches (89 x 127 mm)
* 4 x6inches (102 x 152 mm)
e 5x7inches (127 x 178 mm)
A6 (4.1 x 5.8 inches [105 x 148 mm])
* 16:9 wide (4 x 7.1 inches [102 x 181 mm)])

Note: Do not remove or insert the paper cassette during printing.

1. Close the output tray, if necessary.
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Note: As you slide in the output tray, there may be slight resistance and noise. This is normal.

Open the front cover.

Note: If the cassette is too far inside the product to reach, turn the product off and then back on
again to reset the cassette's position.

Slide the edge guides outward.
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Set the front edge guide to the position for the paper size you are using.

Note: Various paper sizes are marked on the tray.

Insert paper with the glossy or printable side facedown.

Note: Make sure the paper is loaded against the front edge guide.

Slide the side edge guides against the paper, but not too tightly.

Note: Make sure the paper is under the tabs on the edge guides.
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8. Keep the cassette flat as you insert it until the left and right arrow marks on the tray and product line
up.

Note: The output tray opens automatically when you print. Leave enough space in front of the
product for the paper to be fully ejected. Do not remove or insert the paper cassette while the
product is operating.

Always follow these paper loading guidelines:
» Load only the recommended number of sheets.
» Load paper short edge first and printable side facedown.

» Make sure the paper is under the tabs on the edge guides and not sticking out from the end of the
cassette.

» Check the paper package for any additional loading instructions.
Parent topic: Loading Paper

Related references

Paper Loading Capacity

Related tasks

Loading Paper in Cassette 2 (Lower Cassette)

Loading Paper in the Rear Paper Feed Slot
Loading Envelopes
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Loading Paper in Cassette 2 (Lower Cassette)
You can load paper up to this size in the lower paper cassette: Legal (8.5 x 14 inches [216 x 357 mm]).

Note: Do not remove or insert the paper cassette during printing.

1. Close the output tray, if necessary.

Note: As you slide in the output tray, there may be slight resistance and noise. This is normal.

2. Open the front cover.
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Slide the edge guides outward.

Note: If you are using legal-size paper, remove the CD/DVD tray from the product. Press the button
on the cassette and then extend it as shown.

Note: Various paper sizes are marked on the tray.

Insert paper with the glossy or printable side facedown.
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Note: Make sure the paper is loaded against the edge guide and not sticking out from the end of the
cassette.

7. Slide the side edge guides against the paper, but not too tightly.

Note: Make sure the paper is under the tabs on the edge guides.

8. Keep the cassette flat as you insert it.

Note: The output tray opens automatically when you print. Leave enough space in front of the
product for the paper to be fully ejected. Do not remove or insert the paper cassette while the
product is operating.

Always follow these paper loading guidelines:
» Load only the recommended number of sheets.
» Load paper short edge first and printable side facedown.
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» Make sure the paper is under the tabs on the edge guides and not sticking out from the end of the
cassette.

» Check the paper package for any additional loading instructions.
Parent topic: Loading Paper

Related references

Paper Loading Capacity

Related tasks

Loading Paper in Cassette 1 (Upper Cassette)

Loading Paper in the Rear Paper Feed Slot
Loading Envelopes

Loading Paper in the Rear Paper Feed Slot

You can load card stock, envelopes, and other thick media in the rear paper feed slot.
Note: Paper that is too stiff may not load correctly. Check the paper specifications.

1. Send your print job from a computer or using the product's touch screen.

* If printing from a computer, select Rear Paper Feed Slot for the Source (Windows) or Paper
Source (Mac OS X) setting.

* If printing from the product's touch screen, select Rear Paper Feed Slot for the Paper Source
setting.

2. Flip open the rear paper feed slot cover and swing out the paper support.

o, |
Pom -~ =N
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3. Slide the edge guides outward.

4. Do one of the following:

» Load a single sheet of paper or thick media, printable side up and short edge first, in the center of
the rear paper feed slot. Slide the edge guides against the paper, but not too tightly.

« Load an envelope, short edge first with the flap facing down, in the center of the rear paper feed
slot. Slide the edge guides against the envelope, but not too tightly.
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5. Push the paper or envelope down until it meets resistance. About 2 inches (5 cm) of the paper
should be fed inside the printer as shown.

1 2inches (5cm)
6. When you are ready to print, press the & start button.
Note: To cancel printing, select Cancel.

Always follow these loading guidelines:

» Load one sheet or envelope at a time.

» Load the paper or envelope short edge first and printable side faceup.
» Check the paper package for any additional loading instructions.
Parent topic: Loading Paper

Related references

Paper Loading Capacity

Paper Specifications

Related tasks

Loading Paper in Cassette 1 (Upper Cassette)
Loading Paper in Cassette 2 (Lower Cassette)
Loading Envelopes
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Loading Envelopes

You can load envelopes in Cassette 2 (lower cassette) as described here. You can print on plain paper
envelopes in this size: No. 10 (4.1 x 9.5 inches [105 x 241 mm]).

You can also load a single envelope in the rear paper feed slot, as described in that section.
Note: Do not remove or insert the paper cassette during printing.

1. Close the output tray, if necessary.

Note: As you slide in the output tray, there may be slight resistance and noise. This is normal.

2. Open the front cover.
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Pull on the front cover to pull out the lower paper cassette.

Note: Make sure the envelope is not sticking out from the end of the cassette.

Slide the edge guides against the envelopes, but not too tightly.

Note: Make sure the envelopes are under the tabs on the edge guides.
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7. Keep the cassette flat as you insert it.

Note: The output tray opens automatically when you print.

Always follow these envelope loading guidelines:

« If you have trouble loading a stack of envelopes, press each envelope flat before loading it or load one
envelope at a time.

» Do not load envelopes that are curled, folded, or too thin.
Parent topic: Loading Paper

Related references

Paper Loading Capacity

Related tasks

Loading Paper in Cassette 1 (Upper Cassette)

Loading Paper in Cassette 2 (Lower Cassette)
Loading Paper in the Rear Paper Feed Slot

Paper Loading Capacity

Load one sheet of paper or one envelope at a time in the rear paper feed slot. See the table here for the
loading capacity of the paper cassettes.
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Paper type Load up to this many sheets
Cassette 2 (lower cassette) Cassette 1 (upper cassette)
Plain paper Letter (8.5 x 11 inches —

[216 x 279 mm]), A4 (8.3 x 11.7
inches [210 x 297 mm]), or Legal
(8.5 x 14 inches [216 x 357 mm])
size: 100 sheets

Epson Bright White Paper
Epson Presentation Paper Matte

80 sheets

Epson Premium Presentation
Paper Matte

Epson Ultra Premium Presentation
Paper Matte

20 sheets

Epson Photo Paper Glossy

Epson Premium Photo Paper
Glossy

Epson Ultra Premium Photo Paper
Glossy

Epson Premium Photo Paper
Semi-gloss

Epson Ultra Premium Photo Paper
Luster

20 sheets

20 sheets

Epson Premium Presentation
Paper Matte Double-sided

Epson Photo Quality Self-adhesive
Sheets

Epson Iron-on Cool Peel Transfer
paper

Epson Brochure & Flyer Paper
Matte Double-sided

1 sheet

Envelopes

10 envelopes

Parent topic: Loading Paper
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Available Epson Papers

You can purchase genuine Epson ink and paper at Epson Supplies Central at epson.com/ink3 (U.S.
sales) or epson.ca (Canadian sales). You can also purchase supplies from an Epson authorized reseller.
To find the nearest one, call 800-GO-EPSON (800-463-7766).

Paper Type Size Part number Sheet count
Epson Bright White Paper Letter (8.5 x 11 inches S041586 500
[216 x 279 mm])
Epson Photo Paper Glossy 4 x 6 inches (102 x 152 mm) | S041809 50
S042038 100
Letter (8.5 x 11 inches S041141 20
[216 > 279 mm]) 5041649 50
S041271 100
Epson Premium Photo Paper 4 x 6inches (102 x 152 mm) |S041808 40
Glossy S041727 100
5x 7inches (127 x 178 mm) |S041464 20
8 x 10 inches (203 x 254 mm) |S041465 20
Letter (8.5 x 11 inches S042183 25
[216 > 279 mm]) 5041667 50
Epson Ultra Premium Photo Paper |4 x 6 inches (102 x 152 mm) | S042181 60
Glossy S042174 100
5x 7 inches (127 x 178 mm) | S041945 20
8 x 10 inches (203 x 254 mm) |S041946 20
Letter (8.5 x 11 inches 5042182 25
[216 x 279 mm]) S042175 50
Epson Ultra Premium Photo Paper | Letter (8.5 x 11 inches S041405 50
Luster [216 x 279 mm])
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[216 x 279 mm])

Paper Type Size Part number Sheet count
Epson Premium Photo Paper 4 x 6 inches (102 x 152 mm) |S041982 40
Semi-gloss Letter (8.5 x 11 inches S041331 20
[216 x 279 mm])
Epson Presentation Paper Matte | Letter (8.5 x 11 inches S041062 100
[216 x 279 mm])
Legal (8.5 x 14 inches S041067 100
[216 x 357 mm])
Epson Premium Presentation 8 x 10 inches (203 x 254 mm) |S041467 50
Paper Matte Letter (8.5 x 11 inches S041257 50
[216 > 279 mm]) 5042180 100
Epson Premium Presentation Letter (8.5 x 11 inches S041568 50
Paper Matte Double-sided [216 x 279 mm])
Epson Ultra Premium Presentation | Letter (8.5 x 11 inches S041341 50
Paper Matte [216 x 279 mm])
Epson Brochure & Flyer Paper Letter (8.5 x 11 inches S042384 150
Matte Double-sided [216 x 279 mm])
Epson Photo Quality Self-adhesive | A4 (8.3 x 11.7 inches S041106 10
Sheets [210 x 297 mm])
Epson Iron-on Cool Peel Transfer |Letter (8.5 x 11 inches S041153 10
paper [216 x 279 mm])
Epson Velvet Fine Art Paper Letter (8.5 x 11 inches S041636 20

Parent topic: Loading Paper

Borderless Paper Type Compatibility

You can print borderless photos on compatible paper types in compatible sizes:

Borderless Paper Types
» Epson Photo Paper Glossy

» Epson Premium Photo Paper Glossy
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» Epson Ultra Premium Photo Paper Glossy

» Epson Premium Photo Paper Semi-gloss

» Epson Ultra Premium Photo Paper Luster

» Epson Premium Presentation Paper Matte

* Epson Ultra Premium Presentation Paper Matte

Borderless Paper Sizes

e 3.5x5inches (89 x 127 mm)

4 x 6 inches (102 x 152 mm)

16:9 wide (4 x 7.1 inches [102 x 181 mm])
5 x 7 inches (127 x 178 mm)

8 x 10 inches (203 x 254 mm)

Letter (8.5 x 11 inches [216 x 279 mm])
A4 (8.3 x 11.7 inches [210 x 297 mm])
Parent topic: Loading Paper

Paper or Media Type Settings

For this paper Select this paper Type or Media Type setting

Plain paper Plain Paper/Bright White Paper
Epson Bright White Paper

Epson Iron-on Cool Peel Transfer paper
Epson Photo Quality Self-adhesive Sheets

Epson Ultra Premium Photo Paper Glossy Ultra Premium Photo Paper Glossy
Epson Premium Photo Paper Glossy Premium Photo Paper Glossy
Epson Photo Paper Glossy Photo Paper Glossy

Epson Presentation Paper Matte Presentation Paper Matte

Epson Premium Photo Paper Semi-gloss Premium Photo Paper Semi-Gloss
Epson Ultra Premium Photo Paper Luster Ultra Premium Photo Paper Luster
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For this paper Select this paper Type or Media Type setting

Epson Premium Presentation Paper Matte Premium Presentation Paper Matte

Epson Premium Presentation Paper Matte Double-
sided

Epson Ultra Premium Presentation Paper Matte
Epson Brochure & Flyer Paper Matte Double-sided

Epson Velvet Fine Art Paper Velvet Fine Art Paper

Envelopes Envelope

Note: The settings listed here are available only when printing from your computer; they do not apply to
your product's control panel settings.

Parent topic: Loading Paper
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Placing Originals on the Product

Follow the instructions here to place your original documents or photos on the product.

Caution: Do not place anything on top of your product or use its cover as a writing surface to avoid
damaging it.

Placing Originals on the Scanner Glass
Placing Originals in the Automatic Document Feeder

Placing Originals on the Scanner Glass

You can place originals up to this size on the scanner glass: Letter (8.5 x 11 inches [216 x 279 mm]) or
A4 (8.3 x 11.7 inches [210 x 297 mm]).

1. Open the document cover.

2. Place your original facedown on the scanner glass with the top of the original facing into the corner
shown. Slide the original to the edges of the indicated corner.

Note: You can place multiple originals on the scanner glass. Just make sure they are at least 0.20
inch (5 mm) away from each other and from the edge of the scanner glass.

64



3 i€ e

3. Ifyou are copying two book pages onto one sheet, place the book as shown to copy the first page,
then turn the book as shown to copy the second page.

.......

4. Close the document cover gently to keep your original in place.
Parent topic: Placing Originals on the Product
Related topics

Copying
Scanning
Faxing

Placing Originals in the Automatic Document Feeder

You can place multi-page original documents in the Automatic Document Feeder (ADF). Make sure the
originals meet the Automatic Document Feeder specifications before loading them.

Caution: Make sure your originals are not creased or folded, and do not contain holes, staples, tape, or
other materials that could obstruct the feeder.
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1. Open the ADF paper support, and then slide out the output tray extension.

3. Fan your stack of originals and tap them gently on a flat surface to even the edges.

4
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4. Insert the originals into the ADF faceup and top-edge first.

Note: If you're using the Letter, 2-up Copy, or A4, 2-up Copy layout, make sure the originals are
loaded as shown.
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Parent topic: Placing Originals on the Product

Related references

Automatic Document Feeder (ADF) Specifications
Related topics

Copying

Scanning

Faxing
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Copying

See the information here to copy documents or photos using your product.
Note: Copies may not be exactly the same size as your originals.

Copying Documents or Photos
Copying and Restoring Photos

Related tasks
Copying onto a CD/DVD

Copying Documents or Photos

You can copy documents or photos onto various sizes and types of paper, including Epson special
papers.

1. Place your original document or photo on the scanner glass, or load your documents in the ADF.
2. Load the paper you want to print on.

Note: Load only the recommended number of sheets.
3. Select Copy.

1»1-5ided, with Border

— 1 + Preview

Coed
Color

4. To print more than one copy, press + or — to select the number (up to 99).
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5. Select Color or B&W.

Scroll down to view and change additional copy settings, if necessary.

7. When you are ready to copy, press the & start button.

Note: To cancel printing, select Cancel.

Paper Type Settings - Copying
Paper Size Settings - Copying
Copying Options

Parent topic: Copying

Related references

Paper Loading Capacity
Available Epson Papers
Related topics

Loading Paper

Placing Originals on the Product

Paper Type Settings - Copying

Select a Paper Type setting that matches the paper you loaded.

Paper type loaded

Paper Type setting

Plain paper

Epson Bright White Paper

Epson Presentation Paper Matte

Epson High Quality Ink Jet Paper

Epson Iron-on Cool Peel Transfer paper
Epson Photo Quality Self-adhesive Sheets

Plain Paper

Epson Premium Presentation Paper Matte
Epson Ultra Premium Presentation Paper Matte

Epson Premium Presentation Paper Matte Double-sided

Matte
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Paper type loaded

Paper Type setting

Epson Premium Photo Paper Glossy
Epson Premium Photo Paper Semi-gloss
Epson Ultra Premium Photo Paper Luster

Prem. Glossy

Epson Ultra Premium Photo Paper Glossy

Ultra Glossy

Epson Photo Paper Glossy

GlossyGlossy

Parent topic: Copying Documents or Photos

Paper Size Settings - Copying

Select the Paper Size setting that matches the paper you loaded.

Note: You can copy photos only on these paper sizes.

* 4 x6inches (102 x 152 mm)
* 5x 7inches (127 x 178 mm)

8 x 10 inches (203 x 254 mm)
Letter (8.5 x 11 inches [216 x 279 mm])
A4 (8.3 x 11.7 inches [210 x 297 mm])

e Legal (8.5 x 14 inches [216 x 357 mm])
Parent topic: Copying Documents or Photos

Copying Options

Select the copying options you want to use for your copies.

Note: Not all options or settings may be available, depending on other copying settings.

Copying option

Available settings

Description

Density

Varying levels

Adjusts the lightness or darkness of copies
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Copying option

Available settings

Description

2-Sided Copying 1>1-Sided Uses the duplexer and ADF to make 2-sided
2>2-Sided copies
1>2-Sided
2>1-Sided

Layout With Border Leaves a small margin around the image
Borderless Expands the image to the edge of the paper

(slight cropping may occur)

A4, 2-up Copy Copies 2 originals onto a single A4-size sheet

Letter, 2-up Copy

Copies 2 originals onto a single letter-size sheet

A4, Book/2-up

Copies 2 pages of a book or magazine onto a
single A4-size sheet

Letter, Book/2-up

Copies 2 pages of a book or magazine onto a
single letter-size sheet

Reduce/Enlarge

Custom Size

Automatically sizes the image by the percentage
you select

Actual Size

Copies at 100% size

Auto Fit Page

Automatically sizes the image to fit the selected
paper size setting

Letter->4x6in and other
conversions

Automatically converts from one size to another

Paper Size Various sizes Selects the paper size for the copy printout
Paper Type Plain Paper Adjusts printer settings for the selected paper
Matte type
Prem. Glossy
Ultra Glossy
Glossy
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Copying option

Available settings

Description

Paper Source Cassette 1 Copies onto paper loaded in Cassette 1 (upper
cassette)
Cassette 2 Copies onto paper loaded in Cassette 2 (lower
cassette)
Document Type Text Copies a text document

Text & Image

Copies a document that includes text and
images

Photo

Copies a photograph

Quality

Draft

Provides lower quality for draft copies (plain
paper only)

Standard Quality

Provides good quality for most copies

Best

Provides the highest quality for special copies

Documentation Portrait Specifies the orientation of your originals (only
Orientation available when 2>1-Sided or 1>2-Sided is
Landscape selected)
Binding Direction Left Edge Specifies the binding edge of your double-sided
originals (only available when 2>1-Sided is
Top Edge selected)
Binding Margin Left Edge Specifies the binding edge of your double-sided
copies (only available when 1>2-Sided is
Top Edge selected)
Expansion Standard Adjusts the amount of expansion for printing
Medium borderless photos
Minimum
Dry Time Standard Provides longer drying time for 2-sided copies, if
Lon smudges or marks appear on the front of the
9 paper when you print on the second side
Longer

Clear All Settings

Restores the copy settings to the default settings

Parent topic: Copying Documents or Photos
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Copying and Restoring Photos
You can restore the colors in faded photos as you copy them.
Load photo paper in the product.

2. Press the  home button, if necessary.
3. Select More Functions.
4. Select Copy/Restore Photos.
Copy/Restore Photos
Oit On
If your photo is faded,
select On.
5. Select On.

6. Place up to two original photos on the product.
Note: View the LCD screen for instructions on placing your photos on the product.

7. Press the ¢ start button.
Press + or —to select one or more copies of the photo (up to 99).

9. If you placed two originals on the scanner, press the left or right arrow button to view the second
original, then press + or — to select one or more copies of the photo (up to 99).

10. To adjust your print and copy settings, do one or more of the following:
« To change the print settings, select Settings, and select the necessary settings.
« To adjust the copy image, select Edit > Photo Adjustments, then select your settings.
« To add a B&W filter to the copy, select Edit > Filter, then select the B&W setting.
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< To crop or zoom into your photo, select Edit > Crop/Zoom, then press the icons displayed on the
LCD screen to crop your image.

11. When you are ready to print, press the ¢ start button.
Note: To cancel printing, select Cancel.

Parent topic: Copying

Related references

Paper Loading Capacity

Available Epson Papers

Paper Type Settings - Copying

Paper Size Settings - Copying

Copying Options

Related tasks

Placing Originals on the Scanner Glass

Related topics
Loading Paper
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Printing From a Computer

Before printing from your computer, make sure you have set up your product and installed its software
as described on the Start Here sheet.

Note: If you have an Internet connection, it is a good idea to check for updates to your product software
on Epson's support website. If you see a Software Update screen, select Enable automatic checking
and click OK. The update scans your system to see if you have the latest product software. Follow the
on-screen instructions.

Printing with Windows
Printing with Mac OS X
Cancelling Printing Using a Product Button

Related tasks
Checking for Software Updates

Printing with Windows
You can print with your product using any Windows printing program, as described in these sections.

Selecting Basic Print Settings - Windows

Selecting Advanced Print Settings - Windows
Selecting Print Layout Options - Windows

Selecting a Printing Preset - Windows

Selecting Double-sided Printing Settings - Windows
Printing Your Document or Photo - Windows
Selecting Default Print Settings - Windows
Changing Automatic Update Options

Parent topic: Printing From a Computer

Selecting Basic Print Settings - Windows
Select the basic settings for the document or photo you want to print.
1. Open a photo or document for printing.
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2. Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.

3. If necessary, select your product name as the printer you want to use.
Note: You may also need to select Properties or Preferences to view your print settings.

You see the Main tab of your printer settings window:

| Or Sodcus| B Man | Advanced | [T Page Layeut | # Maintenance |
Quakty Option

B s E

I Deaft WText (Text&image (IPhotn () BestPhotn

Paper Opbons 2-sided printing
O dut
() OfF () Manual
Type | Plain Paper [ Bright White Paper Print Options

Source | Auto Casseiie Selecton

[[] Fix Phata
[l Fix Red-Eve
(®) Borders Borderiess []reverse Order

[T

Size |Letter (8 1/2x 11)
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4. Select the Quality Option setting that matches your print content and the print quality you want to
use.

5. Select the Source setting that indicates where you loaded the paper or CD/DVD you want to print
on.

6. Select the type of paper you loaded as the Type setting.

Note: The setting may not exactly match the name of your paper. Check the paper type settings list
for details.

7. Select the size of the paper you loaded as the Size setting.
Note: You can also select the User Defined setting to create a custom paper size.

8. Select one of the border options:
 If you are printing a borderless photo, select Borderless.

Note: You must select a compatible borderless paper type and size to print without borders.
Check the borderless paper compatibility list for details.

* If you are printing a document or a photo with borders, select Borders.
9. Select the orientation of your document or photo as shown in the printer settings window.

Note: If you are printing an envelope, select Landscape.

10. To print on both sides of the paper, select a 2-sided printing option.
11. Select any of the available print options.

Note: If you need to access the Epson product support website, click the Online Support button.

Paper Source Options - Windows
Basic Print Options - Windows

Parent topic: Printing with Windows

Related references
Borderless Paper Type Compatibility
Paper or Media Type Settings
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Related tasks
Selecting Double-sided Printing Settings - Windows

Paper Source Options - Windows

You can select any of the available options in the Paper Source menu to print on the paper loaded in that
source.

Auto Cassette Selection
Automatically selects the paper source based on the selected paper size.

Cassette 1
Selects the paper in cassette 1 as the paper source.

Cassette 2
Selects the paper in cassette 2 as the paper source.

Cassette 1 > Cassette 2
Selects the paper in cassette 1 as the paper source and automatically switches to cassette 2 when
cassette 1 is empty.

Rear Paper Feed Slot
Selects the paper in the rear feed slot as the paper source.

CD/DVD
Selects the CD or DVD loaded as the source.

Parent topic: Selecting Basic Print Settings - Windows
Basic Print Options - Windows

You can select any of the basic print options to customize your print. Some options may be pre-selected
or unavailable, depending on other settings you have chosen.

Fix Photo
Improves the color, contrast, and sharpness of flawed photos.

Note: Fix Photo uses a sophisticated face recognition technology to optimize photos that include
faces. For this to work, both eyes and the nose must be visible in the subject's face. If your photo
includes a face with an intentional color cast, such as a statue, you may want to turn off Fix Photo to
retain the special color effects.

Fix Red-Eye
Reduces or removes red-eye in photos.

Reverse Order
Prints multi-page print jobs last page first.
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Print Preview
Displays a preview of your printout before printing.

Parent topic: Selecting Basic Print Settings - Windows

Selecting Advanced Print Settings - Windows

Select print settings on the Advanced tab to customize the quality and color settings for your printout,
and save your own printing presets.

1. Click the Advanced tab.
You see the advanced print settings:

|7 Shotcuts | i Man | B Advanced | [T] Page Layout | .~ Mantenance|
Paper & Quality Oplicns Codor Management
v @ Color Conrois
-
Plain Paper | Bright White Paper b4 i:;‘mm
| Hormal b
EFSOM Vivid
Letter (B 1/2x 11in) w e
(®) Borders Borderless
Crientation
(®) Portrait (O Landscape
Print Opbons
[]Fx Red-Eve
[+4] High Speed
[ Edige Smoathing
[erint Preview
[ eache farayscate

Criet Mode | off

Custom Setings W

| Reset Defaults
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2. Select the Paper & Quality Options settings for your printout:

Select where you loaded the paper or CD/DVD you want to print on.
Select the type of paper you loaded.

Note: Check the paper type settings list for details.
Select the print quality setting you want to use.
Note: Check the print quality settings list for details.

Select the size of the paper you loaded.

Select Borderless to print a borderless photo, or Borders to print a document or a photo with
borders.

Note: You must select a compatible borderless paper type and size to print without borders.
Check the borderless paper compatibility list for details.

3. Select Portrait or Landscape as the orientation of your document or photo.

Note: If you are printing an envelope, select Landscape.

4. Select any of the available advanced print options.

5. Select any of the available color management options, or turn off color management.

Advanced Print Quality Settings - Windows
Advanced Print Options - Windows
Color Management Options - Windows

Parent topic: Printing with Windows

Related references

Paper Source Options - Windows
Borderless Paper Type Compatibility
Paper or Media Type Settings

Related tasks
Selecting Double-sided Printing Settings - Windows
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Advanced Print Quality Settings - Windows

You can select any of the print quality settings to fine-tune the quality of your print. Some settings may
be unavailable, depending on the paper type and border setting you have chosen.

Draft
For draft printing on photo paper.

Fast Economy
For the fastest printing with draft quality.

Economy
For fast printing with reduced quality.

Normal
For everyday text and image printing.

Fine
For text and graphics with good quality and print speed.

Photo
For photos and graphics with good quality and print speed.

Photo RPM
For the best print quality, but the slowest print speed.

Parent topic: Selecting Advanced Print Settings - Windows
Advanced Print Options - Windows

You can select any of the print options to customize your print. Some options may be unavailable,
depending on other settings you have chosen.

Fix Red-Eye
Reduces or removes red-eye in photos.
High Speed
Speeds up printing, but may reduce print quality.
Edge Smoothing
Smooths jagged edges in low-resolution images such as screen captures or images from the Web.

Print Preview
Displays a preview of your printout before printing.

Black/Grayscale
Prints text and graphics in black or shades of gray.

Quiet Mode
Lessens noise during printing but may decrease print speed.
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Parent topic: Selecting Advanced Print Settings - Windows
Color Management Options - Windows

You can adjust the Color Management settings on the Advanced tab to fine-tune the colors in your
printout, or turn off color management in your printer software.
Color Controls

Lets you select a Color Mode setting, individual settings for Brightness, Contrast, Saturation, and

Density, and individual color tones. Depending on the selected color mode, you can also adjust the
midtone density using the Gamma setting.

Fix Photo
Improves the color, contrast, and sharpness of flawed photos.

Note: Fix Photo uses a sophisticated face recognition technology to optimize photos that include
faces. For this to work, both eyes and the nose must be visible in the subject's face. If your photo
includes a face with an intentional color cast, such as a statue, you may want to turn off Fix Photo to
retain the special color effects.

ICM
Lets you turn off color management in your printer software using the Off (No Color Adjustment)
option. You can then manage color using only your application software.

Parent topic: Selecting Advanced Print Settings - Windows

Selecting Print Layout Options - Windows
You can select a variety of sizing and layout options for your document or photo on the Page Layout tab.
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» To change the size of your printed document or photo, select the Reduce/Enlarge Document
checkbox and select sizing options.

» To print on both sides of your paper, select the 2-sided printing options.

» To print multiple pages on one sheet of paper, or print one image on multiple sheets of paper, select
the Multi-Page checkbox and select the options you want.

» To print multiple copies and arrange their print order, select the Copies options.
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» To control printing at the edges of borderless images, select a Borderless option:

Note: To make changes to the Borderless settings, you must have selected the Borderless option
on the Advanced tab.

» To adjust the automatic settings, select Auto Expand as the Enlargement Method setting, then
adjust the Expansion slider (if necessary) to control the amount of image expansion.

Note: If you select the Min option for the Expansion setting, you may see white borders on your
printed photo.

» To print the borderless image at its actual size without scaling, select Retain Size as the
Enlargement Method setting.
» To add a watermark to your printout, select Watermark settings.
» To rotate or flip the printed image, select the Rotate 180° or Mirror Image checkboxes.
Parent topic: Printing with Windows

Related tasks
Selecting Double-sided Printing Settings - Windows

Selecting a Printing Preset - Windows

For quick access to common groups of print settings, you can select a printing preset.
Note: You can create your own preset by clicking the Save Settings button on the Advanced tab.

1. Click the Shortcuts tab.
You see the available Printing Presets options:
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@ Letter Document - High Quality
2] Letter Document - Double Sided
H 4 x 6 in Fhoto - Portrait

W 6 nPhoto - Landscape
o Printable CO/DVD Printing
H Letter Fhoto - Portrait

i Letter Fhoto - Landscape

A ¥ Reset
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= for Printing Presets.

AddRemove. .. Online Support

Place your cursor over a Printing Presets option to view its list of settings.
Use any of the available options on the screen to control your printing presets.
To choose an option for printing, select it.

Click OK.
Parent topic: Printing with Windows

a M w DN

Selecting Double-sided Printing Settings - Windows

You can print on both sides of the paper by selecting one of the 2-sided printing options on the Main or
Page Layout tab. (Some options are not available on the Main tab.)

Automatic double-sided printing is only available if you have loaded plain paper in these sizes: Letter
(8.5x 11 inches [216 x 279 mm]) and A4 (8.3 x 11.7 inches [210 x 297 mm]).
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Note: Some options may be unavailable, depending on other settings you have chosen.

Click the Page Layout tab.
Select one of the 2-sided printing options:
« Select the Auto checkbox to automatically print your double-sided print job.

» Select the Manual checkbox to print your double-sided print job manually by printing one side and
flipping the paper over to print the other side (recommended for paper types that do not support
automatic duplexing).

3. Select the Folded Booklet checkbox if you want to order the pages of your double-sided print to
create a single-fold booklet.

4. Click the Settings button.
You see this window:

rt_:z:" Ety

Binding Margin
12 [12... 118
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Bookdet Option

Center Banding Side Binding
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5. Select the binding options you want to use.
Click OK to return to the Page Layout tab.

7. Click the Adjust Print Density button.
You see this window:

Print Density Adjustment
Select Dooument Type
(@ Text] () Text with Photo (") Phato "I Manual
Adjustments
Print Density 0 | [3e)
50 Q
Increased Ink Drying Time 0 | (sec)
1] (1]
0K Cancel Help

8. Select the type of document you are printing as the Document Type setting. The software
automatically sets the Adjustments options for that document type.

9. Ifyou selected the Manual document type, select the Adjustments options you want to use.
10. Click OK to return to the Page Layout tab.

11. Print a test copy of your double-sided document to test the selected settings.

12. Follow any instructions displayed on the screen during printing.

Double-sided Printing Options - Windows
Print Density Adjustments - Windows

Parent topic: Printing with Windows

Related tasks
Selecting Basic Print Settings - Windows
Selecting Advanced Print Settings - Windows
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Double-sided Printing Options - Windows

You can select any of the double-sided options to set up your double-sided print job.
Binding Edge Options

Select a setting that orients double-sided print binding in the desired direction.
Binding Margin Options

Select options that define a wider margin to allow for binding.

Booklet Option
Select a binding option to use when creating a folded booklet.

Parent topic: Selecting Double-sided Printing Settings - Windows
Print Density Adjustments - Windows

You can select any of the available options on the Print Density Adjustment window to adjust the print
quality of your double-sided print job.

Print Density
Sets the level of ink coverage for double-sided printing.

Increased Ink Drying Time

Sets the amount of time required for drying ink after printing on one side of the paper before printing
the other side in double-sided printing to prevent ink smearing.

Parent topic: Selecting Double-sided Printing Settings - Windows
Printing Your Document or Photo - Windows

Once you have selected your print settings, you are ready to save your settings and print.
1. Click OK to save your settings.

You see your application's Print window, such as this one:
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2. Click OK or Print to start printing.
Checking Print Status - Windows
Parent topic: Printing with Windows

Related tasks

Selecting Basic Print Settings - Windows
Selecting Advanced Print Settings - Windows
Selecting Print Layout Options - Windows

Checking Print Status - Windows

During printing, you see this window showing the progress of your print job. It allows you to control
printing and check ink cartridge status.
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EPSON ...
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Media Type : Plain Paper [ Bright White Paper
Paper Sipe ; Letter (3 12 x L1in)

» To cancel printing, click Cancel.

» To see print jobs lined up for printing, click Print Queue.
» To check ink status, click Check Ink Levels.

Parent topic: Printing Your Document or Photo - Windows

Selecting Default Print Settings - Windows

When you change your print settings in a program, the changes apply only while you are printing in that
program session. If you want to change the print settings you use in all your Windows programs, you can
select new default print settings.

1. Right-click the product icon in the Windows taskbar.
2. Select Printer Settings.
You see the printer settings window:
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3. Select the print settings you want to use as defaults in all your Windows programs.
4. Click OK.

These settings are now the defaults selected for printing. You can still change them as needed for
printing in any program session.

Changing the Language of the Printer Software Screens
Parent topic: Printing with Windows
Changing the Language of the Printer Software Screens
You can change the language used on the Windows printer software screens.
1. Right-click the product icon in the Windows taskbar.
2. Select Printer Settings.
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You see the printer settings window.
3. Click the Maintenance tab.
You see the maintenance options:

| Shotcuts | 4 Man | @5 Advanced | [T PageLayout . Mantenance

k| Epson status Monitor 3

L}
%

®

Language | Englsh (Enghsh)

Version 7, 10,00

4. Select the language you want to use as the Language setting.
5. Click OK to close the printer software window.

The printer software screens appear in the language you selected the next time you access them.
Parent topic: Selecting Default Print Settings - Windows
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Changing Automatic Update Options

Your printer software for Windows automatically checks for updates to the product software. You can
change how often the software checks for updates or disable this feature.

1. Right-click the product icon in the Windows taskbar.
2. Select Software Update Settings.
You see this window:

Software Update Settings “-
Check for Software Updates on the Internet
(@) Chedk every 2 weeks W
) Mever
L0k | cance

3. Do one of the following:

» To change how often the software checks for updates, select a setting in the Check every menu.
< To disable the automatic update feature, select the Never option.
4. Click OK to exit.

Note: If you choose to disable the automatic update feature, you can check for updates manually.

Parent topic: Printing with Windows

Related tasks
Checking for Software Updates

Printing with Mac OS X

You can print with your product using any Mac OS X printing program, as described in these sections.
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Selecting Basic Print Settings - Mac OS X

Selecting Page Setup Settings - Mac OS X
Selecting Print Layout Options - Mac OS X

Selecting Double-sided Printing Settings - Mac OS X
Managing Color - Mac OS X

Selecting Printing Preferences - Mac OS X

Printing Your Document or Photo - Mac OS X

Parent topic: Printing From a Computer

Selecting Basic Print Settings - Mac OS X
Select the basic settings for the document or photo you want to print.
1. Open a photo or document for printing.
2. Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.

3. Select your product as the Printer setting.

Printer: | EPSON H

Presets: | Default Settings

4. If necessary, click the arrow next to the Printer setting or the Show Details button to expand the
print window.

You see the expanded printer settings window for your product:
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Printer: | EPSON -

Presets: | Default Settings -
Copies: |1
Pages: (=) All
From: |1 to: 1
Paper Size: | US Letter + | 8.50 by 11.00 inches

N v
Orientation: 'l It
Preview :

Iﬂ Auto Rotate

(=) Scale: 100 %
Scale to Fit: =

aF

Copies per page: | 1

Cancel | Print |

Note: The print window may look different, depending on the version of Mac OS X and the
application you are using.

Select the Copies and Pages settings as necessary.

Note: If you do not see these settings in the print window, check for them in your application before
printing.

Select the page setup options: Paper Size and Orientation.

Note: If you do not see these settings in the print window, check for them in your application before
printing. They may be accessible by selecting Page Setup from the File menu.
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Select any application-specific settings that appear on the screen, such as those shown in the image
above for the Preview application.

Select Print Settings from the pop-up menu.

Praview

Layout

Color Matching
Paper Handling
Cover Page

¥ Print Settings
Color Options
Two-sided Printing Settings

Supply Levels

You see these settings:

Print Settings

ik

Paper Source: | Cassette 2

Media Type: | Plain Paper / Bright White Paper E

]

Print Quality: | Normal

EXpansion Max

GCrayscale

Mirror Image

Cancel Print
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9. Select the Paper Source you wish to print from.
10. Select the type of paper you loaded as the Media Type setting.

Note: The setting may not exactly match the name of your paper. Check the paper type settings list
for details.

11. Select the Print Quality setting you want to use.
12. Select any of the available print options.

Paper Source Options - Mac OS X
Print Quality Settings - Mac OS X
Print Options - Mac OS X

Parent topic: Printing with Mac OS X

Related references
Paper or Media Type Settings

Related tasks
Selecting Page Setup Settings - Mac OS X
Printing Your Document or Photo - Mac OS X

Paper Source Options - Mac OS X

You can select any of the available options in the Paper Source menu to print from paper loaded in that
source.

Cassette 1
Selects the paper in cassette 1 as the paper source.

Cassette 2
Selects the paper in cassette 2 as the paper source.

Rear Paper Feed Slot
Selects the paper in the rear feed slot as the paper source.

Parent topic: Selecting Basic Print Settings - Mac OS X
Print Quality Settings - Mac OS X

You can select any of the print quality settings to fine-tune the quality of your print. Some settings may
be unavailable, depending on the paper type and border setting you have chosen.

Draft
For draft printing on photo paper.
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Fast Economy
For the fastest printing with draft quality.

Economy
For fast printing with reduced quality.

Normal
For everyday text and image printing.

Fine
For text and graphics with good quality and print speed.

Photo
For photos and graphics with good quality and print speed.

Photo RPM
For the best print quality, but the slowest print speed.

Parent topic: Selecting Basic Print Settings - Mac OS X
Print Options - Mac OS X

You can select any of the print options to customize your print. Some options may be unavailable,
depending on other settings you have chosen.

Expansion
If you selected a borderless paper size setting, this option adjusts the image expansion settings to
control printing at the edges of borderless prints.

Grayscale
Prints text and graphics in black or shades of gray.

Mirror Image
Lets you flip the printed image horizontally.

Note: If you select the Min option for the Expansion setting, you may see white borders on your printed
photo.

Parent topic: Selecting Basic Print Settings - Mac OS X

Selecting Page Setup Settings - Mac OS X

Depending on your application, you may be able to select the paper size and orientation settings from
the print window.
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Ak

Paper Size: | US Letter
8.50 by 11.00 inches

QOrientation: I* li"

Note: If you do not see these settings in the print window, check for them in your application before
printing. They may be accessible by selecting Page Setup from the File menu.

1. Select the size of the paper you loaded as the Paper Size setting. If you are printing a borderless
photo, select the Borderless checkbox or a paper size with a Borderless option. You can also
select a custom setting to create a custom paper size.

Note: You must select a compatible borderless paper type and size to print without borders. Check
the borderless paper compatibility list for details.

2. Select the orientation of your document or photo as shown in the print window.

Note: If you are printing an envelope, selectthe "* icon.

Note: You can reduce or enlarge the size of the printed image by selecting Paper Handling from the
pop-up menu and selecting a scaling option.

Parent topic: Printing with Mac OS X

Related references
Borderless Paper Type Compatibility

Selecting Print Layout Options - Mac OS X

You can select a variety of layout options for your document or photo by selecting Layout from the pop-
up menu on the print window.
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Layout

Pages per Sheet: | 1 =

Border: | None :

Reverse page orientation
Flip horizontally

Cancel | | Print |

» To print multiple pages on one sheet of paper, select the number of pages in the Pages per Sheet
pop-up menu. To arrange the print order of the pages, select a Layout Direction setting.

» To print borders around each page on the sheet, select a line setting from the Border pop-up menu.
» Toinvert or flip the printed image, select the Reverse page orientation or Flip horizontally settings.
Parent topic: Printing with Mac OS X

Selecting Double-sided Printing Settings - Mac OS X

You can print on both sides of the paper by selecting Two-sided Printing Settings from the pop-up
menu on the print window.
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Two-sided Printing Settings

Two-sided Printing: | Off

Cancel Print

Note: Some options may be pre-selected or unavailable, depending on other settings you have chosen
or if you are accessing the product over a network. This screen may be different, depending on the

version of Mac OS X you are using.

1. Selectone of the Two-sided Printing options.
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2. Select the type of document you are printing as the Document Type setting. The software
automatically sets the Adjustments options for that document type.

Two-sided Printing Settings
Twa-sided Printing: | Long-Edge binding
Document Type: | Text

¥ Adjustments

Pring Density

[V
=50 ]
ncreaded Ink Drying Time:
1 (E114]
1] G0

whan printing a photo or documant containing a kot of selid image
areas, reduce the density of the ink and increase its drying time.

Cancel | | Print |

3. If necessary, customize the Adjustments settings as instructed on the screen.
4. Print a test copy of your double-sided document to test the selected settings.
5. Follow any instructions displayed on the screen during printing.
Double-sided Printing Options and Adjustments - Mac OS X
Parent topic: Printing with Mac OS X

Double-sided Printing Options and Adjustments - Mac OS X

You can select any of the available options in the Two-sided Printing Settings or Output Settings
pop-up menu to set up your double-sided print job.

Two-sided Printing Options

Long-Edge binding
Orients double-sided printed pages to be bound on the long edge of the paper.
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Short-Edge binding
Orients double-sided printed pages to be bound on the short edge of the paper.
Adjustments

Print Density
Sets the level of ink coverage for double-sided printing.

Increased Ink Drying Time
Sets the amount of time required for drying ink after printing on one side of the paper before printing
the other side in double-sided printing.

Parent topic: Selecting Double-sided Printing Settings - Mac OS X

Managing Color - Mac OS X

You can adjust the Color Matching and Color Options settings to fine-tune the colors in your printout, or
turn off color management in your printer software.

1. Select Color Matching from the pop-up menu in the print window.

Color Matching =

ColorSync  (* EPSON Color Controls

2. Select one of the available options.
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3. Select Color Options from the pop-up menu in the print window.

Color Options *

#) Manual Settings
Fix Photo
Off (No Color Adjustment)

F Advanced Semtings

Cancel | Print |

Note: The available settings on the Color Options menu depend on the option you selected on the
Color Matching menu.

4. Select one of the available options.
Color Matching and Color Options - Mac OS X
Parent topic: Printing with Mac OS X
Color Matching and Color Options - Mac OS X
You can select from these settings on the Color Matching and Color Options menus.

Color Matching Settings

EPSON Color Controls
Lets you manage color using controls in your printer software, or turn off color management.

ColorSync
Prints using standard color profiles for your product and paper to help match image colors. You can
customize the conversion method and filter settings on the ColorSync pop-up menu in the print
window.
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Color Options Settings

Manual Settings
Lets you select manual color adjustments. Click the arrow next to Advanced Settings and select
settings for Brightness, Contrast, Saturation, and individual color tones. You can also select a color
Mode setting for printing photos and graphics and the Fix Red-Eye setting to reduce or remove red-
eye in photos. Depending on the selected color mode, you can also adjust the midtone density using
the Gamma setting.

Fix Photo
Improves the color, contrast, and sharpness of flawed photos. Click the arrow next to Advanced
Settings and select the Fix Red-Eye setting to reduce or remove red-eye in photos.

Note: Fix Photo uses a sophisticated face recognition technology to optimize photos that include
faces. For this to work, both eyes and the nose must be visible in the subject's face. If your photo
includes a face with an intentional color cast, such as a statue, you may want to turn off Fix Photo to
retain the special color effects.

Off (No Color Adjustment)
Turns off color management in your printer software so you can manage color using only your
application software.

Parent topic: Managing Color - Mac OS X

Selecting Printing Preferences - Mac OS X
You can select printing preferences that apply to all the print jobs you send to your product.
1. Inthe Apple menu or the Dock, select System Preferences.
2. Select Print & Fax or Print & Scan, select your product, and select Options & Supplies.
3. Select Driver.
You see this screen:
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+ General m Supply Levels Litility

To take full advantage of your printer's optlons, confiem that they are accuraiely shown
here. For information on your printer and its cpteonal hardware, chec the printer’s
documentation.

Thick paper amd emvelopes: | OF
Skip Blank Page:| OH

Chuiiet Made: | O

Permil temperary black printing: | Of
AUtGMatc Casserne Switching: | Of
High Speed Printing: | On

Warmning Notifications: | On

Establish bidirectional communication:| On

Cancel | Sl

4. Select any of the available printing preferences.
5. Click OK.
Printing Preferences - Mac OS X
Parent topic: Printing with Mac OS X
Printing Preferences - Mac OS X
You can select from these settings on the Driver tab.

Thick paper and envelopes
Prevents ink from smearing when you print on envelopes or other thick paper.

Skip Blank Page
Ensures that your product does not print pages that contain no text or images.

Quiet Mode
Lessens noise during printing but may decrease print speed.

Permit temporary black printing
Allows you to print using black ink when a color ink cartridge is expended.

Automatic Cassette Switching
Automatically switches to the other cassette when one of the cassettes runs out of paper.
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High Speed Printing
Speeds up printing, but may reduce print quality.
Warning Notifications

Lets you choose whether or not to receive warning notifications from the printer software when ink is
low.

Establish bidirectional communication

Allows the product to communicate with the computer. Do not change the default setting On unless
you experience issues when using a shared printing pool.

Parent topic: Selecting Printing Preferences - Mac OS X

Printing Your Document or Photo - Mac OS X

Once you have selected your print settings, you are ready to print.
Click Print at the bottom of the print window.

Print Settings :

Paper Source: | Cassette 2

Media Type: | Plain Paper / Eright White Paper

Print Quality: | Mormal

Grayscale

Mirrer Image

Cancel Print

Checking Print Status - Mac OS X
Parent topic: Printing with Mac OS X

Related tasks
Selecting Basic Print Settings - Mac OS X
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Selecting Page Setup Settings - Mac OS X

Selecting Print Layout Options - Mac OS X

Selecting Double-sided Printing Settings - Mac OS X

Managing Color - Mac OS X

Selecting Printing Preferences - Mac OS X
Checking Print Status - Mac OS X

During printing, you can view the progress of your print job, control printing, and check ink cartridge
status.

1. Click the printer icon when it appears in the Dock.
You see the print status window:

ann 1Job
e
Pause Settings Scanner

. page_setup_maclOB. tiff

2. Select the following options as necessary:
Mac OS X 10.5/10.6/10.7:
» To cancel printing, click the print job and click the Delete icon.

e To pause a print job, click the print job and click the Hold icon. To resume a print job, click the print
job marked "Hold" and click the Resume icon.

« To pause printing for all queued print jobs, click the Pause Printer icon.
» To check ink status, click the Supply Levels icon.
Mac OS X 10.8:

» To cancel printing, click the I:' button next to the print job.
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« To pause a print job, click the |:| button next to the print job. To resume a print job, click the |:|
button.

« To pause printing for all queued print jobs, click the large Pause button.
» To check ink status, click the Settings icon, then click the Supply Levels tab.
Parent topic: Printing Your Document or Photo - Mac OS X

Cancelling Printing Using a Product Button
If you need to cancel printing, select Cancel on the LCD display.
Parent topic: Printing From a Computer
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Scanning

You can scan original documents or photos and save them as digital files.

Starting a Scan

Selecting Epson Scan Settings

Scanning with Mac OS X 10.6/10.7/10.8 Using Image Capture
Scanning Special Projects

Starting a Scan

After placing your original documents or photos on your product for scanning, start scanning using one of
these methods.

Starting a Scan Using the Product Control Panel
Starting a Scan Using the Epson Scan Icon
Starting a Scan from a Scanning Program

Parent topic: Scanning

Related topics
Placing Originals on the Product

Starting a Scan Using the Product Control Panel
You can scan an image to your computer using your product's touch panel buttons.

Your product automatically selects suitable default scan settings, but you can view or change them as
necessary.

1. Make sure you installed the product software and connected the product to your computer or
network.

Press the a home button, if necessary.
Select Scan.
The scan options are displayed:
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Scan

=8 Scan to Memory Card

- Scan to Cloud

= Scan to PC (JPEG)

Scroll up or down to view additional scan options, then select the one you want.

Scan to Memory Card saves your scan file on a memory card and lets you select the file format,
quality, and other settings.

Scan to Cloud sends your scanned files to a destination that you have registered with Epson
Connect.

Note: To use this feature, you must have registered a cloud account with Epson Connect.
Scan to PC (JPEG) saves your scan file directly to your computer or as an image capture in Mac

OS X 10.6/10.7/10.8.

Scan to PC (PDF) saves your scan as a PDF file to your computer or as an image capture in Mac
OS X 10.6/10.7/10.8.

Scan to PC (Email) scans your original and attaches it to a message in your e-mail program. You
can select the e-mail program you want to use and resize your image, if necessary, from an option
screen on your computer.

Note: This works with MAPI-type email such as Microsoft Outlook, Windows Live Mail, Mac Mail,
and Entourage, but not web-based email such as Gmail.

Scan to PC (WSD) lets you manage wireless scanning in Windows 8, Windows 7, or Windows
Vista (English only).
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Note: To use this feature, you must first set up WSD (Web Services for Devices) on the computer
you want to scan to.

5. To scan to your PC, you first need to select how you connected your product to your computer:
* If your product is connected directly to your computer with a USB cable, select USB Connection.

« If your product is connected to your computer over a network, select the computer name from the
list.

6. Press the ¢ start button to start scanning.

Scan to Memory Card Options
Changing Default Scan Button Settings

Parent topic: Starting a Scan

Related tasks
Using Epson Scan to Cloud

Scan to Memory Card Options
Select the Scan to Memory Card options you want to use.

Scan to Memory Card Available options Description

setting

JPG — JPG: for photos

PDF PDF: for documents

Color — Select color or black-and-white

B&W scans

Contrast Various levels Decrease or increase image

contrast

2-Sided Scanning Off Automatic 2-sided scanning for

on documents in the ADF
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Scan to Memory Card Available options Description
setting
Scan Area Letter Selects the page size for documents
Legal or special settings for photos.
Ad Auto Cropping: for photos with
_ dark edges
Auto Cropping Max Area: for most photos
Max Area
Document Text Select_s the type of original you are
Photograph scanning
Resolution 200 dpi 200 dpi: for e-mailing or posting on
300 dpi the web
600 dpi 300 dpi: for printing or OCR
600 dpi: for highest quality printing
Document Orientation Portrait Spe_cifies the orientation of your
Landscape originals
Binding Direction Left Edge Specifies the binding edge of your
Top Edge double-sided originals

Parent topic: Starting a Scan Using the Product Control Panel

Changing Default Scan Button Settings

You can view or change the default scan settings your product uses when you scan to your computer
using the product buttons. You do this using the Event Manager program.

1. Do one of the following to open Event Manager:

« Windows 8: Navigate to the Start screen and select Event Manager.

« Windows (other versions): CIickE:II or Start > All Programs or Programs > EPSON Software

> Event Manager.

« Mac OS X: Open the Applications folder, click Epson Software, and click Event Manager.

2. Openthe Scanner (Windows) or Select Scanner (Mac OS X) drop-down list and select your

product, if necessary.
3. Click Make Job Settings.
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5.
6.
7.

Open the Edit Job Settings drop-down list and select the scan button settings you want to view or
change.

Change the settings as necessary.
Click OK.
Click Close to close the Event Manager window.

Parent topic: Starting a Scan Using the Product Control Panel

Starting a Scan Using the Epson Scan Icon

You can start the Epson Scan program to select scan settings, scan, and save the scanned image to a
file.

Windows: Double-click the EPSON Scan icon on your computer desktop.

Mac OS X: Open the Applications folder, open the Epson Software folder, and double-click the
EPSON Scan icon.

Note: With Mac OS X 10.6, 10.7, or 10.8, in addition to scanning with Image Capture, you can
download and install Epson Scan scanning software. Epson Scan provides additional image
adjustment and photo correction features for enhancing scanned images, and provides an interface
for TWAIN-compliant OCR scanning software, such as ABBYY FineReader. To download Epson
Scan, visit Epson's driver download site (U.S. downloads or Canadian downloads).

You see an Epson Scan window like this:
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Parent topic: Starting a Scan

Related tasks
Scanning with Mac OS X 10.6/10.7/10.8 Using Image Capture

Related topics
Selecting Epson Scan Settings
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Starting a Scan from a Scanning Program

You can start Epson Scan from a scanning program to select scan settings, scan, and open the scanned
image in the program.

Note: With Mac OS X 10.6, 10.7, or 10.8, in addition to scanning with Image Capture, you can download
and install Epson Scan scanning software. Epson Scan provides additional image adjustment and photo
correction features for enhancing scanned images, and provides an interface for TWAIN-compliant OCR
scanning software, such as ABBYY FineReader. To download Epson Scan, visit Epson's driver
download site (U.S. downloads or Canadian downloads).

1. Open your scanning program and select its scanning option. (See your scanning program help for
instructions.)

2. Select your product.

Note: In certain programs, you may need to select your product as the "source" first. If you see a
Select Source option, choose it and select your product. With Windows, do not select a WIA option
for your product; it will not work correctly.

You see an Epson Scan window like this:
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Note: Epson Scan may start in a mode other than Home Mode when you first access it.

Parent topic: Starting a Scan
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Selecting Epson Scan Settings

After starting Epson Scan, you can select settings in various modes to customize your scan.
Scan Modes

Selecting the Scan Mode

Scanning in Office Mode

Scanning in Home Mode

Scanning in Professional Mode

Image Preview Guidelines

Scan Resolution Guidelines

Selecting Scan File Settings

Parent topic: Scanning

Scan Modes

Epson Scan provides a choice of scan modes with different levels of control over your settings.

Office Mode
You can quickly scan text documents and adjust them on a preview screen. You can also select
various image adjustment options and preview your scanned image.

Home Mode

You can select setting groups based on the type of content you are scanning. You can also select
various image adjustment options, and preview and size your scanned image.

Professional Mode
You can manually customize all available settings, and preview and size your scanned image.

Note: You must place your original on the scanner glass when using Home Mode.

Parent topic: Selecting Epson Scan Settings

Related tasks
Selecting the Scan Mode

Selecting the Scan Mode

Select the Epson Scan mode you want to use from the Mode box in the upper right corner of the Epson
Scan window:
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Mode:

EPSON Scan |_I.'_Illi|::u Mode

" Grayscabs

Parent topic: Selecting Epson Scan Settings

Related tasks

Scanning in Office Mode
Scanning in Home Mode
Scanning in Professional Mode

Scanning in Office Mode

When you scan in Office Mode, Epson Scan automatically saves your scanned file in JPEG format in
your operating system's Pictures or My Pictures folder, or opens it in your scanning program. You can
select settings, preview, and change the scanned file settings as necessary.

1. Start Epson Scan and select Office Mode as the Mode setting.
You see this window:
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Select the Image Type setting that matches your original.

Select the Document Source setting indicating where you placed your original. To scan a 2-sided
document in the ADF, select ADF-Double-sided.

Note: If you are using the ADF, remove any documents from the scanner glass.
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4. Select the Size and Orientation settings that match your original.

5. Select the Resolution setting you want to use for your scan.

6. Click the Preview button.
Epson Scan previews your original and displays the result in a separate Preview window.
If you are using the ADF, reinsert your original into the ADF.
If desired, select the area in your preview image that you want to scan (scan area).

Note: You cannot select a scan area if you chose ADF-Double-sided as the Document Source
setting.

9. Select any of the image adjustment settings you want to use. Before making adjustments, click the
image or scan area in the Preview window.

10. Click Scan.
You see the File Save Settings window.
11. Change any of the necessary file save settings and click OK.

Epson Scan scans your original, and saves the file in the selected folder or opens it in your scanning
program. If the file was saved directly to your computer, you see the file in the Windows Explorer or Mac
OS X Finder, where you can view and print the image, if desired.

Available Document Source Settings - Office Mode
Selecting a Scan Area - Office Mode
Available Image Adjustments - Office Mode

Parent topic: Selecting Epson Scan Settings

Related concepts
Image Preview Guidelines
Scan Resolution Guidelines

Related tasks
Selecting Scan File Settings

Available Document Source Settings - Office Mode
You can select these Document Source options in Epson Scan Office Mode.

Auto Detect
Automatically detects where the originals are placed on your product for scanning.
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ADF - Single-sided
Selects the Automatic Document Feeder as the location where the originals are placed on your
product for single-sided scanning.

ADF - Double-sided
Selects the Automatic Document Feeder as the location where the originals are placed on your
product for double-sided scanning.

Document Table
Selects the scanner glass as the location where the originals are placed on your product for scanning.

Parent topic: Scanning in Office Mode
Selecting a Scan Area - Office Mode

You can select a specific area in your preview image to include in your scanned image. You can select
the entire image area or a portion of it. You can even select multiple scan areas to create multiple
scanned images of different areas.

You can also use the scan area to select specific Image Adjustments settings for a scanned image. Just
be sure to click inside the scan area before selecting the settings.
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1. Inthe Preview window, click the @ Auto Locate icon to create a marquee (dotted line) on the preview
image.
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2. Do the following, as necessary, to work with the selected scan area:
« |If the marquee is correct, continue with the next step.
» To move the marquee, click inside the scan area and drag the marquee where you want it.
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« Toresize the scan area, place your cursor over the edge or corner of the marquee, then click and
drag the edges where you want them. (Hold down the Shift key as you resize the marquee to
retain the same width/height proportions.)

» To create additional marquees (up to 50, if available), click the i Copy Marquee icon to copy the
existing marquee and paste it on the preview image.

Note: If you draw multiple marquees, make sure you select the All button in the Preview window
before you scan. Otherwise, only the area inside the currently selected marquee will be scanned.

» To delete a marquee, click the marquee, then click the & Delete Marquee icon.
3. Click inside each scan area and make any necessary settings in the Epson Scan window.

Parent topic: Scanning in Office Mode
Available Image Adjustments - Office Mode

You can select these Image Adjustments options in Epson Scan Office Mode.

Image Adustments
Unzhaip Mask Descreening
Image Option
Text Enhancement

Ao Area Seamentation

Colar Enhance: Fed
Brighiness: [ 0
Confrast: () 0

Note: Select the Image Option checkbox if you need to set any of the grayed-out image adjustments.
Not all adjustment settings may be available, depending on the Image Type setting.

Unsharp Mask
Makes the edges of certain image areas clearer. Turn off this option to leave softer edges.
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Descreening
Removes the ripple pattern that might appear in subtly shaded image areas, such as skin tones. This
option improves results when scanning magazines or newspapers. (The results of descreening do not
appear in the preview image, only in your scanned image.)

Text Enhancement
Sharpens the appearance of letters in text documents.

Auto Area Segmentation
Makes grayscale images clearer and text recognition more accurate by separating the text from the
graphics.

Color Enhance
Enhances the red, green, or blue shades in the scanned image.

Brightness

Adjusts the overall lightness and darkness of the scanned image.
Contrast

Adjusts the difference between the light and dark areas of the overall scanned image.
Threshold

Adjusts the level at which black areas in text and line art are delineated, improving text recognition in
OCR (Optical Character Recognition) programs.

Parent topic: Scanning in Office Mode

Scanning in Home Mode

When you scan in Home Mode, Epson Scan automatically saves your scanned file in JPEG format in
your operating system's Pictures or My Pictures folder, or opens it in your scanning program. You can
select settings, preview, and change the scanned file settings as necessary.

Note: You must place your original on the scanner glass when using Home Mode.

1. Start Epson Scan and select Home Mode as the Mode setting.
You see this window:
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2. Select the Document Type setting that matches your original, such as Photograph or Text/Line
Art.

3. Select the Image Type setting that matches your original.
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4. Select the way you plan to use your scanned image as the Destination setting. (The Resolution
setting is selected automatically based on the Destination setting you choose.)

« Screen/Web: Select this option for images you will email, view on a computer screen, or post on
the web.

» Printer: Select this option for images you will print or documents you will convert to editable text
using OCR (Optical Character Recognition) software.

e Other: Select this option if you want to select a custom resolution for your image.
5. Ifyou selected Other in the last step, select the Resolution setting you want to use for your scan.
6. Click the Preview button.

Epson Scan previews your original and displays the result in a separate Preview window.
7. If desired, select the area in your preview image that you want to scan (scan area).

Select any of the image adjustment settings you want to use. Before making adjustments, click the
image or scan area in the Preview window.

9. If you want to reduce or enlarge your image as you scan, select the Target Size setting you want to
use.

10. Click Scan.
You see the File Save Settings window.
11. Change any of the necessary file save settings and click OK.

Epson Scan scans your original, and saves the file in the selected folder or opens it in your scanning
program. If the file was saved directly to your computer, you see the file in the Windows Explorer or Mac
OS X Finder, where you can view and print the image, if desired.

Selecting a Scan Area - Home Mode
Available Image Adjustments - Home Mode
Selecting a Scan Size - Home Mode

Parent topic: Selecting Epson Scan Settings

Related concepts
Image Preview Guidelines
Scan Resolution Guidelines

Related tasks
Selecting Scan File Settings
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Selecting a Scan Area - Home Mode

You can select a specific area in your preview image to include in your scanned image. You can select
the entire image area or a portion of it. You can even select multiple scan areas to create multiple
scanned images of different areas (Normal Preview mode only).

You can also use the scan area to select specific Image Adjustments settings for a scanned image. Just
be sure to click inside the scan area before selecting the settings.

1. Do one of the following to select your scan area in the Preview image:

« Thumbnail preview: Your scan area is selected automatically, but you can change it. Place your
cursor in one corner of the desired scan area, then click and drag the cursor to the opposite corner
to create a marquee (dotted line) on the preview image.
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« Normal preview: Click the & Auto Locate icon to create a marquee (dotted line) on the preview
image.
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2. Do the following, as necessary, to work with the selected scan area:
« |f the marquee is correct, continue with the next step.
» To move the marquee, click inside the scan area and drag the marquee where you want it.

« To resize the scan area, place your cursor over the edge or corner of the marquee, then click and
drag the edges where you want them. (Hold down the Shift key as you resize the marquee to
retain the same width/height proportions.)
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* Normal preview: To create additional marquees (up to 50), click the i Copy Marquee icon to
copy the existing marquee and paste it on the preview image.

Note: If you draw multiple marquees, make sure you select the All button in the Preview window
before you scan. Otherwise, only the area inside the currently selected marquee will be scanned.

« To delete a marquee, click the marguee, then click the = Delete Marquee icon.
3. Click inside the scan area and make any necessary settings in the Epson Scan window.
Parent topic: Scanning in Home Mode
Available Image Adjustments - Home Mode
You can select these Image Adjustments options in Epson Scan Home Mode.

Image Adjustments
| Descresning | Backlight Correction
| Colar Restoration | Dust Rermoval
Image Optian(]
Tt Enhancemeant
Auto Area Segmantation
Brnightrness...

Note: Select the Image Option checkbox if you need to set any of the grayed-out image adjustments.
Not all adjustment settings may be available, depending on the Document Type and Image Type setting.
Click the Brightness button to access additional settings.

Descreening
Removes the ripple pattern that might appear in subtly shaded image areas, such as skin tones. This
option improves results when scanning magazines or newspapers. (The results of descreening do not
appear in the preview image, only in your scanned image.)

Color Restoration
Restores the colors in faded photos automatically.

Backlight Correction
Removes shadows from photos that have too much background light.

Dust Removal
Removes dust marks from your originals automatically.
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DIGITAL ICE Technology
DIGITAL ICE removes dust and scratch marks from photos. It cannot be used with the Dust Removal
option. The effects of DIGITAL ICE Technology will not appear in the Preview of the image. You must
scan the original to see the results.

Text Enhancement
Sharpens the appearance of letters in text documents.

Auto Area Segmentation
Makes grayscale images clearer and text recognition more accurate by separating the text from the
graphics.

Brightness
Adjusts the overall lightness and darkness of the scanned image.

Contrast
Adjusts the difference between the light and dark areas of the overall scanned image.

Threshold
Adjusts the level at which black areas in text and line art are delineated, improving text recognition in
OCR (Optical Character Recognition) programs.

Parent topic: Scanning in Home Mode
Selecting a Scan Size - Home Mode

You can reduce or enlarge the size of your image as you scan. You can also select a specific scan size,
such as a common photo size like 4 x 6 inches (102 x 152 mm). This places a scan area of that size on
the preview image so you can use it to help crop the image in the correct proportions.

1. Click the Preview button to preview your image.

2. Inthe Epson Scan window, select the size you want your scanned image to be from the Target Size
list.

Target Size: 5 %7 N, '] FPEI

Note: If you need to rotate the orientation of the target size for your image, click the @ Orientation
icon.

A marquee (dotted line) appears on your preview image proportioned for the size you selected.
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Do the following, as necessary, to work with the selected scan area:
« To move the marquee, click inside the scan area and drag the marquee where you want it.

» To resize the scan area, place your cursor over the edge or corner of the marquee, then click and
drag the edge where you want it.

Note: Manually adjusting the marquee will not change the target size of the scanned file. The
marquee only indicates the area of the image that will be scanned.
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4. To create a scanned image size that is not available in the Target Size list, click the Customize
option.

Target Size Mame:

5. Name the custom size, enter the size, click Save, and click OK. Then create a scan area on the
preview image.

The marquee is automatically proportioned for your custom scan size.
Parent topic: Scanning in Home Mode

Scanning in Professional Mode

When you scan in Professional Mode, Epson Scan automatically saves your scanned file in JPEG
format in your operating system's Pictures or My Pictures folder, or opens it in your scanning program.
You can select settings, preview, and change the scanned file settings as necessary.

1. Start Epson Scan and select Professional Mode as the Mode setting.
You see this window:
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10.

11.

12.

13.

Select the Document Type setting that matches your original, such as Reflective for documents or
photos.

Select the Document Source setting indicating where you placed your original. To scan a 2-sided
document in the ADF, select ADF - Double-sided.

Note: If you are using the ADF, remove any documents from the scanner glass.

Select the specific type of original you are scanning as the Auto Exposure Type setting: Document
or Photo.

Select the details of your original and how you want it scanned as the Image Type setting.
Select the Resolution setting you want to use for your scan.

Click the Preview button.

Epson Scan previews your original and displays the result in a separate Preview window.
If you are using the ADF, reinsert your original into the ADF.

If desired, select the area in your preview image that you want to scan (scan area).

Note: You cannot select a scan area if you chose ADF-Double-sided as the Document Source
setting.

Select any of the image adjustment settings you want to use. Before making adjustments, click the
image or scan area in the Preview window.

If you want to reduce or enlarge your image as you scan, select the Target Size setting you want to
use.

Note: You cannot select a target size if you chose ADF-Double-sided as the Document Source
setting.

Click Scan.

You see the File Save Settings window.

Change any of the necessary file save settings and click OK.

Epson Scan scans your original, and saves the file in the selected folder or opens it in your scanning
program. If the file was saved directly to your computer, you see the file in the Windows Explorer or Mac
OS X Finder, where you can view and print the image, if desired.

Available Document Source Settings - Professional Mode
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Available Image Types - Professional Mode
Selecting a Scan Area - Professional Mode
Available Image Adjustments - Professional Mode
Selecting a Scan Size - Professional Mode
Parent topic: Selecting Epson Scan Settings
Related concepts

Image Preview Guidelines

Scan Resolution Guidelines

Related tasks

Selecting Scan File Settings

Available Document Source Settings - Professional Mode

You can select these Document Source options in Epson Scan Professional Mode.

Document Table
Selects the scanner glass as the location where the originals are placed on your product for scanning.
ADF - Single-sided
Selects the Automatic Document Feeder as the location where the originals are placed on your
product for single-sided scanning.

ADF - Double-sided

Selects the Automatic Document Feeder as the location where the originals are placed on your
product for double-sided scanning.

Parent topic: Scanning in Professional Mode
Available Image Types - Professional Mode

You can select these Image Type options in Epson Scan Professional Mode.

24-bit Color
Select this setting for color photos.

Color Smoothing
Select this setting for color graphic images, such as charts or graphs.

8-bit Grayscale
Select this setting for black-and-white photos.

Black & White
Select this setting for black text documents or line art.

Parent topic: Scanning in Professional Mode
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Selecting a Scan Area - Professional Mode

You can select a specific area in your preview image to include in your scanned image. You can select
the entire image area or a portion of it. You can even select multiple scan areas to create multiple
scanned images of different areas (Normal Preview mode only).

You can also use the scan area to select specific Image Adjustments settings for a scanned image. Just
be sure to click inside the scan area before selecting the settings.

Note: In Professional Mode, the default Preview mode is Normal mode. To use Thumbnail Preview
mode instead, select the Thumbnail checkbox beneath the Preview button (if available), then click the
Preview button to preview your image again.

1. Do one of the following to select your scan area in the Preview image:

« Normal preview: Click the & Auto Locate icon to create a marquee (dotted line) on the preview
image.
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« Thumbnail preview: Your scan area is selected automatically, but you can change it. Place your
cursor in one corner of the desired scan area, then click and drag the cursor to the opposite corner
to create a marquee (dotted line) on the preview image.
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2. Do the following, as necessary, to work with the selected scan area:
« |f the marquee is correct, continue with the next step.
» To move the marquee, click inside the scan area and drag the marquee where you want it.

« To resize the scan area, place your cursor over the edge or corner of the marquee, then click and
drag the edges where you want them. (Hold down the Shift key as you resize the marquee to
retain the same width/height proportions.)
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 Normal preview: To create additional marquees (up to 50, if available), click the & Copy Marquee
icon to copy the existing marquee and paste it on the preview image.

« To delete a marquee, click the marquee, then click the & Delete Marquee icon.

Note: If you draw multiple marquees, make sure you select the All button in the Preview window
before you scan. Otherwise, only the area inside the currently selected marquee will be scanned.

3. Click inside the scan area and make any necessary settings in the Epson Scan window.
Parent topic: Scanning in Professional Mode

Available Image Adjustments - Professional Mode
You can select these Adjustments options in Epson Scan Professional Mode.

Adjustments

Q) [l |

[+] [¥] Unshamp Mask

@ [ |

[+] || Descreening
Color Restoration

|| Backlight Comrection

[+] [C] Dust Removal

Note: Not all adjustment settings may be available, depending on the Image Type setting.

Click the =l image adjustment icon to access additional settings.
Click the + (Windows) or » (Mac OS X) icon next to a setting to change the level of adjustment.

Unsharp Mask
Makes the edges of certain image areas clearer. Turn off this option to leave softer edges.
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Descreening
Removes the ripple pattern that might appear in subtly shaded image areas, such as skin tones. This
option improves results when scanning magazines or newspapers. (The results of descreening do not
appear in the preview image, only in your scanned image.)

Color Restoration
Restores the colors in faded photos automatically.

Backlight Correction
Removes shadows from photos that have too much background light.

Dust Removal
Removes dust marks from your originals automatically.

Auto Exposure
Automatically adjusts the image exposure settings when you click the @ Auto Exposure icon. To
automatically adjust image exposure settings continuously, click the Configuration button, click the
Color tab, and select Continuous auto exposure. You can adjust the level of auto exposure using a
slider.

Histogram Adjustment
Provides a graphical interface for adjusting highlight, shadow, and gamma levels individually. (For
advanced users only.) Click the i« histogram icon to access the settings.

Tone Correction
Provides a graphical interface for adjusting tone levels individually. (For advanced users only.) Click
the & tone correction icon to access the settings.

Brightness
Adjusts the overall lightness and darkness of the scanned image.

Contrast
Adjusts the difference between the light and dark areas of the overall scanned image.

Saturation
Adjusts the density of colors in the overall image.

Color Balance
Adjusts the balance of colors in the overall image.

Color Palette
Provides a graphical interface for adjusting mid-tone levels, such as skin tones, without affecting the
highlight and shadow areas of the image. (For advanced users only.) Click the @ Color Palette icon to
access the settings.
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Threshold

Adjusts the level at which black areas in text and line art are delineated, improving text recognition in
OCR (Optical Character Recognition) programs.

Parent topic: Scanning in Professional Mode
Selecting a Scan Size - Professional Mode

You can reduce or enlarge the size of your image as you scan. You can also select a specific scan size,
such as a common photo size like 4 x 6 inches (102 x 152 mm). This places a scan area of that size on
the preview image so you can use it to help crop the image in the correct proportions.

1. Click the Preview button to preview your image.

2. Inthe Epson Scan window, select the size you want your scanned image to be from the Target Size
list.

+] Target Sige Brin_____1~][A]

Note: If you need to rotate the orientation of the target size for your image, click the @ orientation
icon.

A marquee (dotted line) appears on your preview image proportioned for the size you selected.
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Do the following, as necessary, to work with the selected scan area:
« To move the marquee, click inside the scan area and drag the marquee where you want it.

» To resize the scan area, place your cursor over the edge or corner of the marquee, then click and
drag the edge where you want it.

Note: Manually adjusting the marquee will not change the target size of the scanned file. The
marquee only indicates the area of the image that will be scanned.
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4. To create a scanned image size that is not available in the Target Size list, click the Customize
option.

Target Size Mame:

5. Name the custom size, enter the size, click Save, and click OK. Then create a scan area on the
preview image.

The marquee is automatically proportioned for your custom scan size.

6. To use additional sizing tools, click the + (Windows) or » (Mac OS X) icon next to the Target Size
setting and select options as desired.

(=] Target Sige: [51!?'!'1. "]
w | 5m H 700 in - @

Seals: 158 5 &

Thirring: & O @ On

« Scale: Reduces or enlarges your image by the percentage you enter.

146



e Trimming: Turns automatic image cropping on or off.

« @ Unlock icon: Unlocks the width/height proportions of the scanned image size so you can adjust it
without constraint.

Parent topic: Scanning in Professional Mode

Image Preview Guidelines

You can preview your scanned image so you can adjust the scan settings using the preview as a guide.
There are two types of preview available, depending on the scan mode and selected settings:

Thumbnail preview
A thumbnail preview displays your previewed images as thumbnails with the scanned image area and
exposure automatically selected. If the Thumbnail checkbox is selected, clicking the Preview button
opens a thumbnail preview.

Normal preview
A normal preview displays your previewed images in their entirety so you can select the scanned
image area and other settings manually. If the Thumbnail checkbox is deselected, clicking the
Preview button opens a normal preview.

Parent topic: Selecting Epson Scan Settings

Scan Resolution Guidelines

If you plan to enlarge a scanned image so you can print it at a larger size, you may need to increase the
resolution from the default resolution set by Epson Scan. Follow these guidelines to determine the
resolution setting you need:

* You will enlarge the image as you scan it.

If you will enlarge the image using Epson Scan's Target Size setting (Home and Professional modes
only), you do not need to increase the Resolution setting.

» You will scan the image at its original size, but enlarge it later in an image-editing program.

Increase Epson Scan's Resolution setting in your scan. Increase the resolution by the same amount
you will increase the image size to retain a high image quality. For example, if the resolution is 300 dpi
(dots per inch) and you will double the image size later, change the Resolution setting to 600 dpi.

* You will scan the image at 100% or smaller size.
Select Epson Scan's Resolution setting based on how you will use the scanned image:
» Email/view on a computer screen/post on the web: 96 to 150 dpi
* Print/convert to editable text (OCR): 300 dpi
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» Fax: 200 dpi
Parent topic: Selecting Epson Scan Settings

Selecting Scan File Settings

You can select the location, name, and format of your scan file on the File Save Settings window. You
can also select various optional settings that control how Epson Scan behaves when you scan and save

files.

" Other  Desklop Browe

File Marne [Prefis + 3-digh rumbes)

Predi: mg StaitNurber. | 001=]

Image Fomat

Tvpe: |JPEG ipgd >l Options..

Dietails: Comprezzion Levet [15]
E Standard
Embed ICC Profie: OH

[ Dvensrite any files with fhe same name
¥ Show this dislog box before nest scan
¥ Open image folder alter scanning

¥ Show Add Page dislog alter scanning

ak. | Cancel

The File Save Settings window may appear after you click Scan on the Epson Scan window. You may
also be able to access the window by clicking the “* icon on the Epson Scan window.
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1. Do one of the following to select the folder in which you want to save your scanned image:
 Click the button for one of the displayed folders.
* Click the Other button, click the Browse or Choose button, and select a folder.

2. Typein a stem file name in the Prefix field. This name is used along with numbers to automatically
name your scanned files.

Select a different number as the Start Number setting, if you like.

Select the file format you want to use in the Image Format Type menu.

If your file format provides optional settings, click the Options button to select them.
Choose any of the optional settings you want to use by selecting their checkboxes.
Click OK.

Available Scanned File Types and Optional Settings

N o o bk~ ow

Parent topic: Selecting Epson Scan Settings
Available Scanned File Types and Optional Settings

You can select from a variety scanned file types and optional settings on the File Save Settings window
in Epson Scan.

File Formats

Bitmap (*.bmp)
A standard image file format for most Windows programs.

JPEG (*.jpg)
An image format that lets you highly compress image data. However, the higher the compression, the
lower the image quality. (The Tiff format is recommended when you need to modify or retouch your
scanned image.)

Multi-TIFF (*.tif)
A Tiff file format when multiple pages are saved to the same file, allowing you to edit the images using
a compatible program.

PDF (*.pdf)
A document format that is readable by Windows and Mac OS X systems using Adobe Reader,
Acrobat, or other programs. You can save multi-page documents in one PDF file.

PICT (*.pct)
A standard image file format for most Mac OS X programs.
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PRINT Image Matching Il (*.jpg or *.tif)
File formats that include Epson PRINT Image Matching Il data for enhanced quality and a wider color
range (does not affect the way the image displays on the screen).

TIFF (*.tif)
A file format created for exchanging data between many programs, such as graphic and DTP
software.

Optional Settings

Overwrite any files with the same name
Select to overwrite previous files with the same names.

Show this dialog box before next scan
Select to have the File Save Settings window appear automatically before you scan.

Open image folder after scanning
Select to have Windows Explorer or Mac OS X Finder automatically open to the folder where your
scanned image is saved after scanning.

Show Add Page dialog after scanning
If you are scanning a multi-page document using the PDF or Multi-Tiff format, select to display a
prompt for scanning additional pages after the first page is scanned.

Parent topic: Selecting Scan File Settings

Scanning with Mac OS X 10.6/10.7/10.8 Using Image Capture

With Mac OS X 10.6/10.7/10.8, you can scan with your product using an image-editing application such
as Image Capture.

Note: With Mac OS X 10.6, 10.7, or 10.8, in addition to scanning with Image Capture, you can download
and install Epson Scan scanning software. Epson Scan provides additional image adjustment and photo
correction features for enhancing scanned images, and provides an interface for TWAIN-compliant OCR
scanning software, such as ABBYY FineReader. To download Epson Scan, visit Epson's driver
download site (U.S. downloads or Canadian downloads).

Open an image editing application, such as Image Capture.

Select your Epson product from the DEVICES or SHARED list, if necessary.

If you see the Show Details button, click it.

If you are scanning an item on the scanner glass, your product begins a preview scan.
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Select the Scan Mode setting indicating where you placed your original (if available). Select any
other scan settings as necessary.

5can Mode: | Flatbed

Kind: | [ Color

Ak

Resolution: [5g [«]| dpi

_ | Use Custom Size

Size: | U5 Letter
Orientation: '_._ﬂ & €

Scan To: | (i3] Pictures

MName: Scan

Format: | JPEG

Image Correction: | None

Ak

Unsharp Mask | None

ik

Descreening | None

Ak

Backlight Correction | None

Dust Removal | None

Ak

Color Restoration

Hide Details | Overview | |  Scan

Select the folder in which you want to save your scanned file in the Scan To pop-up menu.
Click Scan.
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Your scanned file is saved in the folder you selected.
Available Scan Settings - Mac OS X Image Capture
Parent topic: Scanning

Available Scan Settings - Mac OS X Image Capture
You can select these scan settings in your imaging editing application for Mac OS X.

Unsharp Mask
Makes the edges of certain image areas clearer. Turn off this option to leave softer edges.

Descreening
Removes the ripple pattern that might appear in subtly shaded image areas, such as skin tones. This
option improves results when scanning magazines or newspapers. (The results of descreening do not
appear in the preview image, only in your scanned image.)

Backlight Correction
Removes shadows from photos that have too much background light.

Dust Removal
Removes dust marks from your originals automatically.

Color Restoration
Restores the colors in faded photos automatically.

Parent topic: Scanning with Mac OS X 10.6/10.7/10.8 Using Image Capture

Scanning Special Projects

Your product's scanning software offers various options to help you quickly complete special scan
projects.

Scanning to a PDF File
Restoring Photo Colors as You Scan

Parent topic: Scanning

Scanning to a PDF File

Using Epson Scan, you can scan a multi-page document and save it in one PDF (Portable Document
Format) file on your computer.

1. Place your original on your product for scanning.
2. Start Epson Scan.
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Select the scan mode you want to use.
Select the scan settings for your scan.
Preview your image.

o g k> w

When you finish selecting all your settings, click Scan.
You see the File Save Settings window.

" My Documents
= My Fictues

" Other  Dezhkiop Browrse

- File: M [Prefix + 3-digt numbet] —

Prefix g Stat Number: 001 =

Image Fomat -
Type: [PDF [~.pdi] - Dptions...

Dietail: Paper Size: Actual Image Size
Orientation: Portrait
Margin: [Lelt, Topl 0.00in., 0.00in )
Page Number: Save File \With Al Pages
Compression Level : Standard Compression
Tiext Setling: ‘Yes

[ Owenarite any fles with (ke same name
[¥ Show this dislog box before nest scan

[ Open image folder alter scanring
[¥ Show Add Page dialog after scanring

| 0k I Cancel

7. Select PDF as the Type setting.

8. Select any other settings you want to use on the File Save Settings window. Click the Options
button to access additional settings.
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9. Click OK.
Epson Scan scans your document and you see this window:

Add Page Confirmation

. Scanning cornplete.
)| Do you want to continue scanning and add more pages?

Select Edit Page to finizh scanning and edit the paoes
before zaving the file.

Selact Save File ta finish scanning and save the file
withaout editing the pages.

E. ....................................... I| IW iave Fk

10. Choose one of the following options on the screen:
 If you are scanning only one page, click Save File.

 If you need to scan additional pages in a document, click Add page. Place additional pages on
the product for scanning, click Scan, and repeat until you have scanned all the pages. When you
are finished, click Save File.

« If you need to delete or reorder the scanned pages, click Edit page. Delete or reorder the pages
using the icons that appear on the bottom of the editing window. When you are finished, click OK.

Note: If you installed an OCR (Optical Character Recognition) program, you may see a screen
indicating the program is converting your page to text. Wait until the program re-scans the page and
close the program, if necessary.

11. Click Close to exit the Epson Scan window, if necessary.

Epson Scan scans your original, and saves the PDF file in the selected folder or opens it in your
scanning program. If the file was saved directly to your computer, you see the file in the Windows
Explorer or Mac OS X Finder, where you can view and print the document, if desired.

Parent topic: Scanning Special Projects
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Related tasks

Starting a Scan Using the Epson Scan Icon
Selecting the Scan Mode

Selecting Scan File Settings

Related topics
Placing Originals on the Product

Restoring Photo Colors as You Scan

You can restore the colors in faded photos as you scan them using Epson Scan's Color Restoration
setting. You can select this setting in any of the available scan modes.

Note: Color restoration is not available in Office Mode, if Epson Scan offers that mode.

Place your original on your product for scanning.
Start Epson Scan.

Select the scan mode you want to use.

Select the scan settings for your scan.

Preview your image.

Locate or access the image adjustment settings.

N o g bk wbd e

Select the Color Restoration checkbox.

V] Coloy Restoratior

8. When you finish selecting all your settings, click Scan.
9. Click Close to exit the Epson Scan window, if necessary.

Epson Scan scans your original, and saves the color-restored file in the selected folder or opens it in
your scanning program. If the file was saved directly to your computer, you see the file in the Windows
Explorer or Mac OS X Finder, where you can view and print the image, if desired.

Parent topic: Scanning Special Projects

Related tasks
Starting a Scan Using the Epson Scan Icon
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Selecting the Scan Mode

Related topics
Placing Originals on the Product
Selecting Epson Scan Settings
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Faxing

See these sections to fax using your product.

Note: This product allows you to store names, telephone numbers, and fax data in its memory even
when the power is turned off. Make sure you restore all of the default settings if you give away or dispose
of the product. This will erase all of your network settings and fax data.

Connecting a Telephone or Answering Machine
Setting Up Fax Features

Setting Up Speed Dial and Group Dial Lists
Sending Faxes

Receiving Faxes

Connecting a Telephone or Answering Machine

You must connect your product to a telephone wall jack to send or receive faxes. If you want to use the
same telephone line to receive calls, you can connect a telephone or answering machine to your product
using an additional phone cable.

Note: If you do not connect a telephone to your product, make sure to turn on Auto Answer mode.
Otherwise, you cannot receive faxes.

1. Connect the phone cable to your telephone wall jack and to the LINE port on your product.

Note: If you have a DSL or ISDN connection, you must connect the appropriate DSL filter, or ISDN
terminal adapter or router to the wall jack to be able to use the line for faxing or voice calls using your
product. Contact your DSL or ISDN provider for the necessary equipment.
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DSL connection

1  Telephone wall jack
DSL filter
DSL modem

ISDN connection (one phone number)

1 ISDN wall jack
Terminal adapter or ISDN router

ISDN connection (two phone numbers)
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1 ISDN wall jack
2  Terminal adapter or ISDN router

If you are connecting a telephone or answering machine to your product using a second phone
cable, remove the cap from the EXT port on your product.

! @ ., LINE

Connect the second phone cable to your telephone or answering machine and to the EXT port on
your product.

159



Note: If you connect an answering machine and Auto Answer mode is turned on, set the number of
rings before your product answers a call to a number that is higher than your answering machine's
setting for the number of rings.

Any phone or answering machine must be connected to the EXT port for your product to detect an
incoming fax call when the phone is picked up. Epson cannot guarantee compatibility with VolP,
cable phone systems, or fiberoptic digital services such as FIOS.

Parent topic: Faxing

Related tasks
Receiving Faxes Automatically (Auto Answer)

Setting Up Fax Features

Before faxing with your product, set up your fax header and select the fax features you want to use.

Note: If you leave your product unplugged for a long period of time, you may need to reset the date and
time settings for faxes.

Setting Up Fax Features Using the Product Control Panel
Setting Up Fax Features Using the Fax Utility - Windows
Setting Up Fax Features Using the Fax Utility - Mac OS X

Parent topic: Faxing

Setting Up Fax Features Using the Product Control Panel
See these sections to set up fax features using the product control panel.

Selecting Your Country or Region

Selecting the Date and Time

Entering Fax Header Information

Entering Numbers and Characters for Faxing
Selecting Fax Send and Receive Settings
Selecting Fax Communication Settings
Printing Fax Reports

Restoring Default Fax Settings

Fax Send Options

Fax Receive Options

160



Fax Print Options

Fax Report Options

Fax Communications Options
Fax Security Options

Restore Default Settings Options

Parent topic: Setting Up Fax Features

Related tasks
Setting Up Fax Features Using the Fax Utility - Windows
Setting Up Fax Features Using the Fax Utility - Mac OS X

Selecting Your Country or Region
Before faxing, select the country or region in which you are using your product.

Note: If you change the country or region, your fax settings return to their defaults and you must select
them again.

1. Pressthe & home button, if necessary.
2. Press the left or right arrow button and then select Setup.

setup

@ Ink Levels

== Maintenance

Printer Setup
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3. Select Basic Setup.
Basic Setup

Date/Time

Dayliaht Saving Time

Country/Region

4. Select Country/Region.

5. Scroll up or down, if necessary, then select your country or region.
You see a confirmation screen.

6. If the setting is correct, select Yes. (If not, select No and retry.)

Note: Changing the country or region restores the fax settings to the default settings.

Parent topic: Setting Up Fax Features Using the Product Control Panel
Selecting the Date and Time

Before faxing, select the current date, time, and daylight saving phase in your area, and choose your
preferred date and time format.

1. Press the # home button, if necessary.
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2. Press the left or right arrow button and then select Setup.

setup

(ﬁ Ink Levels

==§ Maintenance

Printer Setup

3. Select Basic Setup.
Basic Setup

Date/Time

Daylight Savina Time

Country/Region

4. Select Daylight Saving Time.
5. Select the setting that applies to your area:
« Winter: it is winter or your region does not use Daylight Saving Time (DST)
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e Summer: it is spring or summer and your region uses Daylight Saving Time (DST)
After making a selection, you return to the Basic Setup screen.

Note: If your region uses Daylight Saving Time (DST), you must change this setting to match the
season. When you change from Winter to Summer, your product automatically sets its clock ahead
one hour. When you change from Summer to Winter, it sets its clock back one hour.

6. Select Date/Time.

Date Format

mn.dd. yyyy

Yyyy.mm.dd

dd.mm.yyyy

7. Select the date format you want to use.
Use the numeric keypad to enter the current date, then select Done.
9. Select the time format you want to use.

10. Use the numeric keypad to enter the current time, select AM or PM if you selected a 12-hour time
format, then select Done.

You return to the Basic Setup screen.
Parent topic: Setting Up Fax Features Using the Product Control Panel
Entering Fax Header Information

Before faxing, add your sender name and fax number to the fax header to identify the source of the faxes
you send.

1. Press the # home button, if necessary.
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2. Press the left or right arrow button and then select Setup.

setup

(ﬁ Ink Levels

==§ Maintenance

Printer Setup

3. Scroll down and select Fax Settings.
Fax Settings

send Settings

Receive Settings

Print Settings

4. Scroll down and select Communication.
5. Select Header.
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6. Select Fax Header.

| s || 2rec |3 per

7. Use the numeric keypad to enter the sender name for your fax source, such as your name or a
business name. You can enter up to 40 characters.

8. Select Done.
You return to the Header screen.
9. Select Your Phone Number.

Your Phone Number
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10. Use the numeric keypad to enter your fax number, up to 20 characters. For international numbers
that require use of a + symbol, press the # key.

Note: When entering a phone number, the * key does not work.

11. Select Done.
You return to the Header screen.
Parent topic: Setting Up Fax Features Using the Product Control Panel

Related tasks
Entering Numbers and Characters for Faxing

Entering Numbers and Characters for Faxing
Follow these guidelines to enter numbers and characters for faxing and setting up your fax settings.

B Q yyz b |

Dome : I H Do

» To enter text or characters, press the keys on the numeric keypad until the desired character or
number appears.

» To enter symbols, press the 1 Symb. key until the desired symbol appears.

» To enter a pause symbol (=) in phone numbers requiring a brief pause during dialing, press ==3.
» To move the cursor to the next space, press &=a.

» To delete the previous character, press k=1

Parent topic: Setting Up Fax Features Using the Product Control Panel
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Selecting Fax Send and Receive Settings
You can select the fax quality and other settings for incoming and outgoing faxes.
1. Press the & home button, if necessary.
2. Press the left or right arrow button and then select Setup.

setup

(ﬁ Ink Levels

==§ Maintenance

Printer Setup

3. Scroll down and select Fax Settings.
Fax Settings

send Settings

Receive Settings

Print Settings

4. Select Send Settings or Receive Settings.
5. Change any of the available settings.
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6. Press the # home button to exit.

Parent topic: Setting Up Fax Features Using the Product Control Panel
Related references

Fax Send Options

Fax Receive Options

Selecting Fax Communication Settings

You can customize how your product sends and receives faxes over your phone line.
1. Pressthe 4 home button, if necessary.

2. Press the left or right arrow button and then select Setup.

setup

@ Ink Levels

== Maintenance

Printer Setup
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3. Scroll down and select Fax Settings.
Fax Settings

Send Settings

Receive Settings

Print Settings

4. Scroll down and select Communication.

5. Change any of the available settings.

6. Pressthe # home button to exit.

Parent topic: Setting Up Fax Features Using the Product Control Panel

Related references
Fax Communications Options

Printing Fax Reports

You can run a variety of reports on your fax transmissions and print your speed and group dial lists.

Note: You can also select to print a report automatically after a fax is sent by going to Setup > Fax
Settings > Send Settings > Last Transmission Report.

1. Make sure you loaded letter-size or larger paper in your product.
2. Press the & home button, if necessary.
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3. Select Fax.

Fax

Enter Fax Number

Jan. 01,2011 12:00 AN

Contacts Redial
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4. Select Advanced Options.
5. Scroll down and select Fax Report.

Fax Report

Fax Settings List

Fax Log

Last Transmission *

—_—y

6. Select one of the available reports.
7. Press the ¢ start button to print the report.
Parent topic: Setting Up Fax Features Using the Product Control Panel
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Related references
Fax Report Options

Restoring Default Fax Settings
You can restore your fax settings to their default options, if necessary.
1. Press the & home button, if necessary.
2. Press the left or right arrow button and then select Setup.

setup

(ﬁ Ink Levels

==§ Maintenance

Printer Setup

3. Scroll down and select Restore Default Settings.

Restore Default Settings

Fax Send/Receive Settinas
Fax Data Settinas

Wi-Fi/Network Settinas
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4. Select one of the available options.
You see a confirmation screen.
5. Select Yes or No.
Parent topic: Setting Up Fax Features Using the Product Control Panel

Related references
Restore Default Settings Options

Fax Send Options
Set the Send Settings options you want to use for outgoing faxes.

Setting Options Description
Resolution Standard Provides good scan resolution and print quality for
most faxes
Fine Provides best scan resolution and print quality for
faxes of small print and line art
Photo Provides best scan resolution and print quality for
faxed photos
Contrast —4to +4 Adjusts the contrast for faxes; negative settings make
faxes lighter and positive settings make faxes darker
2-Sided Faxing Off Lets you fax 2-sided originals placed in the ADF
On
Direct Send Off Sends a monochrome fax to a single recipient as
on soon as the connection is made without saving the

scanned image to memory

You cannot use this setting when sending a color fax
or to multiple recipients.

Send Preview Off Lets you view the scanned image before sending
On

Parent topic: Setting Up Fax Features Using the Product Control Panel
Fax Receive Options
Set the options you want to use for incoming faxes.
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Double & Triple

Setting Options Description
Auto Answer Off Allows you to confirm if an incoming fax should be
printed; A telephone must be connected to the
product
On Automatically receive and print faxes
DRD All If you are using a Distinctive Ring Service on your
Single phone line, your telephone company can assign two
9 or more phone numbers to the same line and assign
Double different ring patterns to each. If you use this service,
Triple select the number of rings for your fax number as the

DRD setting so your product can receive faxes on the
correct number of rings. All is the default setting and
works for phone lines that do not use this service.

Rings to Answer

1to 9

Sets the number of rings before your product receives
a fax. The default setting is 4. If Auto Answer is turned
on and an answering machine is connected to the
product, make sure this setting is set higher than the
number of rings your answering machine is set to
answer a call.

Fax Output

Save to Inbox

Save to Computer

Save to External
Device

Create Folder to
Save

Lets you save received faxes in the product's
memory, on a computer, or on an external USB
storage device

Remote Receive

Off

On

Lets you receive faxes from a cordless handset
whose base is connected to the product

Parent topic: Setting Up Fax Features Using the Product Control Panel

Fax Print Options

Set the Print Settings options you want to use for incoming faxes.
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Setting Options Description
Paper Size Letter Sets the size of the paper loaded for incoming faxes
Legal
A4
Auto Reduction On Reduces size of incoming faxes to fit on the size of
paper selected as the Paper Size setting
Off Prints incoming faxes in original size or on multiple
sheets, if loaded paper size is smaller
Collation Stack Off Select On to print received faxes in descending order
On
Print Inhibit Time Off Lets you stop automatic printing of faxes during a
on specified period of time; received faxes are saved in

the product's memory

Parent topic: Setting Up Fax Features Using the Product Control Panel

Fax Report Options

Set the options to use for printing reports.

Setting Options Description
Last Transmission On Error Prints a report on the last transmitted fax only if a fax
Report error occurs (default setting)
On Send Prints a report on the last transmitted fax after every
fax you send
Off Does not print a report on the last transmitted fax
after you send a fax
Attach Image to Report | Off Lets you print the Last Transmission Report with an

On (Small Image)

image of the first page of the document

On (Large Image)
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Setting Options Description

Fax Log Auto Print Off Does not print a log report
On (Every 30) Prints a log report each time 30 fax transmissions
are completed
On (Time) Prints a log report at a specified time
Report Format Simple Lets you choose to print fax log reports in simple or

detailed format

Detail

Parent topic: Setting Up Fax Features Using the Product Control Panel
Fax Communications Options
Set the communication options you want to use for faxing over your phone line.

Setting Options Description
Header Fax Header Lets you add the header information to outgoing
Your Phone faxes
Number
Dial Tone Detection On Automatically dials the phone number you enter to
send a fax when the product detects a dial tone on
the line
Off Turns off automatic dial tone detection; this is

necessary if you connected your product to a phone
line on a Private Branch Exchange (PBX) or
Terminal Adapter (TA) system

Fax Speed Fast(33,600bps) Transmits faxes at 33.6 Kbps
Medium(14,400bps) | Transmits faxes at 14.4 Kbps (default setting)
Slow(9,600bps) Transmits faxes at 9.6 Kbps

ECM On Turns on Error Correction Mode (ECM) to

automatically request retransmission of faxes
received with detected errors (default setting)

Off Turns off Error Correction Mode (ECM)
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Setting Options Description
Line Type PSTN Lets you change the line type for your product; PSTN
PBX (default) is a standard phone line; PBX is used in

office environments where an access code such as
"9" must be dialed to call an outside line

Parent topic: Setting Up Fax Features Using the Product Control Panel

Fax Security Options

Set the Security Settings options you want to use for fax data.

Setting Options Description

Auto Erase Backup Off Select On to automatically erase sent or received fax

Data on data remaining in your product's memory

Erase Backup Data Yes No Deletes all sent or received fax data remaining in your
product's memory; select Yes if you are giving away
or disposing of your product

Parent topic: Setting Up Fax Features Using the Product Control Panel

Restore Default Settings Options

Select the product settings you want to restore.

Fax Send/Receive Settings

Restores all of the default fax settings on the Send Settings, Receive Settings, and

Communication screens.
Fax Data Settings

Erases the speed dial list, group dial list, header, and fax log.

Wi-Fi/Network Settings

Restores all of the default network settings.

All Except Wi-Fi/Network & Fax Settings

Restores all of the default settings on the control panel, except for the network and fax settings.

All Settings

Restores all of the default settings on the control panel.
Parent topic: Setting Up Fax Features Using the Product Control Panel
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Setting Up Fax Features Using the Fax Utility - Windows
You can set up your fax header and select your fax settings using the FAX Utility for Windows.
1. Do one of the following:
« Windows 8: Navigate to the Start screen.

* Windows (other versions): CIicka or Start > Programs or All Programs > EPSON Software.
2. Select FAX Utility.
You see this window:

3. Select Fax Settings for Printer. (Select your product, if prompted.)
You see this window:
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- Fax Settings for Printer - o lEN

Tool — Check Fax Connection

Fax Settings

Speed Dial/Group Dial List

Help Help

Select Fax Settings.
5. Follow the prompts that appear on the screen to enter your fax header information and select your
fax settings.

Note: For detailed information, select the FAX Utility Help option.

Parent topic: Setting Up Fax Features
Related topics
Setting Up Fax Features Using the Product Control Panel

Setting Up Fax Features Using the Fax Utility - Mac OS X

You can set up your fax header and select your fax settings using the FAX Utility for Mac OS X.
1. Do one of the following:

* Mac OS X 10.6/10.7/10.8: In the Apple menu or the Dock, select System Preferences. Select
Print & Fax or Print & Scan, select the FAX option for your product, and select Options &
Supplies. Select Utility and select Open Printer Utility.

* Mac OS X 10.5: In the Apple menu or the Dock, select System Preferences. Select Print & Fax,
select the FAX option for your product, and select Open Print Queue. Select Utility.
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2. Double-click FAX Utility, if necessary.
You see this window:

Printer FAX

Tool < \ s ]I_a

e =

Fam Trargmsson Sanchronize Fax Regeivs Monsor
Ropoeed Coseacrs

Fax Settings ‘.;“‘_?-2 \_{ L\ tti

Chack Fax Fax Sestinga Speed DaaliGroup
> Conmbelies Dl List

3. Select your FAX product in the Printer list.
Select Fax Settings.

5. Follow the prompts that appear on the screen to enter your fax header information and select your
fax settings.

Note: For detailed information, select the FAX Utility ? icon.

Parent topic: Setting Up Fax Features

Related topics
Setting Up Fax Features Using the Product Control Panel

Setting Up Speed Dial and Group Dial Lists

You can set up a speed dial list of fax numbers so you can quickly select them for faxing. You can also
set up a group dial list to send a fax message to multiple speed dial numbers.

See these sections to set up speed dial and group dial lists.

Setting Up Speed/Group Dial Lists Using the Product Control Panel
Setting Up Speed/Group Dial Lists Using the Fax Utility - Windows
Setting Up Speed/Group Dial Lists Using the Fax Utility - Mac OS X

Parent topic: Faxing
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Setting Up Speed/Group Dial Lists Using the Product Control Panel

You can set up your speed dial and group dial lists using the control panel on your product.
Creating Speed Dial List Entries

Printing Your Speed Dial List

Creating Group Dial List Entries

Printing Your Group Dial List

Parent topic: Setting Up Speed Dial and Group Dial Lists

Related tasks

Setting Up Speed/Group Dial Lists Using the Fax Utility - Windows

Setting Up Speed/Group Dial Lists Using the Fax Utility - Mac OS X

Creating Speed Dial List Entries

You can create a speed dial list of fax numbers to help you quickly send faxes.
Note: You can create up to 60 speed dial and group dial entries combined.

1. Pressthe & home button, if necessary.
2. Select Fax.

Fax

Enter Fax Number

Jan. 01,2017 12:00 AH

Contacts Redial
= -—-wl
_fidvanced Options

3. Select Contacts.
4. Select Add/Edit Contacts.

181



5. Select Speed Dial Setup.

Add Speed Dial

6. Select the number you want to use for the fax number you are adding.

7. Use the numeric keypad to enter the fax number. You can enter up to 64 characters.
Select Done.
You see this screen:

Enter Hame

1 gt |2 fec |3 o

9. Use the numeric keypad to enter a name for the speed dial entry. You can enter up to 30 characters.
10. Select Done.
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You return to the Add/Edit Contacts screen.
11. Do the following as necessary:
» To create additional entries, select Speed Dial Setup and repeat the steps above.
< To edit an existing entry, select Edit Contacts, select the entry, and change the information.

« To delete an entry, select Delete Contacts, select the entry, select Proceed, and confirm the
deletion.

Parent topic: Setting Up Speed/Group Dial Lists Using the Product Control Panel

Related tasks
Printing Your Speed Dial List

Printing Your Speed Dial List
You can print your speed dial list for easy reference.
1. Load paper in your product.
2. Press the 4 home button, if necessary.
3. Select Fax.

Fax

Enter Fax Number

Jan.01.2011 12:00 &AM

Contacts Redial
—‘I

fidvanced Options

4. Select Advanced Options.
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5. Scroll down and select Fax Report.

Fax Report

Fax Settings List

Fax Log

Last Transmission

6. Scroll down and select Speed Dial List.
7. Press the ¢ start button to print the report.

Parent topic: Setting Up Speed/Group Dial Lists Using the Product Control Panel
Creating Group Dial List Entries

You can create a group dial list after creating a speed dial list. Each group dial list can include up to 30
fax numbers.

Note: You can create up to 60 speed dial and group dial entries combined.

1. Pressthe & home button, if necessary.
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2. Select Fax.

Fax

Enter Fax Number

Jan. 01,2011 12:00 AN

Contacts Redial
—v
Advanced Options

Select Contacts.
Select Add/Edit Contacts.
Select Group Dial Setup.

Use the numeric keypad to enter a name for the group dial entry. You can enter up to 30 characters.

3
4
5
6. Select the number you want to use for the group dial entry you are adding.
7
8. Select Done.

9

Select the speed dial entry you want to add to the group and press [*1to select it.
10. Continue selecting speed dial entries as necessary.
11. When you are finished, select Done.
You return to the Add/Edit Contacts screen.
12. Do the following as necessary:
« To create additional entries, select Group Dial Setup and repeat the steps above.
« To edit an existing entry, select Edit Contacts, select the entry, and change the information.

» To delete an entry, select Delete Contacts, select the entry, select Proceed, and confirm the
deletion.

Parent topic: Setting Up Speed/Group Dial Lists Using the Product Control Panel
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Related tasks
Creating Speed Dial List Entries
Printing Your Group Dial List

Printing Your Group Dial List
You can print your group dial list for easy reference.
1. Load paper in your product.
2. Press the  home button, if necessary.
3. Select Fax.

Fax

Enter Fax Number

Jan. 01,2011 12:00 AN

Contacts Redial
—v
Advanced Options

4. Select Advanced Options.
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5. Scroll down and select Fax Report.

Fax Report

Fax Settings List

Fax Log

Last Transmission

6. Scroll down and select Group Dial List.
7. Press the ¢ start button to print the report.
Parent topic: Setting Up Speed/Group Dial Lists Using the Product Control Panel

Setting Up Speed/Group Dial Lists Using the Fax Utility - Windows

You can set up your speed dial and group dial lists using the FAX Utility for Windows. The utility also lets
you import fax numbers from the Windows Address Book and back up fax numbers stored in your
product's memory.

Note: You can create up to 60 speed dial and group dial entries combined.

1. Do one of the following:
* Windows 8: Navigate to the Start screen.

* Windows (other versions): CIickE]' or Start > Programs or All Programs > EPSON Software.
2. Select FAX Utility.
You see this window:
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Select Fax Settings for Printer. (Select your product, if prompted.)
You see this window:
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4. Select Speed Dial/Group Dial List.
You see this window:

5. Select an empty entry and click the # icon.

Note: To edit an entry, select it and click the # icon. To delete an entry, select it and click the &
icon.

6. Do one of the following:
« To create a speed dial entry, select Speed Dial, enter a name and fax number, and click OK.

« To create a group dial entry, select Group, enter a name, select your desired fax numbers, and
click OK.

7. Repeat the previous steps as necessary to add all your speed dial or group dial entries.
8. When you are finished, click the £ icon to save the entries to your product's memory.
Parent topic: Setting Up Speed Dial and Group Dial Lists

Related topics
Setting Up Speed/Group Dial Lists Using the Product Control Panel

Setting Up Speed/Group Dial Lists Using the Fax Utility - Mac OS X

You can set up your speed dial and group dial lists using the FAX Utility. The utility also lets you import
fax numbers from the MacAddress Book and back up fax numbers to your product's memory.

Note: You can create up to 60 speed dial and group dial entries combined.

1. Do one of the following:

* Mac OS X 10.6/10.7/10.8: In the Apple menu or the Dock, select System Preferences. Select
Print & Fax or Print & Scan, select the FAX option for your product, and select Options &
Supplies. Select Utility and select Open Printer Utility.

» Mac OS X 10.5: In the Apple menu or the Dock, select System Preferences. Select Print & Fax,
select the FAX option for your product, and select Open Print Queue. Select Utility.

2. Double-click FAX Utility, if necessary.
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You see this window:

FAX Uikt

Printer FAX
Tool o
= - [
o= o3 —=
Fam Trarpmingios Sanchronae Fax Repene BMansor
L CBaLacry
Fax Settings ] \‘ l Ii
Check Fax Fam Sastings Speed DaliGraup
2 Constoiies éad List

Select your FAX product in the Printer list.
Select Speed Dial/Group Dial List.
You see this window:

‘a6 Speed DialfCroup Dial List

L2ty bw Base e hase Fkin Bor=a ity

To add an entry, double-click an empty entry.

Note: To edit an entry, select it and change the information. To delete an entry, select it and press
the Delete key on your keyboard.
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6. Do one of the following:
« To create a speed dial entry, select Speed Dial, enter a name and fax number, and click OK.

» To create a group dial entry, select Group Dial, enter a name, select your desired fax numbers,
and click OK.

7. Repeat the previous steps as necessary to add all your speed dial or group dial entries.
8. To import entries from your MacAddress book, click the | % icon.

9. When you are finished, click the |- icon to save the entries to your product's memory.
Parent topic: Setting Up Speed Dial and Group Dial Lists

Related topics
Setting Up Speed/Group Dial Lists Using the Product Control Panel

Sending Faxes
See these sections to send faxes using your product.

Sending Faxes from the Product Control Panel
Sending Faxes Using the Fax Utility - Windows
Sending Faxes Using the Fax Utility - Mac OS X

Parent topic: Faxing

Sending Faxes from the Product Control Panel
See these sections to send faxes using the product's control panel.

Manually Dialing or Redialing Fax Numbers
Selecting Fax Numbers from Speed or Group Dial Lists
Dialing Fax Numbers from a Connected Telephone
Broadcasting a Fax
Sending a Fax at a Specified Time
Fax Sending Options
Parent topic: Sending Faxes
Manually Dialing or Redialing Fax Numbers

You can send a fax from your product control panel by manually dialing the fax number or redialing the
last dialed fax number.

1. Place your original on the product for faxing.
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2. Press the 4 home button, if necessary.
3. Select Fax.

Fax

Enter Fax Number

Jan.01.2011 12:00 &AM

Contacts Redial
—‘I

fidvanced Options

4. Do one of the following:

» Select the Enter Fax Number area on the LCD display, then use the numeric keypad to enter the
fax number. You can enter up to 64 characters.

» Select Redial to redial the last dialed fax number.
5. If you need to change any fax settings, scroll down and select your settings.

Note: If your recipient's fax machine does not print in color, your fax is automatically sent in black-
and-white.

6. Press the ¢ start button. If prompted, select where you placed your document (ADF or scanner
glass).

Note: To cancel faxing, select Cancel.

Your product scans your original and prompts you to place additional pages, if necessary.
After scanning your originals, your product dials the number and sends the fax.

Note: If the number is busy or there is a communication problem, your product displays a redialing
message and will redial the number in a few minutes.

192



Parent topic: Sending Faxes from the Product Control Panel

Related references
Fax Sending Options

Related tasks
Entering Numbers and Characters for Faxing

Related topics
Placing Originals on the Product

Selecting Fax Numbers from Speed or Group Dial Lists

You can send a fax from your product control panel by selecting a speed dial or group dial entry from the
list.

1. Place your original on the product for faxing.
2. Press the  home button, if necessary.
3. Select Fax.

Fax

Enter Fax Number

Jan. 01,2017 12:00 AH

Contacts Redial

.wi

_Qd'uar'-u::eﬂ Elptil;_r-ur.-:

Select Contacts.
5. Select the speed dial or group dial entry you want to use.
6. If you need to change any fax settings, scroll down and select your settings.

Note: If your recipient's fax machine does not print in color, your fax is automatically sent in black-
and-white.
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7. Press the ¢ start button. If prompted, select where you placed your document (ADF or scanner
glass).

Note: To cancel faxing, select Cancel.

Your product scans your original and prompts you to place additional pages, if necessary.
After scanning your originals, your product dials the number and sends the fax.

Note: If the number is busy or there is a communication problem, your product displays a redialing
message and will redial the number in a few minutes.

Parent topic: Sending Faxes from the Product Control Panel

Related references
Fax Sending Options

Related topics
Placing Originals on the Product
Setting Up Speed Dial and Group Dial Lists

Dialing Fax Numbers from a Connected Telephone

If you have connected a telephone to the EXT port on your product, you can send a fax by dialing the fax
number from the connected telephone.

1. Place your original on the product for faxing.
2. Press the  home button, if necessary.
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3.

8.

Select Fax.

Fax

Enter Fax Number

Jan. 01,2011 12:00 AN

Contacts Redial
—v
Advanced Options

Dial the fax number from the connected telephone.
Select Send on the LCD display.

Note: Your product now communicates with the recipient's fax machine. Do not hang up the
telephone.

If you need to change any fax settings, scroll down and select your settings.

Note: If your recipient's fax machine does not print in color, your fax is automatically sent in black-
and-white.

Press the ¢ start button. If prompted, select where you placed your document (ADF or scanner
glass).

Note: To cancel faxing, select Cancel.

Your product scans your original and prompts you to place additional pages, if necessary.
Hang up the telephone.

After scanning your originals, your product sends the fax.

Parent topic: Sending Faxes from the Product Control Panel
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Related references
Fax Sending Options

Related topics
Placing Originals on the Product

Broadcasting a Fax

You can easily send a fax to several recipients at the same time using your speed dial list or group dial
list, or by entering phone numbers. You can send the same fax to up to 30 phone numbers.

Note: You can only send faxes in black-and-white when you use this option.

1. Place your original on the product for faxing.
2. Press the # home button, if necessary.
3. Select Fax.

Fax

Enter Fax Number

Jan 01,2017 12:00 AH

Contacts Redial
—v
fidvanced Options

4. Select Advanced Options.

5. Select Broadcast Fax.

6. Select Add New then do one of the following:
» Select Enter Fax Number then use the numeric keypad to manually enter fax numbers.
» Select Select From Contacts then select a speed or group dial entry.

~

Repeat the step above to add additional fax recipients, if necessary.
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8. When you have finished selecting your recipients, select Done.

9. Ifyou need to change any fax settings, scroll down and select your settings.

10. Press the @ start button. If prompted, select where you placed your document (ADF or scanner
glass).
Note: To cancel faxing, select Cancel.

Your product scans your original and prompts you to place additional pages, if necessary.
After scanning your originals, your product dials the number and sends the fax.

Note: If the number is busy or there is a communication problem, your product displays a redialing
message and will redial the number in a few minutes.

Parent topic: Sending Faxes from the Product Control Panel

Related references
Fax Sending Options

Related topics
Placing Originals on the Product

Sending a Fax at a Specified Time
You can send a fax at a time of your choice.

Note: You can only send faxes in black-and-white when you use this option.

1. Place your original on the product for faxing.
2. Press the w home button, if necessary.
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3. Select Fax.

Fax

Enter Fax Number

Jan. 01,2011 12:00 AN

Contacts Redial
—v
Advanced Options

Enter a phone number or select a number from a speed or group dial list.
Select Advanced Options.

4

5

6. Select Send Fax Later.

7. Select On, use the number pad to enter your desired time, then select Done.
8. If you need to change any fax settings, scroll down and select your settings.
9

Press the ¢ start button. If prompted, select where you placed your document (ADF or scanner
glass).

Note: To cancel faxing, select Cancel.

Your product scans your original and prompts you to place additional pages, if necessary.

After scanning your originals, your product dials the number and sends the fax at the specified time. You
cannot send additional faxes until the timed fax has been sent.

Note: If the number is busy or there is a communication problem, your product displays a redialing
message and will redial the number in a few minutes.

Parent topic: Sending Faxes from the Product Control Panel
Fax Sending Options
While sending a fax, you can select these options.
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Setting Options Description
Resolution Standard Provides good scan resolution and print quality for
most faxes
Fine Provides best scan resolution and print quality for
faxes of small print and line art
Photo Provides best scan resolution and print quality for
faxed photos
Contrast —4to +4 Adjusts the contrast for faxes; negative settings make
faxes lighter and positive settings make faxes darker
2-Sided Faxing Off Lets you fax 2-sided originals placed in the ADF
On
Direct Send Off Sends a monochrome fax to a single recipient as
on soon as the connection is made without saving the
scanned image to memory
You cannot use this setting when sending a color fax
or to multiple recipients
Send Preview Off Lets you view the scanned image before sending
On

Parent topic: Sending Faxes from the Product Control Panel

Sending Faxes Using the Fax Utility - Windows

You can send a fax from a printing program in Windows. You can fax up to 100 pages at a time,

including a cover sheet.

1. Open the file you want to fax and select the print command.

You see a window like this:
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General

Sedect Prirder

& Add Printer
i EPSON

[ EFSON (FAX)

<

Sistus: Offine
Location
Comment:

Select your product with the FAX option as the printer.
To change the Paper Size, Orientation, Color, Image Quality, or Character Density settings, click the
Preferences or Properties button.

Note: If you see a Setup, Printer, or Options button, click it. Then click Preferences or Properties
on the next screen. For more information about selecting fax print settings, click Help.

Select the Page Range as necessary. (Leave the Number of copies setto 1.)
Click Print.

If you're faxing for the first time, you see a window like this one:
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9.

Plescipeent List: Recpent Total: 1
Mamee. Group Mame Fae Humber Compary,Tomp [
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Fiax Musnbser:

[

Becmrse *-" acts a5 8 pause, do not use it b
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Envision,Tithe:

|

Enter your sender information so that recipients can identify the origin of the fax. Then click OK to
save the sender information.

Add a cover sheet, input a fax number, or set up a phone book of numbers for future use, then click
Next.

Note: For detailed instructions on using the Epson FAX Utility, click Help.

If you added a cover sheet to your fax, select a cover sheet style, enter your subject and comment
information, then click Next.

Click Send to transmit your fax.

Parent topic: Sending Faxes

Sending Faxes Using the Fax Utility - Mac OS X

You can send a fax from a Mac OS X printing program using the FAX Utility. You can fax up to 100
pages at a time, including a cover sheet.
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Open the file you want to fax.
Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.

Printer: | FAX T‘ E

Presets: | Standard Ti

Copies: 1 F‘!Cullated
Pages: () all : )
() Fram: 1 to: |1

Paper Size: | US Letter T] £.50 by 11.00 inches

Orientation: ‘i_ I.l'_

Select your product FAX option as the Printer setting.

If necessary, click the arrow next to the Printer setting or the Show Details button to expand the
print window.

Select the number of pages you are faxing as the Pages setting.
Note: Leave the Copies setting set to 1.

Select Recipient Settings from the pop-up menu.
You see this window:
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Recipient Settings T]

Recipient List:

Marre Company fCorp. Fax Murnber
l -
Add:
Name: .
Company/Corp.: [
Fax Number: |

A hyphen (-) is available only at the
beginning of the phone number because
it acts as a pause in dialing.

External Access Prefix:

- 5
( Cancel Fax
i -

Do one of the following to choose your recipient:
« Select a name or group from the Recipient List.
< Enter a name, company, and fax number and click the + button.

» Click the E icon and select a recipient from your address book.
Select Fax Settings from the pop-up menu.
You see this window:
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Fax Settings ﬂ

Color: ) Black & White
() Color

Image Quality; | Mormal ﬂ

/_Cancel 4 If Fax

-

9. Selectthe Color and Image Quality settings you want to use for your fax.
10. Click Fax.

Parent topic: Sending Faxes

Receiving Faxes

See these sections to receive faxes with your product.

Fax Reception
Receiving Faxes Automatically (Auto Answer)
Receiving Faxes Manually

Parent topic: Faxing

Fax Reception

Your product will automatically receive and print faxes when you set fax reception to Auto Answer mode.

If you connected a telephone to your product so you can use the same phone line for faxes and voice
calls, you can also set your product to receive faxes manually. This allows you to check for a fax tone
using the telephone and press a button on your product to receive the fax.

Make sure to load paper in your product and select your fax settings before receiving a fax.

Note: If you run out of paper during fax printing, load more paper and press the button indicated on your
product's LCD screen to continue.

Parent topic: Receiving Faxes
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Receiving

Receiving

Faxes Automatically (Auto Answer)
To receive and print faxes automatically, you can turn on Auto Answer mode.

Check the % auto answer icon on your product's Home screen to see if Auto Answer mode is turned on
or not.

) Home
Print
Lopy Photos

To turn Auto Answer mode on or off, select Setup > Fax Settings > Receive Settings > Auto Answer.

If an answering machine is connected, make sure the product's Rings to Answer setting is set higher
than the number of rings your answering machine is set to answer a call. For example, if the answering
machine is set to pick up on the fourth ring, set the product to pick up on the fifth ring or later.

If a telephone is connected, and you use it to answer a call that turns out to be a fax, wait until the
product's LCD screen displays a message that a connection has been made before hanging up.

Parent topic: Receiving Faxes

Related references
Fax Receive Options
Fax Communications Options

Related tasks
Receiving Faxes Manually

Faxes Manually

You can set up your product to receive faxes manually by turning off Auto Answer mode. This lets you
check for a fax tone on the connected telephone before receiving a fax.
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When the connected telephone rings, answer the call.
If you hear a fax tone, select Receive on the LCD display.
Press the ¢ start button, then hang up the phone.

P w N PR

Press the ¢ start button again to print the fax.
Parent topic: Receiving Faxes

Related references
Fax Receive Options

Related tasks
Receiving Faxes Automatically (Auto Answer)
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Using Memory Cards With Your Product

Follow the instructions here to work with a memory card inserted into your product.

Inserting a Memory Card
Printing from a Memory Card
Transferring Photos on a Memory Card

Inserting a Memory Card
Insert only one memory card at a time into the memory card slot on your product.

1. Make sure the memory card and the files on it are compatible with your product before inserting the
card.

2. Open the cover and insert your memory card into the slot, making sure the card is oriented correctly.

1  Memory card access light

Note: Do not force the card all the way into the slot. Insert it only until it meets resistance.
The memory card access light flashes and then stays lit.

Caution: Do not remove the memory card or turn off your product while the memory card access light is
flashing or you may lose data from the memory card.

Memory Card Types
Memory Card File Specifications
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Removing a Memory Card
Parent topic: Using Memory Cards With Your Product

Memory Card Types

You can insert these types of memory cards in your product.

Note: Cards marked with an asterisk (*) require an adapter; consult your adapter documentation for
details on using it.

You can insert the following cards in the memory card slot:
* Memory Stick Duo

* Memory Stick PRO Duo

e Memory Stick PRO-HG Duo

* Memory Stick Micro*

* MagicGate Memory Stick Duo

+ SDXC

» SDHC

« SD

* MiniSDHC*

* miniSD*

* microSDXC*

* microSDHC*

* microSD*

Parent topic: Inserting a Memory Card

Memory Card File Specifications
You can insert memory cards in your product containing files that meet these specifications.

File format JPEG with the Exif version 2.3 standard
Image size 80 x 80 pixels to 10200 x 10200 pixels
Number of files Up to 9990
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Parent topic: Inserting a Memory Card

Removing a Memory Card

After you finish working with a memory card, you can check to make sure it is safe to remove it from your
product.

Caution: Do not remove a memory card or turn off your product while the memory card access light is
flashing or you may lose data from the memory card.

1. Make sure the memory card access light is not flashing.
| | [/
g T
0] E-8
~

=

2. If your product is connected to your computer using a USB cable, do one of the following:

* Windows: Open the My Computer, Computer, or Windows Explorer utility. Then right-click the
name of your memory card (listed as a removable disk) and select Eject.

« Mac OS X: Drag the removable disk icon for your memory card from the desktop into the trash.
3. Pull the memory card straight out of its slot.
Parent topic: Inserting a Memory Card

Printing from a Memory Card
See these sections to print photos from a memory card inserted into your product:

Viewing and Printing Photos
Printing Photo Layouts from a Memory Card
Printing Photo Greeting Cards

Parent topic: Using Memory Cards With Your Product
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Viewing and Printing Photos

See these sections to view and print photos displayed on your product's LCD screen.

Viewing and Printing Photos

Cropping Photos Displayed on the LCD Screen

Photo Adjustment Options - Memory Card

Print Setting Options - Memory Card

Paper Type Settings - Memory Card

Parent topic: Printing from a Memory Card
Viewing and Printing Photos

You can select photos for printing as you view them on the LCD screen.
1. Select Print Photos.

select Photos

Jale I I

Options settings

2. Do one of the following to select your photos:

» To select individual photos, select the thumbnail image of the photo you want to print, then press +
or —to select the number of copies (up to 99). Press the left or right arrow button to scroll through
and select additional photos, or press the 3 back button to return to the thumbnail image view and
select another photo.

« To select all photos, select Options > Select Photos > Select All Photos, then press + or —to
select the number of copies (up to 99). Select Done when finished.
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« To select photos based on the date they were taken, select Options > Browse > Browse by
Date , then select any of the dates shown. Select Proceed, select the thumbnail, then press + or —
to select the number of copies (up to 99). Select Done when finished.

3. To adjust your photos, do either of the following as necessary (adjustments modify only your printed
copy, not the original file):

« To crop, zoom into, or rotate a photo, select the thumbnail image of the photo you want to modify,
then select Edit > Crop/Zoom. Make the necessary adjustments, select OK, then OK when
finished.

« To change the appearance (e.g., brightness and contrast) of your printed photos, select the
thumbnail image of a photo, select Edit > Photo Adjustments, and select the necessary settings.
When you are finished, press the  back button twice.

4. To change the print settings, select Settings, then select the necessary settings. When you are
finished, press the 3 back button.

5. When you are ready to print, press the & start button.
Note: To cancel printing, select .

Parent topic: Viewing and Printing Photos

Related references
Photo Adjustment Options - Memory Card
Print Setting Options - Memory Card

Related tasks
Cropping Photos Displayed on the LCD Screen

Cropping Photos Displayed on the LCD Screen

If you want to crop or rotate photos displayed on the LCD screen, select the thumbnail image of the
photo you want to modify, select Edit > Crop/Zoom, and select the necessary options.

» To crop the photo, press + to move the yellow crop area inward or — to move the crop area outward.
» To move the crop area, press the arrow buttons.

 To rotate the crop area, press 9.

» To check the cropped image, press OK.

Parent topic: Viewing and Printing Photos
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Photo Adjustment Options - Memory Card

Select the Photo Adjustment options you want to use when viewing and printing photos displayed on
the LCD screen. The modifications affect only the printed copy of the photo, not the original file.

Photo Adjustment |Available options Description
settings
Fix Photo Fix Photo On Automatically adjusts the brightness, contrast, and

saturation of the photo based on the Scene
Detection setting that is selected.

Fix Photo Off Turns off automatic adjustments; see Note below
P.I.M. Uses your camera's PRINT Image Matching or Exif
Print adjustments

Scene Detection Automatic Optimizes the Fix Photo adjustments for specific

People types of photos; select the option that best matches
P your photo content

Landscape
Night Scene

Fix Red-Eye Off - Current Automatically fixes the red-eye effect in photos

On - Current
Off - All Photos

On - All Photos
Brightness Various settings Adjust individual qualities in your photo
Contrast
Sharpness
Saturation

Note: Fix Photo uses a sophisticated face recognition technology to optimize photos that include faces.
For this to work, both eyes and the nose must be visible in the subject's face. If your photo includes a
face with an intentional color cast, such as a statue, you may want to turn off Fix Photo to retain the
special color effects.

Parent topic: Viewing and Printing Photos
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Print Setting Options - Memory Card

Select the Print Settings options you want to use when printing photos displayed on the LCD screen.

types

Print settings Available Description
options
Paper Size Various paper Indicates the size of paper you have loaded
sizes
Paper Type Various paper Indicates the type of paper you have loaded; see the list of

paper types for copying (available options depend on the
selected Paper Size setting)

Paper Source

Cassette 1 Prints onto paper loaded in Cassette 1 (upper cassette)
Cassette 2 Prints onto paper loaded in Cassette 2 (lower cassette)
Cassette Prints onto paper loaded in Cassette 1 and then onto paper

1>Cassette 2

loaded in Cassette 2 when the first cassette is empty (load
the same size and type of paper in both cassettes when
selecting this option)

formats

Rear Paper Prints onto paper loaded in the rear paper feed slot
Feed Slot
Borderless Borderless Expands the image to the edge of the paper (slight cropping
may occur)
With Border Leaves a small margin around the image
Quality Draft Provides lower quality for draft printing
Standard Provides good quality for most prints
Best Provides the highest quality for important prints
Expansion Standard Expands images correctly for most borderless prints
Medium Expands images slightly less for borderless prints
Minimum Expands images the least for borderless prints (you may see
some white border)
Date Various date Prints the date the photo was taken on the photo in the

format you select

213




Print settings Available Description
options
Print Info. On Camera Prints settings that you added in your camera
Photos Settings
Camera Text Prints text that you added in your camera
Landmark Prints location information embedded in a photo by cameras
that have a built-in GPS feature
Fit Frame On Automatically crops the photo to fit into the selected photo
layout
Off Turns off automatic cropping
Bidirectional On Prints at normal speed
Off Slows down printing to improve print quality
Clear All Settings Yes Clears all print settings.
No

Parent topic: Viewing and Printing Photos

Paper Type Settings - Memory Card

Select a Paper Type setting that matches the paper you loaded.

Paper type loaded

Paper Type setting

Plain paper

Epson Bright White Paper
Epson Presentation Paper Matte
Epson Iron-on Cool Peel Transfer paper
Epson Photo Quality Self-adhesive Sheets

Plain Paper

Epson Ultra Premium Presentation Paper Matte
Epson Premium Presentation Paper Matte Double-sided

Epson Premium Presentation Paper Matte Matte
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Paper type loaded

Paper Type setting

Epson Premium Photo Paper Glossy
Epson Premium Photo Paper Semi-gloss
Epson Ultra Premium Photo Paper Luster

Prem. Glossy

Epson Ultra Premium Photo Paper Glossy

Ultra Glossy

Epson Photo Paper Glossy

Glossy

Epson Velvet Fine Art Paper

Velvet Fine Art Paper

Parent topic: Viewing and Printing Photos

Printing Photo Layouts from a Memory Card

You can print one or more photos from a memory card in special layouts on various sizes of photo paper.

1. Load photo paper in your product.
2. Press the  home button, if necessary.
3. Select More Functions.

More Functions

B4 Copy/Restore Photos

E® Photo Layout Sheet

."v Greeting Card
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4.

9.

10.
11.

Select Photo Layout Sheet.

Print Layout

Picture Package

F=Up

4=yup

Scroll down to view all of the layout options, then select the option you want.
Select the paper size and paper type that matches the paper you loaded, then select Proceed.

If you see a screen asking you to choose between automatic and manual placement of photos, do
one of the following:

« Select Automatic layout if you want to allow your product to place the photos in the layout
automatically.

e Select Place photos manually to place photos in the layout manually.

Select the photos you want to print, then select Proceed. If you chose to place the photos manually,
follow the instructions on the LCD screen to select and place your photos on the layout, then select
Proceed.

Press + or — to select the number of layout sheets to print (up to 99), then select Proceed.
Select additional print settings for your layout as necessary.
When you are ready to print, press the ¢ start button.

Note: To cancel printing, select Cancel.

Photo Layout Options

Parent topic: Printing from a Memory Card
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Photo Layout Options

Select the layout you want to use when printing your photos in a layout.

Picture Package
Prints one photo in multiple sizes on one sheet.

2-up, 4-up, 8-up, or 20-up
Print 2, 4, 8, or 20 photos on one sheet.

Upper Y2 or Lower %2
Print one photo in the upper or lower half of the sheet.

Photo ID
Prints 4 ID-sized photos on one sheet.

Jewel Upper
Prints one photo on the upper half of a folded jewel case insert.

Jewel Index
Prints 24 to 48 thumbnail images on a folded jewel case insert.

Parent topic: Printing Photo Layouts from a Memory Card

Printing Photo Greeting Cards

You can create custom greeting cards using photos on your memory card or other device, and add your
own handwritten or printed text.

First you select your photo and print a template on plain paper. Then you fill out the template, add your
message, and print your cards.

Creating and Printing a Greeting Card Template
Printing a Greeting Card from a Template

Parent topic: Printing from a Memory Card

Creating and Printing a Greeting Card Template
Before you start, make sure plain paper is loaded and your memory card is inserted.
1. Pressthe & home button, if necessary.
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2. Select More Functions.

More Functions

B4 Copy/Restore Photos

W Photo Layout Sheet

.‘-’. Greeting Card

N

3. Select Greeting Card.

Greeting Card
Select Photo and Print Template

Print Greeting Cards
from Template

Select Select Photo and Print Template.
Select the photo you want, then select Proceed.

6. Select Paper Size, then select Letter to print three cards on one letter-size sheet or 4x6in to print
one card.

Select Paper Type, then select the type of paper you plan to use.
Select the other print settings as necessary, then select Proceed.
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9. When you are ready to print your greeting card template on plain paper, press the < start button.
Parent topic: Printing Photo Greeting Cards

Related tasks
Inserting a Memory Card

Related topics
Loading Paper

Printing a Greeting Card from a Template
After your greeting card template is printed, you fill it out to create your card and add your message.
1. Use adark pen or pencil to fill in the circles and select the Text Style and Text Effects.

2. Add your greeting card message within the box. You can write it in by hand, print a message and
paste it into the box, or draw a picture.

Tip: When adding text, place it in the direction that your photo faces.

3. Load photo paper either in Cassette 2 (lower) for this size: Letter (8.5 x 11 inches [216 x 279 mm]),
or in Cassette 1 (upper) for this size: 4 x 6 inches (102 x 152 mm).

4. Select Print Greeting Cards from Template. (If you don't see the option, press the & home button
and select More Functions > Greeting Card > Print Greeting Cards from Template.)

5. Follow the instructions on the LCD screen to place the template facedown on the scanner glass, with
the blue triangle facing into the front right corner.

Close the document cover, then select Proceed.
7. To print more than one copy, press + or — to select the number (up to 99).
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8. When you are ready to print, press the ¢ start button.
Note: To cancel printing, select Cancel.

When you finish printing, cut your greeting cards apart, if necessary.
Parent topic: Printing Photo Greeting Cards

Related tasks
Creating and Printing a Greeting Card Template

Transferring Photos on a Memory Card
You can transfer photos to and from a memory card inserted into a memory card slot on your product.

Setting Up File Sharing for Photo Transfers From Your Computer
Transferring Photos from a Memory Card to Your Computer

Parent topic: Using Memory Cards With Your Product

Setting Up File Sharing for Photo Transfers From Your Computer

Before you transfer photos from a computer to a memory card inserted into a memory card slot on your
product, you may need to set up your product's file sharing settings.

Caution: Remove the memory card before you change this setting or you may lose data from the
memory card. Do not remove a memory card or turn off your product while the memory card access light
is flashing or you may lose data from the memory card.

Remove any memory cards from the product.

Press the # home button, if necessary.

Press the left or right arrow button and then select Setup.
Scroll down and select File Sharing Setup.

o wbnh e

Select the connection type between the printer and your computer.
Parent topic: Transferring Photos on a Memory Card

Related tasks
Removing a Memory Card
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Transferring Photos from a Memory Card to Your Computer

You can transfer photos to and from a memory card inserted into a memory card slot on your product
and a computer connected to your product.

Note: Do not transfer photos to and from a memory card while you are printing from the memory card.

Make sure your product is connected to a computer.

Insert a memory card into a memory card slot on your product.

Do one of the following to access your memory card files from your computer:

* Windows: Select the Computer or My Computer utility, then select the removable disk icon.

* Mac OS X with a USB connection: Look for the removable disk icon on your desktop, then select
It.

 Mac OS X with a network connection: Select the hard drive icon on your desktop or select

Computer from the Go menu, select your product in the SHARED section of the sidebar (you may
need to widen the sidebar to see the name), then select the MEMORYCARD icon.

4. Select the folder that contains your photos.
5. Drag the photos you want to transfer to the desired folder on your computer or on your memory card.

Note: Your product's LCD screen does not update to display new photos transferred to the memory
card. Wait until the memory card access light stops flashing, then remove and insert the memory card to
update the photos displayed.

Parent topic: Transferring Photos on a Memory Card

Related tasks
Inserting a Memory Card
Removing a Memory Card
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Using an External Device with Your Product

Follow the instructions in these sections to use your product with an external device, such as a camera,
smartphone, or other device.

Printing from a Camera
Viewing or Printing from a USB Flash Drive or External Device

Printing from a Camera

If you have a digital camera that supports PictBridge printing, you can print your photos directly from the
camera. Check your camera manual to see if it is compatible.

Note: Your photos must be in JPG format and sized from 80 x 80 to 10200 x 10200 pixels. Epson
cannot guarantee the compatibility of your camera. Some combinations of paper type, size, and layout
may not be supported, depending on your camera and the product settings.

Selecting Print and Photo Adjustment Settings
Connecting and Printing from a Camera
Printing from a Camera Wirelessly

Parent topic: Using an External Device with Your Product

Selecting Print and Photo Adjustment Settings

Before printing from your camera, you can make image adjustments and select the print settings for your
photos. Image adjustments affect only the printed copy of the photo, not the original file.

1. Pressthe & home button, if necessary.
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2. Press the left or right arrow button and select Setup.

setup

(ﬁ Ink Levels

==§ Maintenance

Printer Setup

3. Scroll down and select External Device Setup.

External Device Setup

‘ Print Settings

' Photo Adjustments
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4. Select Print Settings.

Print Settings

Paper Size

Paper Type

Paper Source

Layout

5. Select the print settings you want to use.
6. When you are done, press the 3 back button.
7. Select Photo Adjustments.

~ Photo Adjustments
Fix Photo
Fix Photo O

Scene Detection
Automatic

F Red-tye

OFf
Filter

8. Select the photo adjustments you want to use, then press the & home button to exit.

After you select settings, you are ready to connect your camera and print your photos.
Print Settings - Camera
Photo Adjustments - Camera
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Parent topic: Printing from a Camera

Print Settings - Camera

Select the Print Settings options you want to use when printing photos from your camera.

Print settings

Available options

Description

Paper Size

Various paper sizes

Indicates the size of paper you have loaded

Paper Type

Various paper types

Indicates the type of paper you have loaded; see
the list of paper types for copying (available
options depend on the selected Paper Size
setting)

Paper Source

Cassette 1 Prints onto paper loaded in Cassette 1 (upper
cassette)
Cassette 2 Prints onto paper loaded in Cassette 2 (lower

cassette)

Cassette 1> Cassette 2

Prints onto paper loaded in Cassette 1 and then
onto paper loaded in Cassette 2 when the first
cassette is empty (load the same size and type of
paper in both cassettes when selecting this
option)

Rear Paper Feed Slot

Prints onto paper loaded in the rear paper feed
slot

Layout Borderless Expands the image to the edge of the paper (slight
cropping may occur)
With Border Leaves a small margin around the image
2-up, 4-up, 8-up, or 20-up Print the selected number of photos on one sheet
Upper % or Lower ¥ Print one photo in the upper or lower half of the
sheet
Quality Draft Provides lower quality for draft printing
Standard Quality Provides good quality for most prints
Best Provides the highest quality for important prints
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Print settings

Available options

Description

Expansion Standard Expands images correctly for most borderless
prints
Medium Expands images slightly less for borderless prints
Minimum Expands images the least for borderless prints
(you may see some white border)
Date Off Does not print the date on which the photo was
taken
On Prints the date on which the photo was taken

Print Info. on

Camera Settings

Prints your camera's shutter speed, aperture, and

Photos ISO speed
Camera Text Prints text that you added in your camera
Landmark Prints location information embedded in a photo
by cameras that have a built-in GPS feature
Fit Frame On Automatically crops the photo to fit into the
selected photo layout
Off Turns off automatic cropping
Bidirectional On Prints at normal speed
Off Slows down printing to improve print quality

CD Inner/QOuter

Range of measurements

Selects inner and outer diameter for printing on
CDs/DVDs from your camera

CD Density

Standard Density

Darker

Darkest

Adjusts the print density when printing on
CDs/DVDs from your camera

Parent topic: Selecting Print and Photo Adjustment Settings

Photo Adjustments - Camera

Select the Photo Adjustments options you want to use when printing photos from your camera. The
modifications affect only the printed copy of the photo, not the original file.
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Photo Available options Description

Adjustments

settings

Fix Photo Fix Photo On Automatically adjusts the brightness, contrast, and

saturation of the photo based on the Scene Detection
setting that is selected

Fix Photo Off

Turns off automatic adjustments; see Note below

P.I.M

Uses your camera's PRINT Image Matching or Exif Print
adjustments

Scene Detection [Automatic Optimizes the Fix Photo adjustments for specific types of
P photos; select the option that best matches your photo
eople
content
Landscape
Night Scene
Fix Red-Eye Off Does not automatically fix the red-eye effect in photos
On Automatically fixes the red-eye effect in photos
Filter Off Turns off the filter setting
Sepia Applies a sepia tone filter to the viewed or printed photo
B&W Applies a black-and-white filter to the viewed or printed
photo
Brightness Various settings Adjust individual qualities in your photo
Contrast
Sharpness
Saturation

Note: Fix Photo uses a sophisticated face recognition technology to optimize photos that include faces.

For this to work, both eyes and the nose must be visible in the subject's face. If your photo includes a
face with an intentional color cast, such as a statue, you may want to turn off Fix Photo to retain the
special color effects.

Parent topic: Selecting Print and Photo Adjustment Settings
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Connecting and Printing from a Camera
Before you connect your camera, make sure the product is turned on but not printing.
1. Remove any memory cards from the product.
2. Load the paper you want to use for printing.
3. Connect the USB cable that came with your camera to the #¢ USB port on the front of your product.

Note: You cannot use the USB port to transfer images from your camera to your computer.

4. Turn onyour camera.

5. Follow the instructions that came with your camera to select and print your photos.
When you finish printing, turn off your camera and disconnect it from the product.
Parent topic: Printing from a Camera

Related tasks
Removing a Memory Card

Related topics
Loading Paper

Printing from a Camera Wirelessly

You can print photos from a digital camera using a wireless connection. Make sure your digital camera
can connect to a network and is PictBridge compatible (DPS over IP).

1. Remove any memory cards from the product.
2. Load the paper you want to use for printing.
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3. Turn on your camera.

Setup the camera's wireless network connection. See the documentation that came with your
camera for details.

Note: Make sure the camera is connected to the same network as the product. You can print a
Network Status sheet to view your product's network settings.

5. Follow the instructions that came with your camera to select and print your photos.
When you finish printing, turn off your camera and disconnect it from the network.
Parent topic: Printing from a Camera

Viewing or Printing from a USB Flash Drive or External Device

You can view and print photos from a USB thumb drive or other external storage device, such as an
external hard drive or CD/DVD burner.

Note: Make sure the files on your device are compatible with the product.

USB Device File Specifications
Connecting and Using a USB Flash Drive or External Device

Parent topic: Using an External Device with Your Product

Related tasks
Removing a Memory Card

Related topics
Loading Paper
Viewing and Printing Photos
USB Device File Specifications
You can print external device files that meet these specifications.

File format JPEG with the Exif version 2.3 standard
Image size 80 x 80 pixels to 10200 x 10200 pixels
Number of files Up to 9990

Parent topic: Viewing or Printing from a USB Flash Drive or External Device
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Connecting and Using a USB Flash Drive or External Device
Before you connect your thumb drive or device, make sure the product is turned on but not printing.

Note: Epson cannot guarantee the compatibility of your drive.

Remove any memory cards from the product.
Load the paper you want to use for printing.

Insert your USB thumb drive or the USB cable that came with your device into the A USB port on the
front of your product.

4. Insert storage media (such as a CD) into your drive, if necessary.
5. Select the photos to print from the LCD screen.

When you finish printing, make sure the access light on the drive is not flashing, then remove or
disconnect it from the product.

Caution: Do not remove the USB drive or turn off the product when the access light is flashing, or you
may lose photos on the drive.

Parent topic: Viewing or Printing from a USB Flash Drive or External Device
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Printing Personalized Projects

You can turn any photo or drawing into a coloring book page, or print lined paper, graph paper, or
stationery with a photo background.

Printing Coloring Book Pages

Printing Personalized Note Paper

Printing Lined Paper, Graph Paper, and Music Sheets
Printing Calendar Pages

Printing Coloring Book Pages

You can create a coloring book page from a photo on your memory card, or from a photo or drawing
placed on the scanner glass.

1. Load one of these types of paper in either Letter (8.5 x 11 inches [216 x 279 mm]) or A4 (8.3 x 11.7
inches [210 x 297 mm]) size:

 Plain paper

» Epson Bright White Paper

» Epson Presentation Paper Matte

» Epson Premium Presentation Paper Matte

» Epson Velvet Fine Art Paper (letter-size only)
2. Press the w home button, if necessary.
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3. Select More Functions.

More Functions

B4 Copy/Restore Photos

W Photo Layout Sheet

.‘-’. Greeting Card

N

4. Scroll down and select Coloring Book.

Coloring Book
. ]
Phota ar Draming
on scanner Glass

Photo on Memory Card

5. Do one of the following:

» Select Photo or Drawing on Scanner Glass to print a design from an original placed facedown
on the scanner glass, in the front right corner.

« Select Photo on Memory Card to print a design from a memory card inserted in your product,
then select a photo.

6. SelectProceed.
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7. Select Paper Settings and select the size and type of paper that you loaded.
8. Select Paper Source and select where you loaded your paper.
9. If necessary, adjust the following settings:
« Density to make the print lighter or darker
e Line Detection to change the amount of detail in the print
10. When you are ready to print, press the & start button.

Note: To cancel printing, select Cancel.

Parent topic: Printing Personalized Projects

Related tasks
Inserting a Memory Card

Related topics
Loading Paper
Placing Originals on the Product

Printing Personalized Note Paper
You can print lined or unlined note paper with one of your own photos in the background.

1. Load plain paper in either Letter (8.5 x 11 inches [216 x 279 mm]) or A4 (8.3 x 11.7 inches
[210 x 297 mm)]) size.

2. Insert a memory card into your product's memory card slot.
Press the a home button, if necessary.
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4. Select More Functions.

More Functions

B4 Copy/Restore Photos

W Photo Layout Sheet

.‘-’. Greeting Card
—-w

5. Scroll down and select Personal Stationery.
Personal Stationery

Lined Papers

Briting Papers

Calendar
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6. Select Writing Papers.

Writing Papers

Horizontal Rule

Vertical Rule

Nithout Rule

7. Select one of the following settings:
* Horizontal Rule
« Vertical Rule
* Without Rule

Note: View the thumbnails next to each option to preview the design layout.

8. Select the size of paper you loaded.
9. Select the photo you want to use for your note paper, then select Proceed.

Note: To rotate the layout, select Rotate.

10. When you see a message asking you to load paper, select Proceed.
11. To print more than one sheet, press + or — to select the number (up to 99).
12. When you are ready to print, press the & start button.

Note: To cancel printing, select Cancel.

Parent topic: Printing Personalized Projects
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Related tasks
Inserting a Memory Card

Related topics
Loading Paper

Printing Lined Paper, Graph Paper, and Music Sheets
You can print music sheets and wide-rule or narrow-rule notebook paper and graph paper.

1. Load plain paper in either Letter (8.5 x 11 inches [216 x 279 mm]) or A4 (8.3 x 11.7 inches
[210 x 297 mm)]) size.

2. Press the  home button, if necessary.
3. Select More Functions.

More Functions

B4 Copy/Restore Photos

E® Photo Layout Sheet

."v Greeting Card
ﬁ"
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4. Scroll down and select Personal Stationery.

Personal Stationery

Lined Papers

Writing Papers

Calendar

5. Select Lined Papers.
Lined Papers

Wide Rule

Thin Rule

Graph Rule

6. Select one of the following settings:
* Wide Rule
e Thin Rule
» Graph Rule
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* Music Paper
Note: View the thumbnails next to each option to preview the design layout.

7. Select the size of paper you loaded.

When you see a message asking you to load paper, select Proceed.
9. To print more than one sheet, press + or — to select the number (up to 99).
10. When you are ready to print, press the © start button.

Note: To cancel printing, select Cancel.

Parent topic: Printing Personalized Projects

Related tasks
Inserting a Memory Card

Related topics
Loading Paper

Printing Calendar Pages
You can create and print a weekly or monthly calendar page from your product.

1. Load plain paper in either Letter (8.5 x 11 inches [216 x 279 mm]) or A4 (8.3 x 11.7 inches
[210 x 297 mm]) size.

2. Press the 4 home button, if necessary.
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3. Select More Functions.

More Functions

B4 Copy/Restore Photos

W Photo Layout Sheet

.‘-’. Greeting Card
—-w

4. Scroll down and select Personal Stationery.
Personal Stationery

Lined Papers

Briting Papers

Calendar

5. Select Calendar.

6. Select one of the following settings:
« Weekly: prints a Sunday to Saturday week-long calendar with hourly divisions.
* Monthly: prints a monthly calendar for a chosen month and year.

Note: View the thumbnails next to each option to preview the design layout.
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7. If you chose Monthly, enter the year and month and select Done.
Select the type of paper to print on.
9. When you see a message asking you to load paper, select Proceed.
10. To print more than one sheet, press + or — to select the number (up to 99).
11. When you are ready to print, press the ¢ start button.

Note: To cancel printing, select Cancel.

Parent topic: Printing Personalized Projects

Related tasks
Inserting a Memory Card

Related topics
Loading Paper
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Printing on CDs/DVDs

Follow the instructions here to print a design onto ink jet-printable CDs or DVDs to create a custom label.
CD/DVD Printing Features

Loading a CD/DVD

Removing a Printed CD/DVD

Placing a CD/DVD on the Scanner Glass

Copying onto a CD/DVD

Printing Photos from a Memory Card Onto a CD/DVD

Printing a Jewel Case Insert from a Memory Card

Printing on CDs/DVDs from a Computer

CD/DVD Printing Features
You can use any of the following features to print custom CD/DVD labels and accessories:
» Copy an existing CD/DVD label onto a new CD/DVD
» Use your product's control panel to print photos from a memory card onto a CD/DVD
 Print text and images from your computer using the Epson Print CD software

You can also use your product's control panel to create a jewel case insert with photos from a memory
card.

Parent topic: Printing on CDs/DVDs

Related tasks

Copying onto a CD/DVD

Printing Photos from a Memory Card Onto a CD/DVD
Printing a Jewel Case Insert from a Memory Card

Loading a CD/DVD

You can print on any compatible, ink jet-printable CDs or DVDs, including Blu-ray Discs.

Caution: Do not insert the CD/DVD tray while the product is printing, copying, or performing other
operations. Otherwise, your product may be damaged or the surface of the CD/DVD may become dirty
or scratched.
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Note: If you are using discs where the printable area extends to within 0.16 inch (4 mm) of the center
hole, you may need to adjust the inner diameter setting using the control panel or Epson Print CD
software.

1. Burn your files, music, or video onto your disc before printing on it.

2. Press the  home button, if necessary.

3. Pressthe & CD button and select Load CD/DVD.

4. When you see a message asking if you want to prepare for CD loading, select Yes.
5. Raise the control panel all the way up.

6.

7. Close the front cover.
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8. Remove the CD/DVD tray from the bottom of the product.

9. Place a CD or DVD on the CD/DVD tray with the printable side faceup, and insert the tray into the
slot above the output tray.

Note: Make sure the A marks on the tray and the ¥ marks on the product line up.
10. Select Ready > OK.
Note: The CD/DVD tray ejects automatically after a certain period of time.
Caution: Do not turn off the product with a CD or DVD loaded in it. Always remove the disc first.

Parent topic: Printing on CDs/DVDs

Removing a Printed CD/DVD

After your CD or DVD is printed, the tray extends automatically.
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1. Pullthe CD/DVD tray out of the product, and then remove your CD or DVD from the tray.

— -

i
\| \\

2. Insert the CD/DVD tray into the storage slot on the bottom of the product.

After printing, handle the CD or DVD carefully. You may need to wait up to 24 hours for the ink to dry fully
before inserting it in a drive, depending on the type of disc you used. Keep printed discs away from
moisture and direct sunlight.

Parent topic: Printing on CDs/DVDs

Placing a CD/DVD on the Scanner Glass

You can place a CD or DVD on the scanner glass and copy the label design onto another CD or DVD.
1. Open the document cover.
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2. Place your CD or DVD facedown in the center of the scanner glass.

3. Close the document cover gently to keep your disc in place.
Parent topic: Printing on CDs/DVDs

Copying onto a CD/DVD

You can copy a printed photo or CD/DVD label directly onto an ink jet-printable CD or DVD. If you want,
you can first print a test design on plain paper.

Load the CD, DVD, or plain paper you want to print on.
Press the # home button, if necessary.

Press the & CD button.

Select CD/DVD Copy.

Follow the instructions on the LCD screen to place your original CD, DVD, or photo on the scanner
glass, then select Proceed.

a M w DN

6. If necessary, adjust the inner and outer diameter of your CD as shown on the screen, then select
Proceed.

You see this screen:
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Print on a CD/DVD

Test print on Letter,/Ad paper

select either test printing
or printing on a CO/DVD.

7. Select one of the options shown on the screen to print on a CD/DVD or a test print on plain paper. If
printing on plain paper, select Proceed.

8. Select any copy settings as needed.

Copy to CD/DVD

% . I review

Ooe0
Color

9. When you are ready to print, press the ¢ start button.
Note: To cancel printing, select Cancel.

Parent topic: Printing on CDs/DVDs
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Related tasks
Loading a CD/DVD
Placing a CD/DVD on the Scanner Glass

Related topics
Loading Paper
Placing Originals on the Product

Printing Photos from a Memory Card Onto a CD/DVD

You can print one or more photos from a memory card directly onto a CD/DVD. If you want, you can first
print a test design on plain paper.

Insert a memory card into a memory card slot on your product.
Load the CD, DVD, or plain paper you want to print on.

Press the # home button, if necessary.

Press the @ CD button.

Select Print on CD/DVD.

S

Print Layout

En.-"l]'.’[] 1 =L ﬁ

CD/DOVD 4=up ﬁ

CDSDVD Variety '°'

Select a layout, then select Proceed.
Follow the instructions on the screen to select your photo or photos.

When you see the screen to adjust the inner and outer diameter of your CD, adjust the settings if
necessary, then select Proceed.
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You see this screen:

Print on a CD/DVD

Test print on Letter/Ad paper

Jelect either test printing
or printing on a CO/DVD.

9. Select one of the options shown on the screen to print on a CD/DVD or a test print on plain paper. If
printing on plain paper, select Proceed.

10. Adjust the CD Density setting if necessary, then press the ¢ start button to print.
Note: To cancel printing, select Cancel.

Parent topic: Printing on CDs/DVDs

Related tasks
Loading a CD/DVD
Inserting a Memory Card

Related topics
Loading Paper

Printing a Jewel Case Insert from a Memory Card

You can print a photo from a memory card, automatically sized to fit on a CD/DVD jewel case insert. You
can also print thumbnail images formatted to fit on a jewel case insert. After the insert is printed, you can
cut and fold it to fit.

1. Inserta memory card into a memory card slot on your product.
2. Load the paper you want to print on.
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3. Press the 4 home button, if necessary.
4. Select More Functions.

More Functions

B0 Copy/Restore Photos

W Photo Layout Sheet

E Greeting Card

5. Select Photo Layout Sheet.

Print Layout

Picture Package

F=Up

4=yup

6. Scroll down and then select one of the following:
« Jewel Upper to print one photo on the upper half of the insert.
» Jewel Index to print 24 or 48 thumbnail images on the insert.
7. Select your paper size and type, then select Proceed.
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8. Follow the instructions on the LCD display to select your photos and set the number of copies.
9. When you see the Print Settings screen, change your print settings if necessary.
10. When you are ready to print, press the & start button.

Note: To cancel printing, select Cancel.

11. After your insert is printed, cut and fold it following the crop lines.
Parent topic: Printing on CDs/DVDs

Related tasks
Inserting a Memory Card

Related topics
Loading Paper

Printing on CDs/DVDs from a Computer

Before printing directly on CDs or DVDs from your computer, make sure you have set up your product as
described on the Start Here sheet, and installed the Epson Print CD software.

Printing on a CD/DVD with Windows
Printing on a CD/DVD with Mac OS X

Parent topic: Printing on CDs/DVDs

Related tasks
Loading a CD/DVD

Printing on a CD/DVD with Windows
You can print with your product using the Epson Print CD software, as described in these sections.
Designing a CD/DVD - Windows
Printing Your CD/DVD Design - Windows
Adjusting CD/DVD Print Position - Windows
Adjusting CD/DVD Print Quality - Windows
Parent topic: Printing on CDs/DVDs from a Computer
Designing a CD/DVD - Windows

You can use Epson Print CD to design your disc by importing photos, adding text, and creating special
effects.
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1. Open the Epson Print CD program on your computer.
You see this screen:

e - =]

2. Use the buttons on the left side of the screen to select a pre-designed template or add a background
image, picture, text, or graphic elements. For more information, select the Help menu.

3. When you are finished creating your design, click Save and save your design file.
Parent topic: Printing on a CD/DVD with Windows
Printing Your CD/DVD Design - Windows

After you create your design, you can print it on paper to test it, then print it on the CD or DVD that
contains your data, photos, video, or music. Make sure the disc is loaded for printing before you start.

1. Openyour file in Epson Print CD and click Print.
You see this screen:

251



Printar Epsan hal
Copies 1
ledia Type CODVD v
Prind Color Comecion
Lighbe Diefault Darker W I Lt
3 -2 1 0 =1 +2 3

Prird Confirmation Patie nk P
Co ' Adjusk Prink Pogition
= Mong

Print Density Confirmation Pattern Traiy
(]
Manual Print
Print Position Confrmaton Pafiem
Tast Print
Print Cancl Help

2. Make sure your product is selected as the Printer setting.

3. To see how your design will look without printing on the disc, click Test Print and follow the
instructions on the screen.

4. When you are ready to print on the disc, click the Print button on the screen.
5. Click Print.
Parent topic: Printing on a CD/DVD with Windows

Adjusting CD/DVD Print Position - Windows

If your printed design is not positioned correctly on the disc, you can adjust the print position. First, load
an extra CD/DVD to use for printing test patterns.

1. Openyour file in Epson Print CD and click Print.
You see this screen:
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Color |

Tast Print

Select Print Position Confirmation Pattern.

Click Print.

Remove the disc after printing.

Using a metric ruler, measure the distance from the hole to the cross marks labeled Top and Right.

Note: Be sure to measure from the edge of the hole and not the edge of the printable area.

Click Print again, then select Adjust Print Position.
You see this screen:
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0 Qirmem

Enter values

Huiphi(Teg) - mm

R R . mm

Reset

7. Click Enter Values, then select the distance for Top into the Height (Top) box and the distance for
Right in the Width (Right) box.

8. Click OK.
Parent topic: Printing on a CD/DVD with Windows
Adjusting CD/DVD Print Quality - Windows

If ink smears on your disc or is sticky after it dries, you can adjust the color saturation and ink density.
This may be necessary to make sure your designs look their best on the particular brand of discs you are
using. First, load an extra CD/DVD to use for printing test patterns.

1. Open your file in Epson Print CD and click Print.
You see this screen:
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Select Print Density Confirmation Pattern.

Click Print.

Remove the disc after printing and check to see if you need to make the density darker or lighter.
Load the same disc in the product again.

Click Print.

Adjust the Print Color Correction slider to a darker or lighter setting as necessary.

Select Print Density Confirmation Pattern and select the Second radio button.

© © N MWD

Click Print to print another test pattern

10. Examine the disc after printing to see if further adjustment is needed.

When the ink density looks good, you are ready to print on your burned CD or DVD.
Parent topic: Printing on a CD/DVD with Windows

Printing on a CD/DVD with Mac OS X

You can print with your product using the Epson Print CD software, as described in these sections.
Designing a CD/DVD - Mac OS X
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Printing Your CD/DVD Design - Mac OS X
Adjusting CD/DVD Print Position - Mac OS X
Adjusting CD/DVD Print Quality - Mac OS X

Parent topic: Printing on CDs/DVDs from a Computer

Designing a CD/DVD - Mac OS X
You can use Epson Print CD to design your disc by importing photos, adding text, and creating special

effects.
1. Openthe Epson Print CD program in the Applications > Epson Software > Print CD folder on your
Mac.

You see this screen:

B8.0.0 Untitlad

2. Use theicons on the left side of the screen to add a background image, picture, text, or graphic
elements.

3. When you are finished creating your design, make sure you save it.
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Parent topic: Printing on a CD/DVD with Mac OS X

Printing Your CD/DVD Design - Mac OS X

After you create your design, you can print it on paper to test it, then print it on the CD or DVD that
contains your data, photos, video, or music. Make sure the disc is loaded for printing before you start.

1. Openyour file in Epson Print CD and select Print from the File menu.

You see this screen:

Print
Select Prinver Marnual Print
Printer: EPSON Test Pring
Copies: |1
Media Type:| CD/DVD

Cobar Correction Adjust Print Pasiticn

Light Standard strang | Herizontal LHY foC
':T) Wertical 0.0 mm
-3 =2 =1 0 +1 +2 +3 Pasition Adjustment

Frina Check Pattern

(%) None
Print Density Check Pattern Tray

Fosition |_T.:-._- Time
Print Position Check Pattern [}

Cancel Print

2. Make sure your product is selected as the Printer setting.

To see how your design will look without printing on the disc, select Test Print and follow the
instructions on the screen.

4. When you are ready to print on the disc, click the Print button on the screen.
Parent topic: Printing on a CD/DVD with Mac OS X
Adjusting CD/DVD Print Position - Mac OS X

If your printed design is not positioned correctly on the disc, you can adjust the print position. First, load
an extra CD/DVD to use for printing test patterns.

1. Open your file in Epson Print CD and select Print from the File menu.
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You see this screen:

Print
Select Printer Manual Print

Printer: EPSOM Test Pring

Coples:[1

Media Type:| CD/DVD

4

Colar Correttion Adjust Print Pasition
Light Standard Strang Horizontal 00 mm
= Vertical 0.0 mm

=3 =2 =1 0 +1 +I +3 Pasition Adjustment

Fring Check Pattern

None
Print Density Check Pattern Tray
Fasitian |_T|_'_'-|_|__} Second Time

(#) Print Pasition Check Pattern [ ]

Cancel Print

Select Print Position Check Pattern.

Click Print.

Remove the disc after printing.

Using a metric ruler, measure the distance from the hole to the cross marks labeled Top and Right.

Note: Be sure to measure from the edge of the hole and not the edge of the printable area.

Select Print from the File menu.
Select Position Adjustment.
You see this screen:
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Adjust Print Position

oK |

Cancel

0.0 mm

Walue Entry
Tap Space

“ mm

Right Space
5.0 || mem

Rese

0.0 mm

8. Click Value Entry, then select the distance for Top into the Top Space box and the distance for
Right in the Right Space box.

9. Click OK.
Parent topic: Printing on a CD/DVD with Mac OS X
Adjusting CD/DVD Print Quality - Mac OS X

If ink smears on your disc or is sticky after it dries, you can adjust the color saturation and ink density.
This may be necessary to make sure your designs look their best on the particular brand of discs you are
using. First, load an extra CD/DVD to use for printing test patterns.

1. Open your file in Epson Print CD and select Print from the File menu.
You see this screen:
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Print

Select Printer Manual Print
Printer: EPSON
Coples:[1 l

Test Pring

Media Type:| CD/DVD

Colar Correttion Adjust Print Pasition
Light Standard Strang Horizontal 00 mm
= Vertical 0.0 mm

=3 =2 =1 0 +1 +I +3 Pasition Adjustment

Fring Check Pattern

None
(*] Print Density Check Patterm Tray
Pasition !_'F'I-Eiﬁ‘ﬁ:ﬁ:_} Second Time Third Time

Print Position Check Pattern | ]

Cancel Print

Select Print Density Check Pattern.

Click Print.

Remove the disc after printing and check to see if you need to make the density darker or lighter.
Load the same disc in the product again.

Select Print from the File menu.

Select a darker or lighter setting in the Color Correction box as necessary.

Select Print Density Check Pattern and select Second Time.
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Click Print to print another test pattern.

10. Examine the disc after printing to see if further adjustment is needed.

When the ink density looks good, you are ready to print on your burned CD or DVD.
Parent topic: Printing on a CD/DVD with Mac OS X
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Replacing Ink Cartridges

When an ink cartridge is expended, you need to replace it.

You may also need to replace a cartridge that is more than six months old, if your printouts do not look
their best, even after cleaning and aligning the print head.

Note: Please dispose of your used Epson branded ink cartridges responsibly and in accordance with
local requirements. If you would like to return your used ink cartridges to Epson for proper disposal,
please go to epson.com/recycle for more information.

Check Cartridge Status

Purchase Epson Ink Cartridges

Removing and Installing Ink Cartridges

Printing With Black Ink and Expended Color Cartridges
Conserving Low Black Ink with Windows

Check Cartridge Status

Your product and its printing software will let you know when an ink cartridge is low or expended.

Checking Cartridge Status on the LCD Screen
Checking Cartridge Status with Windows
Checking Cartridge Status with Mac OS X

Parent topic: Replacing Ink Cartridges

Checking Cartridge Status on the LCD Screen

You can check the status of your ink cartridges using your product's LCD screen.
1. Pressthe & home button, if necessary.
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2. Press the left or right arrow button and then select Setup.

setup

fil Ink Levels

==§ Maintenance

Printer Setup

3. SelectInk Levels.
The ink cartridge status is displayed.

Note: Displayed ink levels are approximate.

4. Select OK to exit.
Parent topic: Check Cartridge Status

Related tasks
Removing and Installing Ink Cartridges

Checking Cartridge Status with Windows

A low ink reminder appears if you try to print when ink is low, and you can check your cartridge status at
any time using a utility on your Windows computer.

1. To check your cartridge status, double-click the product icon in the Windows taskbar.
You see this window:
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It iz ready 1o prnt.

Replace or reinstall any ink cartridge indicated on the screen.

Note: If any of the cartridges installed in the product are broken, incompatible with the product
model, or improperly installed, Epson Status Monitor will not display an accurate cartridge status.

To disable the low ink reminder, right-click the product icon in the Windows taskbar and select
Monitoring Preferences.

You see this window:
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[¥| Register the shortcut icon to the taskbar

Dauble-cidking the Shortout Ioon
opens the Printer Status Window,

[] Allow monitoring of shared printers
[/] See Low Ink Reminder alerts
[] Display Epson Offers

[ ] Share my usage information with Epson

T ok 1 Cancel

4. Deselect the See Low Ink Reminder alerts checkbox at the bottom of the screen.
5. Todisable promotional offers, deselect the Display Epson Offers checkbox.
Parent topic: Check Cartridge Status

Related tasks
Removing and Installing Ink Cartridges

Checking Cartridge Status with Mac OS X

You can check your cartridge status using a utility on your Mac.
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1. Do one of the following:

* Mac OS X 10.6/10.7/10.8: In the Apple menu or the Dock, select System Preferences. Select
Print & Fax or Print & Scan, select your product, and select Options & Supplies. Select Utility
and select Open Printer Utility.

« Mac OS X 10.5: In the Apple menu or the Dock, select System Preferences. Select Print & Fax,
select your product, and select Open Print Queue. Select Utility.

2. Select EPSON Status Monitor.
You see this window:

an Epson Printer Utility 4

Buy Epson Ink

EPSON

iﬂ EPSOM Status Monitor

Ink Levels

Ay

Maigeis LT

Information

Update j OK

3. Do the following as necessary:
» To update the ink cartridge status, click Update.
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« Replace or reinstall any ink cartridge indicated on the screen.

Note: If any of the cartridges installed in the product is broken, incompatible with the product model,
or improperly installed, Epson Status Monitor will not display an accurate cartridge status.

Parent topic: Check Cartridge Status

Related tasks
Removing and Installing Ink Cartridges

Purchase Epson Ink Cartridges

You can purchase genuine Epson ink and paper at Epson Supplies Central at epson.com/ink3 (U.S.
sales) or epson.ca (Canadian sales). You can also purchase supplies from an Epson authorized reseller.
To find the nearest one, call 800-GO-EPSON (800-463-7766).

Note: We recommend that you use genuine Epson cartridges and do not refill them. The use of other
products may affect your print quality and could result in printer damage.

The cartridges included with the printer are designed for printer setup and not for resale. After some ink
is used for priming, the rest is available for printing. Yields vary considerably based on images printed,
print settings, paper type, frequency of use, and temperature. For print quality, a variable amount of ink
remains in the cartridge after the "replace cartridge" indicator comes on.

Ink Cartridge Part Numbers
Parent topic: Replacing Ink Cartridges

Ink Cartridge Part Numbers
Use these part numbers when you order or purchase new ink cartridges.

Note: For best printing results, use up a cartridge within 6 months of opening the package.

Ink color Part number
Standard-capacity High-capacity
Photo Black (PBK) 273 273XL
Black (BK) 273 273XL
Cyan 273 273XL
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Ink color Part number

Standard-capacity High-capacity
Magenta 273 273XL
Yellow 273 273XL

Parent topic: Purchase Epson Ink Cartridges

Removing and Installing Ink Cartridges

Make sure you have your replacement cartridges handy before you begin. You must install new
cartridges immediately after removing the old ones.

Caution: Leave your old cartridges in the printer until you are ready to replace them to prevent the print
head nozzles from drying out. Do not open ink cartridge packages until you are ready to install the ink.
Cartridges are vacuum packed to maintain reliability.

1. Make sure that the CD/DVD tray is not inserted for printing.
2. Turn on your product.

« Ifanink cartridge is expended, you see a message on the LCD screen. Note which cartridges
need to be replaced and select Proceed, then choose Yes, replace now.

« If you are replacing a cartridge before you see a message on the LCD screen, select Setup >
Maintenance > Ink Cartridge Replacement.

3. Lift up the scanner unit.

Caution: Do not move the print head by hand; otherwise, you may damage your product. Do not
touch the flat white cable inside the printer.
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4. Push in the blue tab to unlock the ink cartridge you are replacing. Then lift the bottom of the ink
cartridge to remove it.

Warning: If ink gets on your skin, wash it thoroughly with soap and water. If ink gets into your eyes,
flush them immediately with water. If ink gets into your mouth, spit it out and see a doctor right away.
Keep ink cartridges out of the reach of children.

5. Recap the used ink cartridge using the cap that came with it.

Note: Dispose of used cartridges carefully. Do not take the used cartridge apart or try to refill it.

6. If you are replacing the Black (BK) ink cartridge, it is recommended that you shake the new cartridge
gently four or five times before unwrapping it. You do not need to shake the Photo Black (PBK)
cartridge or any of the other color ink cartridges.
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Caution: Do not shake the cartridges after opening the packages, or ink may leak.

Remove the cartridge from the package.

Caution: Do not touch the areas shown above. Doing so may prevent normal operation and printing.

Remove the cap from the cartridge and store it in the bag that came with your product for later use.

Note: Save the cap so you can recap ink cartridges before storing or disposing of them.
Caution: Do not remove any other labels or seals, or ink will leak.

Insert the ink cartridge head first into the ink cartridge holder. Then press the bottom of the ink
cartridge down until it clicks into place.
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10. Once you replace all the cartridges that need replacing, close the scanner unit.

The product starts priming the ink. This takes a few minutes. When you see a completion message
on the LCD screen, ink replacement is complete.

Note: If you see an error screen telling you an ink cartridge is installed incorrectly, lift up the scanner
unit and press the ink cartridge down until it clicks into place. When you're finished, close the
scanner unit.

If you remove a low or expended ink cartridge, you cannot re-install and use the cartridge.

Caution: If you remove an ink cartridge for later use, recap the ink cartridge using the cap that came
with it to prevent the ink from drying out and to protect the surrounding area from getting smeared by ink.
Store the ink cartridge in the same environment as the product. Do not leave the product with the ink
cartridges removed for an extended period of time. Otherwise, ink remaining in the print head nozzles
may dry out and you may not be able to print.

Parent topic: Replacing Ink Cartridges

Related concepts
Purchase Epson Ink Cartridges

Printing With Black Ink and Expended Color Cartridges

When a color ink cartridge is expended, you can temporarily continue printing from your computer using
black ink. Replace the expended color cartridge as soon as possible for future printing.

Note: You cannot print with expended color ink cartridges using your product's control panel.

Printing With Expended Color Cartridges - Windows
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Printing With Expended Color Cartridges - Mac OS X
Parent topic: Replacing Ink Cartridges

Printing With Expended Color Cartridges - Windows

If you see a message during printing telling you that you can temporarily print in black ink with an
expended color cartridge, you can cancel your print job and select settings to print on plain paper or on
an envelope.

Note: To use this feature, Epson Status Monitor must be enabled.

1.

9.

© N o s~ wwDN

Click Cancel or Cancel Print to cancel your print job.

Note: If the message screen appears on another computer on a network, you may need to cancel
the print job using the product control panel.

Load plain paper or an envelope in your product.

Access the print settings in your print application.

Click the Main tab.

Select Plain Paper/Bright White Paper or Envelope as the paper type setting.
Select the Black/Grayscale checkbox.

Click OK.

Print your document.

Epson Status Monitor 3 displays a print message.

Click Print in Black to print your document.

Parent topic: Printing With Black Ink and Expended Color Cartridges

Printing With Expended Color Cartridges - Mac OS X

If printing stops, you can cancel your print job and select settings to temporarily print with only black ink
on plain paper or on an envelope.

1.

Click the printer icon in the Dock.
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2. If you see a message telling you that you can temporarily print with only black ink, click the Delete
icon to cancel your print job.

Mac OS X 10.8: Click the I:l button to cancel your print job. If an error message is displayed, click
the OK button.

Note: If the message screen appears on another computer on a network, you may need to cancel
the print job using the product control panel.

3. Inthe Apple menu or the Dock, select System Preferences.
Select Print & Fax or Print & Scan, select your product, and select Options & Supplies.

5. Select Driver.
You see this screen:

General r_—1 Supply Levels Liility

To take full advantage of your printer's optlons, confiem that they are accuraiely shown
here. For information on your printer and its cpteonal hardware, chec the printer’s
documentation.

Thick paper and ervelopes: | OF
Skip Blank Page:| OH

Chuiiet Made: | O

Permil temperary black printing: | Of
AUtGMatc Casserne Switching: | Of
High Speed Printing: | On

Warmning Notifications: | On

Establish bidirectional communication:| On

Cancel | Foobk |

Select On as the Permit temporary black printing setting.
Click OK.
Close the utility window.

© ©® N o

Load plain paper or an envelope in your product.
10. Access the print settings in your print application.
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11. Select Print Settings from the pop-up menu.

12. Select Plain Paper/Bright White Paper or Envelope as the paper type setting.
13. Select the Grayscale option.

14. Click Print to print your document.

Parent topic: Printing With Black Ink and Expended Color Cartridges

Conserving Low Black Ink with Windows
The following window appears when black ink runs low and there is more color ink.

[EPSON Status Meniter 3

Black ink Is lowr.

T keep prnvting unll you replace the cartridge, you can pent wing phots
black and other colors.

Do you want to do this for the current print job?

Yes |

Mo l

Digable this feature |

Note: The window appears only when you have selected Plain Paper/Bright White Paper as the paper
type setting, and depends on other selected print settings. To use this feature, Epson Status Monitor
must be enabled.

» Click Yes to use a mixture of color inks to create black, or No to continue using the remaining black ink
for the document you are printing.

» Click Disable this feature to continue using the remaining black ink.
Note: If you disable this feature, it remains disabled until you reinstall the black ink cartridge.

Parent topic: Replacing Ink Cartridges
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Adjusting Print Quality
If your print quality declines, you may need to run a utility to clean or align the print head.

If running these utilities does not solve the problem, you may need to replace the ink cartridges.

Print Head Maintenance
Print Head Alignment
Cleaning the Paper Path

Related topics
Replacing Ink Cartridges

Print Head Maintenance

If your printouts become too light, or you see dark or light bands across them, you may need to clean the
print head nozzles. Cleaning uses ink, so clean the nozzles only if print quality declines.

You can check for clogged nozzles before you clean them so you don’t clean them unnecessarily.

Note: You cannot clean the print head if an ink cartridge is expended, and may not be able to clean it
when a cartridge is low. You must replace the cartridge first.

Print Head Nozzle Check
Print Head Cleaning

Parent topic: Adjusting Print Quality
Related topics
Replacing Ink Cartridges

Print Head Nozzle Check

You can print a nozzle check pattern to check for clogged nozzles.

Checking the Nozzles Using the Product Control Panel
Checking the Nozzles Using a Computer Utility

Parent topic: Print Head Maintenance
Checking the Nozzles Using the Product Control Panel
You can check the print head nozzles using the control panel on your product.
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Make sure the CD/DVD tray is not inserted for printing.
Load a few sheets of plain paper in the product.

Press the & home button, if necessary.

Press the left or right arrow button and select Setup.

a s wbdh e

Select Maintenance.

Haintenance

Nozzle Check
Head Cleaning

Print Head Alignment

6. Select Nozzle Check.

Nozzle Check

Load Letter/A4 size Plain Paper
in the Casset '
to print nozzle check pattern.

Press ¢.

7. Press the ¢ start button.
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The nozzle check pattern is printed.
8. Check the printed pattern to see if there are gaps in the lines.

Print head is clean

9. Do one of the following:

* If there are no gaps, the print head is clean. Select Done.

« If there are gaps or the pattern is faint, select Clean the Print Head.
10. Follow the instructions on the screen to clean the print head.

If you don’t see any improvement after cleaning the print head up to 2 times, leave the product on and
wait at least 6 hours. Then try cleaning the print head again. If quality still does not improve, one of the
ink cartridges may be old or damaged and needs to be replaced.

Parent topic: Print Head Nozzle Check

Related tasks
Cleaning the Print Head Using the Product Control Panel
Loading Paper in Cassette 2 (Lower Cassette)

Related topics
Replacing Ink Cartridges

Checking the Nozzles Using a Computer Utility
You can check the print head nozzles using a utility on your Windows or Mac computer.
1. Make sure there are no errors on the LCD screen and the CD/DVD tray is not inserted for printing.
2. Load afew sheets of plain paper in the product.
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3. Do one of the following:
* Windows: Right-click the product icon in the Windows taskbar.

* Mac OS X 10.6/10.7/10.8: In the Apple menu or the Dock, select System Preferences. Select
Print & Fax or Print & Scan, select your product, and select Options & Supplies. Select Utility
and select Open Printer Utility.

* Mac OS X 10.5: In the Apple menu or the Dock, select System Preferences. Select Print & Fax,
select your product, and select Open Print Queue. Select Utility.

4. Select Nozzle Check.
You see a window like this:

@ Te perform a nozde check, make sure that the printer is en and

connected to the computer. Make sure that the CO/DVD tray is
removed and the output tray is ejected; otherwise "Nozzle Chedc”
cannot be performed. Also make sure that A4 or Letter size plain
paper is loaded in the cassette 2. Click [Print] to print & nozzle chedk
pattern or ik [Cancel] to quit.

5. Click Print.
6. Check the printed pattern to see if there are gaps in the lines.
Print head is clean
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7. Ifthere are no gaps, click Finish.
If there are gaps or the pattern is faint, clean the print head.
Parent topic: Print Head Nozzle Check

Related tasks
Cleaning the Print Head Using a Computer Utility
Loading Paper in Cassette 2 (Lower Cassette)

Related topics
Replacing Ink Cartridges

Print Head Cleaning

If print quality has declined and the nozzle check pattern indicates clogged nozzles, you can clean the
print head.

Note: You cannot clean the print head if an ink cartridge is expended, and may not be able to clean it
when a cartridge is low. You must replace the cartridge first.

Cleaning the Print Head Using the Product Control Panel
Cleaning the Print Head Using a Computer Utility

Parent topic: Print Head Maintenance

Related topics
Replacing Ink Cartridges
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Cleaning the Print Head Using the Product Control Panel

You can check the print head nozzles using the control panel on your product.

1.

a M w DN

6.

Make sure the CD/DVD tray is not inserted for printing.
Load a few sheets of plain paper in the product.

Press the  home button, if necessary.

Press the left or right arrow button and select Setup.
Select Maintenance.

Haintenance

Hozzle Check

Head Cleaning

Print Head Alignment

Select Head Cleaning.

o

Clean the print head
to correct missing dots.
Press 4.
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Press the ¢ start button to clean the print head. You see a message on the LCD screen during the
cleaning cycle.

Caution: Never turn off the product during a cleaning cycle or you may damage it.

When the cleaning cycle is finished, you see a message on the display screen.

Select Print Nozzle Check Pattern, then press the ¢ start button to run a nozzle check and confirm
that the print head is clean.

If you don’t see any improvement after cleaning the print head up to 2 times, leave the product on and
wait at least 6 hours. Then try cleaning the print head again. If quality still does not improve, one of the
ink cartridges may be old or damaged and needs to be replaced.

Parent topic: Print Head Cleaning

Related tasks
Checking the Nozzles Using the Product Control Panel
Loading Paper in Cassette 2 (Lower Cassette)

Related topics
Replacing Ink Cartridges

Cleaning the Print Head Using a Computer Utility

You can clean the print head using a utility on your Windows computer or Mac.

1.
2.
3.

Make sure there are no errors on the LCD screen and the CD/DVD tray is not inserted for printing.
Load a few sheets of plain paper in the product.

Do one of the following:

* Windows: Right-click the product icon in the Windows taskbar.

* Mac OS X 10.6/10.7/10.8: In the Apple menu or the Dock, select System Preferences. Select
Print & Fax or Print & Scan, select your product, and select Options & Supplies. Select Utility
and select Open Printer Utility.

» Mac OS X 10.5: In the Apple menu or the Dock, select System Preferences. Select Print & Fax,
select your product, and select Open Print Queue. Select Utility.

Select Head Cleaning.
You see a window like this:
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\Q Make sure that the CDJDVD tray is remaved and the output tray is

ejected; otherwise Head Cleaning” cannot be performed. Click [Start]
to dean the print head nozzdes. Becauss deaning consumes soms ink,
only dean the print head when faint areas or gaps appear in your
printout. Lise the Nozzle Chedk” utility first to confirm that the print
head needs to be deaned. If the ink is low or expendad, replace the
cartridge first.

Caution: Do not insert CO/OVD tray untl deaning has finished,

5. Click Start to begin the cleaning cycle.
You see a message on the LCD screen during the cleaning cycle.

Caution: Never turn off the product during a cleaning cycle or you may damage it.

6. When the cleaning cycle is finished, you can check to see if the nozzles are clean; click Print Nozzle
Check Pattern and click Print.

7. Check the printed pattern to see if there are gaps in the lines.
Print head is clean
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Print head needs cleaning

« Ifthere are no gaps, click Finish.
« If there are gaps or the pattern is faint, click Clean to clean the print head again.

If you don’t see any improvement after cleaning the print head up to 2 times, leave the product on and
wait at least 6 hours. Then try cleaning the print head again. If quality still does not improve, one of the
ink cartridges may be old or damaged and needs to be replaced.

Parent topic: Print Head Cleaning

Related tasks
Checking the Nozzles Using a Computer Utility
Loading Paper in Cassette 2 (Lower Cassette)

Related topics
Replacing Ink Cartridges

Print Head Alignment

If your printouts become grainy or blurry, you notice misalignment of vertical lines, or you see dark or
light horizontal bands, you may need to align the print head.

Note: Banding may also occur if your print head nozzles need cleaning.

Aligning the Print Head Using the Product Control Panel
Aligning the Print Head Using a Computer Ultility

Parent topic: Adjusting Print Quality

Aligning the Print Head Using the Product Control Panel
You can align the print head using the control panel on your product.
1. Make sure the CD/DVD tray is not inserted for printing.
2. Load afew sheets of plain paper in the product.
3. Press the 4 home button, if necessary.
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4. Press the left or right arrow buttons and select Setup.
5. Select Maintenance.

Haintenance

Norzle Check

Head Cleaning

Print Head Alignment

6. Select Print Head Alignment.
Nozzle Check

Load Letter/Ad size
Plain Paper
in the Cassette 2

to print nozzle check pattern.
Press 4,

7. Press the ¢ start button to print an alignment sheet.
Note: Do not cancel printing while you are printing a head alignment pattern.

8. Check the printed pattern and select the number representing the best printed pattern for each set.
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9.

Select Done when you are finished.

Parent topic: Print Head Alignment

Aligning the Print Head Using a Computer Utility
You can align the print head using a utility on your Windows computer or Mac.

1.
2.
3.

Make sure the CD/DVD tray is not inserted for printing.

Load a few sheets of plain paper in the product.

Do one of the following:

« Windows: Right-click the product icon in the Windows taskbar.

 Mac OS X 10.6/10.7/10.8: In the Apple menu or the Dock, select System Preferences. Select
Print & Fax or Print & Scan, select your product, and select Options & Supplies. Select Utility
and select Open Printer Utility.

* Mac OS X 10.5: In the Apple menu or the Dock, select System Preferences. Select Print & Fax,
select your product, and select Open Print Queue. Select Utility.

Select Print Head Alignment.
Click Next, then click Print to print an alignment sheet.

Note: Do not cancel printing while you are printing a head alignment pattern.

You see a window like this:
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L Print Head Alignment “

Look at the alignment sheet.

£ A Find the square without any visible bands in sets 21 through 25, Select
the number that corresponds to that square from the list below for all
sets, Then didk [Mext =],
If every square containg a band, select the square with the thinmest
band or bands. Then didk [Realignment].

21 |3 b4
# |4 w
23 |4 w
&4 (4 w
25 |9 w
Realignment Cancel Mext =

6. Check the printed pattern and follow the instructions on the screen to choose the number
representing the best printed pattern for each set.

« After choosing each pattern number, click Next.

« If no patterns are aligned in one or more of the sets, choose the closest one in each set and click
Realignment. Then print another alignment sheet and check it.

Note: Click Skip (where available) if you want to skip a particular alignment sheet.

7. When you are done, click Finish.
Parent topic: Print Head Alignment

Cleaning the Paper Path
If you see ink on the back of a printout, you can clean the paper path to remove any excess ink.
1. Load afew sheets of plain paper in the product.
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2. Use the product control panel to make a copy, but without placing a document on the scanner glass.
3. Check the back of the ejected paper to see if it is clean.

4. Repeat as necessary until the paper comes out clean.

Parent topic: Adjusting Print Quality

Related topics

Copying
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Cleaning and Transporting Your Product

See these sections if you need to clean or transport your product.

Cleaning Your Product
Transporting Your Product

Cleaning Your Product

To keep your product working at its best, you should clean it several times a year.
Close the output tray and front cover when you are not using the product to protect it from dust.

Caution: Do not use a hard brush, alcohol, or paint thinner to clean the product or you may damage it.
Do not use oil or other lubricants inside the product or let water get inside it.

Turn off the product.

Unplug the power cable.
Disconnect any connected cables.
Remove all the paper.

S

Clean the scanner glass with a soft, lint-free cloth (microfiber is recommended), moistened with a
little glass cleaner.

Caution: Do not spray glass cleaner directly on the glass and do not press the glass surface with
any force.

6. Open the ADF cover and use a soft, dry, lint-free cloth (microfiber is recommended), to clean the
roller and the interior of the ADF.
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7. Clean the outer case and control panel with a soft, dry cloth. Do not use liquid or chemical cleansers.
Parent topic: Cleaning and Transporting Your Product

Transporting Your Product
If you need to ship your product or transport it a long distance, prepare it for transportation as described
here.
Caution: During transportation and storage, follow these guidelines:
 Avoid tilting the product, placing it vertically, or turning it upside down; otherwise ink may leak.

» Leave the ink cartridges installed. Removing the cartridges can dry out the print head and may prevent
the product from printing.

» Do not carry the product by its control panel; this may damage the product.

1. Turn off the product.

2. Lift up the scanner unit and check to see if the print head is in the far right position (the home
position). If not, turn on the product, wait for the print head to move, then turn the product off again.

3. Secure the ink cartridge holder to the case with tape.

Caution: Do not place tape on the white flat cable inside the product; otherwise, you may damage
your product.

Lower the scanner unit.
5. Remove all the paper from the product.
6. Unplug the power cable.
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7. Disconnect any connected cables.

8. Close the rear paper feed slot cover, the output tray, the ADF input tray, and the ADF output tray
extension. Then lower the control panel.

9. Place the product in its original packing materials, if possible, or use equivalent materials with
cushioning around the product.

Keep the product level during transportation. Be sure to remove the tape from the ink cartridge holder
before turning on your product. If print quality has declined when you print again, clean and align the
print head.

Parent topic: Cleaning and Transporting Your Product

Related concepts
Print Head Cleaning
Print Head Alignment
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Solving Problems

Check these sections for solutions to problems you may have using your product.

Checking for Software Updates

Product Status Messages

Running a Product Check

Resetting Control Panel Defaults

Solving Setup Problems

Solving Network Problems

Solving Copying Problems

Solving Paper Problems

Solving Problems Printing from a Computer
Solving Page Layout and Content Problems
Solving Print Quality Problems

Solving Scanning Problems

Solving Scanned Image Quality Problems
Solving Memory Card Problems

Solving Faxing Problems

When to Uninstall Your Product Software
Where to Get Help

Checking for Software Updates

Periodically, it's a good idea to check Epson's support website for free updates to your product software.
You can select Download the Latest Software from the Home screen of this manual or visit Epson's
driver download site (U.S. downloads or Canadian downloads).

With Windows, your printer software automatically checks for updates. You can also manually update
the software by selecting Software Update here:

* Right-clicking the product icon in the Windows taskbar
» Onthe Maintenance tab in the printer settings window

* On the Start screen (Windows 8) or in the EPSON program group under your product name (other
Windows versions)

Parent topic: Solving Problems
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http://www.epson.com/support
http://www.epson.ca/support

Related tasks

Changing Automatic Update Options

Product Status Messages

You can often diagnose problems with your product by checking the messages on its LCD screen. You
can also see help information and how-to instructions on the screen. Press the & home button, if
necessary, press the left or right arrow button, and then select Help.

LCD screen message

Condition/solution

Paper jam Paper is jammed in the product. Follow the instructions on the LCD screen to
remove the jammed paper from the indicated area.
Paper out No paper is loaded. Load paper in the product.

Photos not recognized.
Place the photos
correctly on the scanner
glass.

There is a problem with originals placed on the product. Check to make sure
they are placed correctly and repeat the operation.

Printer error. Turn the
power off and on again.
For details, see your
documentation.

A fatal error has occurred. Turn the product off and then back on again. If the
error continues, check for a paper jam. If there is no paper jam, contact
Epson for support.

Communication error.
Check if a computer is
connected.

Make sure the computer is connected to your product and your software is
installed correctly.

A printer's ink pad is
nearing the end of its
service life. Please
contact Epson Support.

The ink pads are near the end of their service life and the message will be
displayed until the ink pad is replaced. Contact Epson for support. (To
resume printing, press the ¢ start button.)

A printer's ink pad is at
the end of its service life.
Please contact Epson
Support.

The ink pad is at the end of its service life. Turn off the product and contact
Epson for support.

Memory card or external
device not recognized.

Make sure the memory card or external device is inserted correctly and
meets the specifications for your product.
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LCD screen message [Condition/solution

The phone line is Make sure the phone cable is connected correctly.

connected to a different

port

No dial tone detected. Make sure the phone cable is connected correctly and the phone line works.
Run Check Fax If you connected the product to a PBX (Private Branch Exchange) phone line

Connection under Fax [ or Terminal Adapter, turn off the Dial Tone Detection setting.
Settings in Setup menu.

Combination of IP There is a problem with the network connection to your product. Check the
address and subnet solutions in this guide.

mask is invalid. See
your documentation.

Recovery mode An error has occurred during firmware updating. Connect your product using
a USB cable and try updating the firmware again. If you still receive this error
message, contact Epson for support.

Parent topic: Solving Problems

Related references

Where to Get Help

Paper Jam Problems Inside the Product

Paper Jam Problems in the Paper Cassette
Paper Jam Problems in the Auto Duplexer
Paper Jams in the Automatic Document Feeder

Related topics

Loading Paper

Placing Originals on the Product
Solving Network Problems

Running a Product Check
Running a product check helps you determine if your product is operating properly.
1. Disconnect any interface cables connected to your product.
2. Load plain paper in the product.
3. Press the & home button, if necessary.
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4. Press the left or right arrow button and then select Setup.
5. Select Maintenance.

Haintenance

Norzle Check

Head Cleaning

Print Head Alignment

6. Select Nozzle Check.

Nozzle Check

in the Cassette 2

to print nozzle check pattern.
Press 4,

7. Press the © start button.
The nozzle check pattern is printed.
8. Do one of the following, depending on the results of the product check:

« |f the page prints and the nozzle check pattern is complete, the product is operating properly. Any
operation problem you may have could be caused by your computer, cable, software, or selected
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settings. Check the other solutions in this book or try uninstalling and reinstalling your printer
software.

« If the page prints but the nozzle check pattern has gaps, clean or align the print head.

« If the page does not print, the product may have a problem. Check the other solutions in this
manual. If they do not work, contact Epson.

Parent topic: Solving Problems

Related concepts

Print Head Cleaning

Print Head Alignment

When to Uninstall Your Product Software

Related references
Where to Get Help

Resetting Control Panel Defaults

If you have a problem with settings on the product control panel, you can reset them to their factory
defaults. You can choose which settings to reset or reset them all.

1. Pressthe 4 home button, if necessary.
2. Press the left or right arrow button and select Setup.
3. Scroll down and select Restore Default Settings.

Restore Default Settings

Fax Send/Receve Settings

Fax Data Settings

Wi-Fi/Network Settinas
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4. Select one of these options:

« Fax Send/Receive Settings: Resets all settings on the Send Settings, Receive Settings, and
Communication screens.

» Fax Data Settings: Erases the speed dial list, group dial list, header, and fax log.
* Wi-Fi/Network Settings: Resets all network settings.

« All except Wi-Fi/Network & Fax Settings: Resets all control panel settings, except for network
and fax settings.

« All Settings: Resets all control panel settings.

You see a confirmation screen.
5. Select Yes to reset the selected settings. (Select No if you want to cancel the operation.)
Parent topic: Solving Problems

Solving Setup Problems
Check these sections if you have problems while setting up your product.

Noise After Ink Installation
Software Installation Problems
Control Panel Setup Problems

Parent topic: Solving Problems

Noise After Ink Installation
If you hear noises from your product after installing ink, check the following:

» The first time you install ink cartridges, the product must prime its print head. Wait until priming
finishes before you turn off the product, or it may prime improperly and use excess ink the next time
you turn it on. Your product is finished priming the print head when the ® power light stops flashing.

« If the product's print head stops moving or making noise, and the charging process has not finished
after approximately 5 minutes, turn off your product. Turn it back on and check to see if charging is still
in progress. If it is still in progress, contact Epson for help.

Parent topic: Solving Setup Problems

Related references
Where to Get Help
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Software Installation Problems
If you have problems while installing your product software, try these solutions:

» Make sure your product is turned on and any necessary cables are securely connected at both ends. If
you still have problems installing software, disconnect the cable and carefully follow the instructions on
the Start Here sheet. Also make sure your system meets the requirements for your operating system.

» Close any other programs, including screen savers and virus protection software, and install your
product software again.

* In Windows, make sure your product is selected as the default printer and the correct port is shown in
the printer properties.

 If you see any error message or your software does not install correctly in Windows, you may not have
software installation privileges. Contact your System Administrator.

Parent topic: Solving Setup Problems

Related concepts
When to Uninstall Your Product Software

Related references
Windows System Requirements
Mac System Requirements

Control Panel Setup Problems
If you have problems setting up the control panel, try these solutions:
» Toview LCD screen text in a different language, select a different language setting for the panel.
» To adjust the position of the control panel, carefully raise or lower it.
Parent topic: Solving Setup Problems

Related tasks
Adjusting Control Panel Position
Changing LCD Screen Language

Solving Network Problems
Check these solutions if you have problems setting up or using your product on a network.
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Note: Breakdown or repair of this product may cause loss of fax and network data and settings. Epson is
not responsible for backing up or recovering data and settings during or after the warranty period. We
recommend that you make your own backup or print out your fax and network data and settings.

Product Cannot Connect to a Wireless Router or Access Point
Network Software Cannot Find Product on a Network

Product Does Not Appear in Mac OS X Printer Window
Cannot Print Over a Network

Cannot Scan Over a Network

Parent topic: Solving Problems

Related references
Product Status Messages

Product Cannot Connect to a Wireless Router or Access Point
If your product has trouble finding or connecting to a wireless router or access point, try these solutions:
» Make sure to place your product within contact range of your router or access point.

Note: Avoid placing your product near a microwave oven, 2.4 GHz cordless phone, or large metal
object, such as a filing cabinet.

» Verify that your router or access point is operating correctly by connecting to it from your computer or
another device.

* You may need to disable the firewall and any anti-virus software on your wireless router or access
point.

» Check to see if access restrictions, such as MAC address filtering, are set on the router or access
point. If access restrictions are set, add your product's MAC address to your router's address list. To
obtain your product's MAC address, print a network status sheet. Then follow the instructions in your
router or access point documentation to add the address to the list.

« If your router or access point does not broadcast its network name (SSID), follow the instructions that
came with your product to enter your wireless network name manually.

« If your router or access point has security enabled, determine the kind of security it is using and any
required password or passphrase for connection. Then make sure to enter the exact WEP key or WPA
passphrase correctly.

» Check if your computer is restricting the available wireless channels. If so, verify that your wireless
access point is using one of the usable channels and change to a usable channel, if necessary.
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« If you are using a Wi-Fi Direct connection that suddenly disconnects, the Wi-Fi direct password on
your device may have been changed. If necessary, delete the existing DIRECT-XxxXXXXXXX connection
settings from your device and enter a new password. See your device documentation for instructions.

« If you connected your product to a Windows computer using Wi-Fi Direct and it automatically selected
Access Point Mode, you may have trouble accessing a low-priority Internet connection. Check the
network connection or adapter settings in the Windows Control Panel and set the Internet metric
setting to 100 for your version of the Internet Protocol.

Parent topic: Solving Network Problems

Network Software Cannot Find Product on a Network
If EpsonNet Setup cannot find your product on a network, try these solutions:

» Make sure your product is turned on and connected to your network. Verify connection using your
product control panel.

» Check if your network name (SSID) contains non-ASCII characters. Your product cannot display non-
ASCII characters.

 If necessary, reinstall your product software and try running EpsonNet Setup again:
1. Reset your product's network settings to their factory defaults.
2. Windows only: uninstall your product software.
3. Initialize your router following the instructions in your router documentation.

Note: If you are reading these instructions online, you will lose your internet connection when you
initialize your router, so note the next step before initializing it.

4. Download your product software from the Epson website, or install it from the CD that came with
your product using the instructions on the Start Here sheet.

* If you have replaced your router, reinstall your product software to connect to the new router.
Parent topic: Solving Network Problems

Related concepts
When to Uninstall Your Product Software

Product Does Not Appear in Mac OS X Printer Window
If your product does not appear in the Mac OS X printer window, try these solutions:
» Turn your product off, wait 30 seconds, then turn it back on again.
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If you are connecting the product wirelessly via EpsonNet Setup and you do not see the Wi-Fi antenna
icon with connection bars on your LCD screen, make sure your product software was installed
correctly. If necessary, reinstall your software.

Parent topic: Solving Network Problems

Related concepts
When to Uninstall Your Product Software

Cannot Print Over a Network
If you cannot print over a network, try these solutions:

Make sure that your product is turned on.
Make sure you install your product's network software as described in your product documentation.

Print a network status sheet and verify that the network settings are correct. If the network status is
Disconnected, check any cable connections and turn your product off and then on again.

If you are using TCP/IP, make sure the product's IP address is set correctly for your network. If your
network does not assign IP addresses using DHCP, set the IP address manually.

Make sure your computer and product are both using the same wireless network.

If network printing is slow, print a network status sheet and check the signal strength. If it is poor, place
your product closer to your router or access point.

Note: Avoid placing your product near a microwave oven, 2.4 GHz cordless phone, or large metal
object, such as a filing cabinet.

Check your wired LAN router or access point to see if the LED for the port to which your product is
connected is on or flashing . If the link LED is off, try the following:

» Make sure the Ethernet cable is securely connected to your product and to your router, access
point, switch, or hub.

» Try connecting your product to a different port or a different router, access point, switch, or hub.
» Try connecting with a different Ethernet cable.
» Try printing to your product from another computer on the network.

If you are connecting the product via EpsonNet Setup and the Wi-Fi icon and signal bars are not
visible on the LCD, make sure your product software was installed correctly. If necessary, reinstall
your software.

Parent topic: Solving Network Problems
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Related concepts
When to Uninstall Your Product Software

Related tasks
Printing a Network Status Sheet

Cannot Scan Over a Network
If you cannot start Epson Scan for scanning over a network, try these solutions:

If you are scanning a large original at a high resolution, a network communication error may occur. Try
scanning again at a lower resolution.

If network communication was interrupted while starting Epson Scan, exit Epson Scan, wait a few
seconds, and restart it. If Epson Scan cannot restart, turn off your product, turn it back on, and try
restarting Epson Scan again.

Check the connection setting and test the connection using Epson Scan Settings:
Windows 8: Navigate to the Start screen and select EPSON Scan Settings. Make sure the
Connection setting is set to Network, then click the Test button.

Windows (other versions): CIickE]' or Start > All Programs or Programs > EPSON > EPSON
Scan > EPSON Scan Settings. Make sure the Connection setting is set to Network, then click the
Test button.

Mac OS X: Open the Applications folder, click Epson Software, and click EPSON Scan Settings.
Make sure the Connection setting is set to Network, then click the Test button.

Make sure the option selected as the Timeout Setting in the Epson Scan Settings program is long
enough to complete scanning over a network.

You may need to disable the firewall and any anti-virus software on your wireless router or access
point.

Note: With Mac OS X 10.6, 10.7, or 10.8, in addition to scanning with Image Capture, you can download
and install Epson Scan scanning software. Epson Scan provides additional image adjustment and photo
correction features for enhancing scanned images, and provides an interface for TWAIN-compliant OCR
scanning software, such as ABBYY FineReader. To download Epson Scan, visit Epson's driver
download site (U.S. downloads or Canadian downloads).

Parent topic: Solving Network Problems

Related topics
Scanning
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Solving Copying Problems
Check these solutions if you have problems copying with your product.

Product Makes Noise, But Nothing Copies
Product Makes Noise When It Sits for a While

Parent topic: Solving Problems

Product Makes Noise, But Nothing Copies
If your product makes a noise, but nothing copies, try these solutions:

* Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if
necessary.

* If the nozzle check page does not print, but the product's power is on, make sure your product
software is installed correctly.

» Make sure your product is level (not tilted).
Parent topic: Solving Copying Problems

Related concepts
Print Head Nozzle Check
Print Head Cleaning

Product Makes Noise When It Sits for a While

Your product is performing routine maintenance. This is normal.
Parent topic: Solving Copying Problems

Solving Paper Problems
Check these sections if you have problems using paper with your product.

Paper Feeding Problems

Paper Jam Problems Inside the Product

Paper Jam Problems in the Paper Cassette
Paper Jam Problems in the Auto Duplexer
Paper Jams in the Automatic Document Feeder
Paper Ejection Problems

Parent topic: Solving Problems
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Paper Feeding Problems
If you have problems feeding paper, try these solutions:

* If paper does not feed for printing, remove it from the rear feed slot or cassette. Reload it, then adjust
the edge guides. Make sure the paper stack is not above the tab on the edge guides inside the
cassette. Make sure to load only one sheet at a time in the rear feed slot.

 If multiple pages feed at once, remove the paper, fan the edges to separate the sheets, and reload it.
» Do not load more than the recommended number of sheets.
» Make sure your paper meets the specifications for your product.
* If paper jams when you print on both sides of the paper, try loading fewer sheets.
» For best results, follow these guidelines:
* Use new, smooth, high-quality paper that is not curled, creased, old, too thin, or too thick.
» Load paper in the cassette printable side down.
» Follow any special loading instructions that came with the paper.
Parent topic: Solving Paper Problems

Related references

Paper Loading Capacity

Paper Jam Problems Inside the Product

Paper Jam Problems in the Paper Cassette
Paper Jam Problems in the Auto Duplexer
Paper Jams in the Automatic Document Feeder
Related topics

Loading Paper

Paper Jam Problems Inside the Product

If you see a message that paper has jammed inside the product, follow the steps below or on the LCD
screen to clear the jam.

1. Cancel the print job, if necessary.
2. Remove any jammed paper from the rear paper feed slot.
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Caution: Do not touch the flat white cable inside the printer.

4. Close the scanner unit.
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5. Follow the prompts on the LCD screen to clear any error messages. If you still see a paper jam
message, check the other paper jam solutions.

Parent topic: Solving Paper Problems

Related references

Paper Jam Problems in the Paper Cassette
Paper Jam Problems in the Auto Duplexer
Paper Jams in the Automatic Document Feeder

Paper Jam Problems in the Paper Cassette

If you see a message that paper has jammed in the paper cassette, follow the steps below or on the LCD
screen to clear the jam.

1. Cancel the print job, if necessary.
2. Pull out both paper cassettes, then carefully remove any jammed paper.

3. Make sure the paper you loaded is under the edge guides.

4. Keep the cassette flat as you insert it. If inserting Cassette 1 (upper cassette), insert it until the arrows
on the right side line up.

5. Follow the prompts on the LCD screen to clear any error messages. If you still see a paper jam
message, check the other paper jam solutions.

Parent topic: Solving Paper Problems

Related references
Paper Jam Problems Inside the Product
Paper Jam Problems in the Auto Duplexer
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Paper Jams in the Automatic Document Feeder

Paper Jam Problems in the Auto Duplexer

If you see a message that paper has jammed in the auto duplexer, follow the steps below or on the LCD
screen to clear the jam.

1. Cancel the print job, if necessary.

2. Press the buttons to release the auto duplexer and remove the duplexer from your product. Carefully
remove any jammed paper from inside the unit.
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5. Reattach the duplexer.

6. Follow the prompts on the LCD screen to clear any error messages. If you still see a paper jam
message, check the other paper jam solutions.

Parent topic: Solving Paper Problems

Related references

Paper Jam Problems Inside the Product

Paper Jam Problems in the Paper Cassette
Paper Jams in the Automatic Document Feeder

Paper Jams in the Automatic Document Feeder

If you have problems with paper jams in the automatic document feeder (ADF), follow the steps below or
on the LCD screen to clear the jam.

1. Cancel the print job, if necessary.
2. Remove your originals from the ADF.
3. Open the ADF cover, then carefully remove any jammed paper.
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Caution: Make sure you open the ADF cover before removing any jammed paper. Otherwise the
product may be damaged.

4. Leave the ADF cover open, then raise the scanner unit.

5. Press the tabs and remove the document mat.
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7. Reattach the document mat, lower the scanner unit, and close the ADF cover.
8. Open the ADF as shown.
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10. Close the ADF.
11. Reload your originals.

Caution: Do not load the ADF beyond its capacity for your paper size. Also make sure your originals
are not bent, folded, or curled and do not have tape, staples, or other materials that could obstruct the
feeder.

12. Follow the prompts on the LCD screen to clear any error messages. If you still see a paper jam
message, check the other paper jam solutions.

Parent topic: Solving Paper Problems

Related references

Paper Jam Problems Inside the Product
Paper Jam Problems in the Paper Cassette
Paper Jam Problems in the Auto Duplexer
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Paper Ejection Problems
If you have problems with paper ejecting properly, try these solutions:

« If paper does not eject fully, you may have set the wrong paper size. Cancel printing to eject the paper.
Select the correct paper size when you reprint.

* If paper is wrinkled when it ejects, it may be damp or too thin. Load new paper and be sure to select
the correct paper type setting when you reprint.

Parent topic: Solving Paper Problems

Related references

Paper or Media Type Settings

Paper Jam Problems Inside the Product

Paper Jam Problems in the Paper Cassette
Paper Jam Problems in the Auto Duplexer
Paper Jams in the Automatic Document Feeder

Related tasks
Cancelling Printing Using a Product Button

Related topics
Loading Paper

Solving Problems Printing from a Computer

Check these sections if you have problems while printing from your computer.

Nothing Prints

Product Icon Does Not Appear in Windows Taskbar
Error After Cartridge Replacement

Printing is Slow

Parent topic: Solving Problems

Nothing Prints
If you have sent a print job and nothing prints, try these solutions:
» Make sure your product is turned on.
» Make sure any interface cables are connected securely at both ends.
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« |If you connected your product to a USB hub, make sure it is a first-tier hub. If it still does not print,
connect your product directly to your computer instead of the hub.

* Run a product check to see if a test page prints. If the test page prints, check to see if your product
software is installed correctly.

* In Windows, make sure your product is selected as the default printer.
* In Windows, clear any stalled print jobs from the Windows Spooler:

» Windows 8: Navigate to the Start screen, right-click the screen, and select All apps. Select
Control Panel > Hardware and Sound > Devices and Printers. Right-click your product name,
select See what's printing, and select your product name again if necessary. Right-click the stalled
print job, click Cancel, and click Yes.

* Windows 7: Clickﬂ'I and select Devices and Printers. Right-click your product name, select See
what's printing, and select your product name again, if necessary. Right-click the stalled print job,
click Cancel, and click Yes.

* Windows Vista: Click E]' and select Control Panel. Click Printer under Hardware and Sound,
right-click your product name, and select Open. Right click the stalled print job, click Cancel, and
click Yes.

* Windows XP: Click Start and select Printers and Faxes. (Or open the Control Panel, select
Printers and Other Hardware, if necessary, and select Printers and Faxes.) Right-click your
product name, select Open, right-click the stalled print job, click Cancel, and click Yes.

Parent topic: Solving Problems Printing from a Computer

Related tasks
Running a Product Check

Product Icon Does Not Appear in Windows Taskbar

If you do not see your product icon in the Windows taskbar, first try restarting your computer. If that does
not work, try this solution:

1. Do one of the following:

* Windows 8: Navigate to the Start screen, right-click the screen and select All apps. Select
Control Panel > Hardware and Sound > Devices and Printers.

 Windows 7: CIickE]' and select Devices and Printers.

* Windows Vista: Click E]' select Control Panel, and click Printer under Hardware and Sound.
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» Windows XP: Click Start and select Printers and Faxes. (Or open the Control Panel, select
Printers and Other Hardware, if necessary, and Printers and Faxes.)

N

Right-click your product name, select Printing Preferences, and select your product name again if
necessary.

Click the Maintenance tab.

Click the Extended Settings button.

Click the Monitoring Preferences button.

Click the Register the shortcut icon to the taskbar checkbox.

N o g bk w

Click OK to close the open program windows.
Parent topic: Solving Problems Printing from a Computer

Error After Cartridge Replacement
If you see an error light or error message after you replace an ink cartridge, follow these steps:

1. Make sure the print head is in the ink cartridge replacement position. (The ink cartridge holder should
be beneath the cutout in the product case.)

Note: If the print head is not in the ink cartridge replacement position, follow the instructions on
replacing an ink cartridge in this manual to move it.

2. Remove and reinsert the replaced ink cartridge, making sure to push it all the way into its slot.
3. Complete the ink cartridge installation steps.
Parent topic: Solving Problems Printing from a Computer

Related topics
Replacing Ink Cartridges

Printing is Slow
If printing becomes slow, try these solutions:

» Make sure your system meets the requirements for your operating system. If you are printing a high-
resolution image, you may need more than the minimum requirements. If necessary, increase your
system's memory.

* If you are using Windows 7, close the Devices and Printers window before you print.
» Clear space on your hard drive or run a defragmentation utility to free up existing space.
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Close any programs you are not using when you print.
If your product is connected to a USB hub, connect it directly to your computer instead.

If printing becomes slower after printing continuously for a long time, the product may have
automatically slowed down to protect the print mechanism from overheating or becoming damaged.
Let the product rest with the power on for 30 minutes, then try printing again.

For the fastest printing, select the following settings in your product software:

Make sure the paper type setting matches the type of paper you loaded.

Turn on any high speed settings in your product software.

Select a lower print quality setting.

Make sure the ink drying time has not been increased for double-sided printing.

Windows: Click the Maintenance tab, select Extended Settings, and select the following settings:
» High Speed Copies

* Always spool RAW datatype

» Page Rendering Mode

« Print as Bitmap

Parent topic: Solving Problems Printing from a Computer

Related references

Windows System Requirements
Mac System Requirements
Paper or Media Type Settings

Related tasks
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac OS X

Solving Page Layout and Content Problems
Check these sections if you have problems with the layout or content of your printed pages.

Inverted Image

Too Many Copies Print
Blank Pages Print

Incorrect Margins on Printout
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Border Appears on Borderless Prints
Incorrect Characters Print

Incorrect Image Size or Position
Slanted Printout

Parent topic: Solving Problems

Inverted Image
If your printed image is inverted unexpectedly, try these solutions:

» Turn off any mirror or inversion settings in your printing application.
» Turn off the Mirror Image, Flip horizontally, or Reverse page orientation settings in your printer

software. (This option has different names, depending on your operating system version.)

Note: Leave these options turned on when you print on Epson Iron-on Cool Peel Transfer paper, if
available for your product.

Parent topic: Solving Page Layout and Content Problems

Related tasks
Selecting Print Layout Options - Windows
Selecting Basic Print Settings - Mac OS X

Too Many Copies Print

Make sure that the Copies setting in your printing program or printer software is not set for multiple
copies.

Parent topic: Solving Page Layout and Content Problems

Blank Pages Print
If blank pages print unexpectedly, try these solutions:

Make sure you selected the correct paper size settings in your printing program and printer software.

If a blank page exists in a document you are printing and you want to skip printing it, select the Skip
Blank Page setting in your printer software.

Run a print head nozzle check to see if any of the nozzles are clogged. Then clean the print head, if
necessary.

Make sure your product is selected as the printer in your printing program.
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Parent topic: Solving Page Layout and Content Problems

Related concepts
Print Head Nozzle Check
Print Head Cleaning

Related references
Printing Preferences - Mac OS X

Related tasks
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac OS X

Incorrect Margins on Printout
If your printed page has incorrect margins, try these solutions:
» Make sure you selected the correct paper size settings in your printing program and printer software.
» Make sure you selected the correct margins for your paper size in your printing program.
» Make sure your paper is positioned correctly for feeding into the printer.
You can use the preview option in your printer software to check your margins before you print.
Parent topic: Solving Page Layout and Content Problems

Related tasks
Selecting Print Layout Options - Windows
Selecting Basic Print Settings - Mac OS X

Related topics
Loading Paper

Border Appears on Borderless Prints
If you see a border on borderless prints, try these solutions:
» Make sure you are printing on a compatible borderless paper type and size.

Note: Do not select a custom paper size for borderless prints.

» Windows: Make sure you selected the Borderless setting in your printer software.

» Mac OS X: Make sure you selected the Borderless checkbox or a paper size with a Borderless
option in your printer software.
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» Adjust the Expansion setting to adjust the amount of image expansion on the edges of borderless
prints.

» Make sure the image size and the paper size are set correctly; if the image is small, the enlargement
may not be enough to cover the paper.

Parent topic: Solving Page Layout and Content Problems

Related tasks

Selecting Basic Print Settings - Windows
Selecting Print Layout Options - Windows
Selecting Basic Print Settings - Mac OS X
Selecting Page Setup Settings - Mac OS X

Incorrect Characters Print
If incorrect characters appear in your prints, try these solutions before reprinting:
» Make sure any cables are securely connected at both ends.
* In Windows, delete all print jobs from the Windows Spooler:

» Windows 8: Navigate to the Start screen, right-click the screen, and select All apps. Select
Control Panel > Hardware and Sound > Devices and Printers. Right-click your product name,
select See what's printing, and select your product name again, if necessary. Right-click the
stalled print job, click Cancel, and click Yes.

* Windows 7: ClickE’I and select Devices and Printers. Right-click your product name, select See
what's printing, and select your product name again, if necessary. Right-click the stalled print job,
click Cancel, and click Yes.

* Windows Vista: Click E" and select Control Panel. Click Printer under Hardware and Sound,
right-click your product name, and select Open. Right click the stalled print job, click Cancel, and
click Yes.

* Windows XP: Click Start and select Printers and Faxes. (Or open the Control Panel, select
Printers and Other Hardware if necessary, and select Printers and Faxes.) Right-click your
product name, select Open, right-click the stalled print job, click Cancel, and click Yes.

» Make sure your product is selected as the printer in your printing program.
 If your product is connected to a USB hub, connect it directly to your computer instead.
Parent topic: Solving Page Layout and Content Problems
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Incorrect Image Size or Position
If your printed image is the wrong size or in the wrong position, try these solutions:

» Make sure you selected the correct paper size and layout settings in your printing program and printer
software.

» Make sure your paper is positioned correctly for feeding into the printer.
You can use the preview option in your printer software to check your margins before you print.
Parent topic: Solving Page Layout and Content Problems

Related tasks

Selecting Basic Print Settings - Windows
Selecting Print Layout Options - Windows
Selecting Basic Print Settings - Mac OS X
Selecting Page Setup Settings - Mac OS X

Related topics
Loading Paper

Slanted Printout
If your printouts are slanted, try these solutions:
 Slide the edge guides against the edges of the paper.
» Select a higher print quality setting in your printer software.
 Align the print head.
» Make sure the product is not printing while tilted or at an angle.
Parent topic: Solving Page Layout and Content Problems

Related concepts
Print Head Alignment

Related tasks
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - Mac OS X

Solving Print Quality Problems

Check these sections if your printouts have problems with print quality, but your image looks fine on your
computer screen.
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White or Dark Lines in Printout
Blurry or Smeared Printout

Faint Printout or Printout Has Gaps
Grainy Printout

Incorrect Colors

Parent topic: Solving Problems

White or Dark Lines in Printout
If you notice white or dark lines in your prints (also called banding), try these solutions before you reprint:

* Run anozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if
necessary.

» Make sure the paper type setting matches the type of paper you loaded.

» Make sure you loaded the printable side of the paper correctly for your product.
» Turn off any high speed settings in your product software.

 Align the print head.

* You may need to replace the ink cartridges.

Parent topic: Solving Print Quality Problems

Related concepts

Print Head Nozzle Check
Print Head Cleaning
Print Head Alignment

Related references
Paper or Media Type Settings
Printing Preferences - Mac OS X

Related tasks

Selecting Advanced Print Settings - Windows
Related topics

Loading Paper

Replacing Ink Cartridges
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Blurry or Smeared Printout
If your printouts are blurry or smeared, try these solutions:

Make sure your paper is not damp, curled, old, or loaded incorrectly in your product.

Use a support sheet with special paper, or load special paper one sheet at a time.

Make sure your paper meets the specifications for your product.

Use Epson papers to ensure proper saturation and absorption of genuine Epson inks.

Make sure the paper type setting in your product software matches the type of paper you loaded.
Remove each sheet from the output tray as it is printed.

Avoid handling printouts on glossy paper right after printing to allow the ink to set.

Turn off any high speed settings in your product software.

If you print on both sides of a sheet of paper, smudges may appear on the reverse side of heavily
saturated or dark images. If one side of a sheet will contain a lighter image or text, print that side first.
Adjust the Print Density and/or Increased Ink Drying Time settings.

Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if
necessary.

Align the print head.
Clean the paper path.

Note: Your product will not operate properly while tilted at an angle. Place it on a flat, stable surface that
extends beyond the base of the product in all directions.

Parent topic: Solving Print Quality Problems

Related concepts
Print Head Nozzle Check
Print Head Cleaning

Related references
Printing Preferences - Mac OS X
Paper Specifications

Related tasks
Selecting Basic Print Settings - Windows
Selecting Advanced Print Settings - Windows
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Selecting Double-sided Printing Settings - Windows
Selecting Basic Print Settings - Mac OS X

Selecting Double-sided Printing Settings - Mac OS X
Cleaning the Paper Path

Related topics
Loading Paper

Faint Printout or Printout Has Gaps
If your printouts are faint or have gaps, try these solutions:

* Run anozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if
necessary.

» The ink cartridges may be old or low on ink, and you may need to replace them.

» Make sure the paper type setting matches the type of paper you loaded.

» Make sure your paper is not damp, curled, old, or loaded incorrectly in your product.
 Align the print head.

» Clean the paper path.

Parent topic: Solving Print Quality Problems

Related concepts

Print Head Nozzle Check
Print Head Cleaning
Print Head Alignment

Related references

Paper or Media Type Settings
Related tasks

Cleaning the Paper Path
Related topics

Loading Paper

Replacing Ink Cartridges
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Grainy Printout
If your printouts are grainy, try these solutions:
» Make sure you loaded the printable side of the paper correctly for your product.
» Select a higher print quality setting and turn off any high speed settings in your product software.

* Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if
necessary.

* Align the print head.

* You may need to increase the image resolution or print a smaller size; see your software
documentation.

Parent topic: Solving Print Quality Problems

Related concepts

Print Head Nozzle Check
Print Head Cleaning
Print Head Alignment

Related references
Printing Preferences - Mac OS X

Related tasks

Selecting Basic Print Settings - Windows
Selecting Advanced Print Settings - Windows
Selecting Basic Print Settings - Mac OS X

Related topics
Loading Paper

Incorrect Colors
If your printouts have incorrect colors, try these solutions:
» Make sure the Black/Grayscale or Grayscale setting is not selected in your printer software.

* Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if
necessary.

» The ink cartridges may be old or low on ink, and you may need to replace them.
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» Your printed colors can never exactly match your on-screen colors. However, you can use a color
management system to get as close as possible. Try using the color management options in your
printer software.

» For best results, use genuine Epson ink and paper.
Parent topic: Solving Print Quality Problems

Related concepts
Print Head Nozzle Check
Print Head Cleaning

Related tasks

Selecting Basic Print Settings - Windows
Selecting Advanced Print Settings - Windows
Selecting Basic Print Settings - Mac OS X
Managing Color - Mac OS X

Related topics
Replacing Ink Cartridges

Solving Scanning Problems

Check these solutions if you have problems scanning with your product.

Scanning Software Does Not Operate Correctly
Cannot Start Epson Scan

Parent topic: Solving Problems

Scanning Software Does Not Operate Correctly
If your scanning software does not operate correctly, try these solutions:

» Make sure your computer has adequate memory and meets the system requirements for your
operating system.

» Make sure your computer is not running in a power-saving mode, such as sleep or standby. If so,
wake your system and restart your scanning software.

« If you upgraded your operating system but did not reinstall your scanning software, try reinstalling it.

Note: With Mac OS X 10.6, 10.7, or 10.8, in addition to scanning with Image Capture, you can
download and install Epson Scan scanning software. Epson Scan provides additional image
adjustment and photo correction features for enhancing scanned images, and provides an interface
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for TWAIN-compliant OCR scanning software, such as ABBYY FineReader. To download Epson
Scan, visit Epson's driver download site (U.S. downloads or Canadian downloads).

Parent topic: Solving Scanning Problems

Related concepts
When to Uninstall Your Product Software

Related references
Windows System Requirements
Mac System Requirements

Related tasks
Scanning with Mac OS X 10.6/10.7/10.8 Using Image Capture

Cannot Start Epson Scan
If you cannot start Epson Scan, try these solutions:
» Make sure your product is turned on and any interface cables are securely connected at both ends.
» Make sure Epson Scan is selected in your scanning program.

» Make sure your computer is not running in a power-saving mode, such as sleep or standby. If so,
wake your system and restart Epson Scan.

» Check the connection setting and test the connection using Epson Scan Settings:
Windows 8: Navigate to the Start screen and select EPSON Scan Settings. Make sure the correct
Connection setting is selected, then click the Test button.

Windows (other versions): CIickE]' or Start > All Programs or Programs > EPSON > EPSON
Scan > EPSON Scan Settings. Make sure the correct Connection setting is selected, then click the
Test button.

Mac OS X: Open the Applications folder, click Epson Software, and click EPSON Scan Settings.
Make sure the correct Connection setting is selected, then click the Test button.

» Make sure you do not have multiple versions of Epson Scan installed. If you do, uninstall both versions
and install one version.

* If you upgraded your operating system but did not reinstall Epson Scan, try reinstalling it.

Note: With Mac OS X 10.6, 10.7, or 10.8, in addition to scanning with Image Capture, you can download
and install Epson Scan scanning software. Epson Scan provides additional image adjustment and photo
correction features for enhancing scanned images, and provides an interface for TWAIN-compliant OCR
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scanning software, such as ABBYY FineReader. To download Epson Scan, visit Epson's driver
download site (U.S. downloads or Canadian downloads).

Parent topic: Solving Scanning Problems
Related tasks
Scanning with Mac OS X 10.6/10.7/10.8 Using Image Capture

Related topics
Starting a Scan

Solving Scanned Image Quality Problems
Check these sections if a scanned image on your computer screen has a quality problem.

Image Consists of a Few Dots Only

Line of Dots Appears in All Scanned Images
Straight Lines in an Image Appear Crooked

Image is Distorted or Blurry

Image Colors are Patchy at the Edges

Image is Too Dark

Back of Original Image Appears in Scanned Image
Ripple Patterns Appear in an Image

Scanned Image Colors Do Not Match Original Colors
Scan Area is Not Adjustable in Thumbnail Preview
Scanned Image Edges are Cropped

Parent topic: Solving Problems

Image Consists of a Few Dots Only
If your scanned image consists only of a few dots, try these solutions:
» Make sure you placed your original for scanning facing the correct way.

 If you are scanning using the Epson Scan Black & White setting, adjust the Threshold setting and
scan again.

Parent topic: Solving Scanned Image Quality Problems

Related references
Available Image Adjustments - Office Mode
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Available Image Adjustments - Home Mode
Available Image Adjustments - Professional Mode

Related topics
Placing Originals on the Product

Line of Dots Appears in All Scanned Images

If a line of dots appears in all your scanned images, clean the scanner glass with a soft, dry, lint-free
cloth or use a small amount of glass cleaner on the cloth, if necessary. Paper towels are not
recommended.

Caution: Do not spray glass cleaner directly on the scanner glass.

Parent topic: Solving Scanned Image Quality Problems

Related tasks
Cleaning Your Product

Straight Lines in an Image Appear Crooked

If straight lines in an original appear crooked in a scanned image, make sure to place your original
straight when you scan it.

Parent topic: Solving Scanned Image Quality Problems

Related topics
Placing Originals on the Product

Image is Distorted or Blurry
If a scanned image appears distorted or blurry, try these solutions:

» Make sure your original is not wrinkled or warped. This may prevent the original from laying flat on the
scanner glass.

» Do not move your original or your product during scanning.

» Your product will not operate properly while tilted at an angle. Place it on a flat, stable surface that
extends beyond the base of the product in all directions.

» Adjust these Epson Scan settings (if available) and try scanning again:
» Select the Unsharp Mask setting.
» Adjust the Auto Exposure setting.
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* Increase the Resolution setting.

Parent topic: Solving Scanned Image Quality Problems
Related topics
Selecting Epson Scan Settings

Image Colors are Patchy at the Edges

If you are scanning a thick or warped original, cover its edges with paper to block external light as you
scan it.

Parent topic: Solving Scanned Image Quality Problems

Image is Too Dark

If your scanned image is too dark, try these solutions:

» Adjust these Epson Scan settings (if available) and try scanning again:
* Auto Exposure
* Brightness
e Histogram Adjustment

» Check the brightness and contrast settings of your computer monitor.

Parent topic: Solving Scanned Image Quality Problems

Related topics
Selecting Epson Scan Settings

Back of Original Image Appears in Scanned Image

If an image from the back of a thin original appears in your scanned image, place a piece of black paper
on the back of the original and scan it again.

Parent topic: Solving Scanned Image Quality Problems

Ripple Patterns Appear in an Image

You may see a ripple pattern (called a moiré€) in scanned images of printed documents. This is caused
by interference from differing pitches in the scanner's screen and your original's halftone screen. To
reduce this effect, adjust these Epson Scan settings (if available) and try scanning again:

» Select the Descreening setting.
» Select a lower Resolution setting.
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Parent topic: Solving Scanned Image Quality Problems

Related topics
Selecting Epson Scan Settings

Scanned Image Colors Do Not Match Original Colors

Printed colors can never exactly match the colors on your computer monitor because printers and
monitors use different color systems: monitors use RGB (red, green, and blue) and printers typically use
CMYK (cyan, magenta, yellow, and black).

Check the color matching and color management capabilities of your computer, display adapter, and the
software you are using to see if they are affecting the palette of colors you see on your screen.

To adjust the colors in your scanned image, adjust these Epson Scan settings (if available) and try
scanning again:

» Change the Image Type setting and experiment with different combinations of the next settings.
» Adjust the Tone Correction setting.

» Adjust the Auto Exposure setting.

Parent topic: Solving Scanned Image Quality Problems

Related topics
Selecting Epson Scan Settings

Scan Areais Not Adjustable in Thumbnail Preview
If you cannot adjust the scan area while viewing a Thumbnail preview in Epson Scan, try these solutions:
» Create a scan area by drawing a marguee on your preview image and adjusting it as necessary.
» Switch to Normal preview mode, if available, and preview your image again.
Parent topic: Solving Scanned Image Quality Problems

Related concepts
Image Preview Guidelines

Related tasks

Selecting a Scan Area - Office Mode
Selecting a Scan Area - Home Mode
Selecting a Scan Area - Professional Mode
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Scanned Image Edges are Cropped

If the edges of a scanned image are cropped, make sure your original is placed correctly for scanning. If
necessary, move your original away from the edges of the scanner glass slightly.

Parent topic: Solving Scanned Image Quality Problems

Related topics
Placing Originals on the Product

Solving Memory Card Problems
Check these solutions if you have problems using memory cards with your product.

Memory Card Does Not Fit Into a Slot
Cannot View or Print Photos from a Memory Card
Cannot Transfer Photos To or From a Memory Card

Parent topic: Solving Problems

Memory Card Does Not Fit Into a Slot

If a memory card does not fit properly in a slot, do not force it in. You may need to use an adapter with
your memory card.

Parent topic: Solving Memory Card Problems

Related references
Memory Card Types

Related tasks
Inserting a Memory Card

Cannot View or Print Photos from a Memory Card
If you cannot view or print photos from a memory card inserted in your product, try these solutions:
» Make sure your memory card is compatible with the product.
» Make sure the files on your memory card are in the correct format.

« If you have too many photos on your memory card, you may not see all the photos you expect or may
be prompted to select a group of photos by date. Reduce the number of photos on your card or select
one group of photos at a time. Check the memory card specifications for the maximum number of
photos.

Parent topic: Solving Memory Card Problems
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Related references
Memory Card Types
Memory Card File Specifications

Related tasks
Inserting a Memory Card

Cannot Transfer Photos To or From a Memory Card

If you have problems transferring photos to or from a memory card inserted in your product, try these
solutions:

» Make sure your memory card is compatible with the product.
» Make sure your product is securely connected to your computer.

* If you are transferring photos to the memory card, check the memory card's write-protect tab to make
sure it is set to allow writing to the card.

» Make sure that the file sharing setting for your product is set correctly.
Parent topic: Solving Memory Card Problems

Related references
Memory Card Types
Memory Card File Specifications

Related topics
Transferring Photos on a Memory Card

Solving Faxing Problems
Check these solutions if you have problems faxing with your product.

Cannot Send or Receive Faxes
Cannot Receive Faxes with a Telephone Connected to Your Product

Parent topic: Solving Problems

Cannot Send or Receive Faxes
If you cannot send or receive faxes, try these solutions:
* Make sure the recipient's fax machine is turned on and working.
» Make sure paper is loaded correctly in your product.
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» Make sure Auto Answer mode is turned on to receive faxes automatically. Check your product control
panel to see if this mode is turned on.

» Check that the cable connecting your telephone wall jack to your product's LINE port is secure.

 Print a fax connection report using your product control panel or fax software to help diagnose the
problem.

» Verify that the telephone wall jack works by connecting a phone to it and testing it.

« If there is no dial tone and you connected the product to a PBX (Private Branch Exchange) phone line
or Terminal Adapter, turn off your product's dial tone detection settings.

« If you connected your product to a DSL phone line, you must connect a DSL filter to the phone jack to
enable faxing over the line. Contact your DSL provider for the necessary filter.

» Try lowering your product's fax speed setting.

» Make sure the error correction mode (ECM) setting is turned on if you are trying to send or receive a
color fax.

Note: If your product is connected to a VolP (Voice over Internet Protocol) phone line, keep in mind that
fax machines are designed to work over analog phone lines. Epson cannot guarantee that fax
transmission will work when using VolIP.

If your phone line includes voice mail answering services, calls or faxes may be inadvertently received
by your voice mail service.

Parent topic: Solving Faxing Problems

Related tasks

Connecting a Telephone or Answering Machine
Receiving Faxes Automatically (Auto Answer)
Selecting Fax Communication Settings

Printing Fax Reports

Related topics

Loading Paper

Cannot Receive Faxes with a Telephone Connected to Your Product
Make sure your telephone is connected to your product's EXT port.

Note: When answering a call that is a fax, wait until the product's LCD screen displays a message that a
connection has been made before you hang up.
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Parent topic: Solving Faxing Problems

Related tasks
Connecting a Telephone or Answering Machine

When to Uninstall Your Product Software

If you have a problem that requires you to uninstall and re-install your software, follow the instructions for
your operating system.

Uninstalling Product Software - Windows
Uninstalling Product Software - Mac OS X

Parent topic: Solving Problems

Uninstalling Product Software - Windows
You can uninstall and then re-install your product software to solve certain problems.
1. Turn off the product.
2. Disconnect any interface cables.
3. Do one of the following:

» Windows 8: Navigate to the Start screen, right-click the screen, and select All apps. Select
Control Panel > Programs > Programs and Features. Select the uninstall option for your Epson
product, then select Uninstall/Change.

Note: If you see a User Account Control window, click Yes or Continue.

Select your product again, if necessary, then select OK, and click Yes to confirm the
uninstallation.

* Windows (other versions): CIickE]' or Start, and select All Programs or Programs. Select
EPSON, select your product, then click EPSON Printer Software Uninstall.

Note: If you see a User Account Control window, click Yes or Continue.

In the next window, select your product and click OK. Then follow any on-screen instructions.
4. Do one of the following to uninstall Epson Event Manager, then follow any on-screen instructions:
* Windows 8: Select Epson Event Manager and click Uninstall.
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* Windows 7 or Windows Vista: Open the Windows Control Panel utility. Select Programs and
Features. (In Classic view, select Programs and click Uninstall a program.) Select Epson
Event Manager and click Uninstall/Change.

* Windows XP: Open the Windows Control Panel utility. Double-click Add or Remove Programs.
Select Epson Event Manager and click Change/Remove.

5. Do one of the following to uninstall Epson Scan, then follow any on-screen instructions:
* Windows 8, Windows 7, or Windows Vista: Select EPSON Scan and click Uninstall/Change.
* Windows XP: Select EPSON Scan and click Change/Remove.

6. Restart your computer, then see the Start Here sheet to re-install your software.

Note: If you find that re-installing your product software does not solve a problem, contact Epson.
Parent topic: When to Uninstall Your Product Software

Uninstalling Product Software - Mac OS X

In most cases, you do not need to uninstall your product software before re-installing it. However, you
can download the Uninstaller utility from the Epson support website to uninstall your product software as
described here.

Note: If you find that re-installing your product software does not solve a problem, contact Epson.

1. To download the Uninstaller utility, visit the Epson download site (U.S. downloads or Canadian
downloads).

Follow the instructions on the screen to install the Uninstaller utility.
Quit all applications currently running on your Mac.

Double-click the Uninstaller icon.

Select the checkbox for each software program you want to uninstall.
Click Uninstall.

Follow the on-screen instructions to uninstall the software.

© N o g s w DN

To reinstall your product software, see the Start Here sheet for instructions.

Note: If you uninstall the printer driver and your product name remains in the Print & Fax or Print & Scan
window, select your product name and click the — (remove) icon to remove it.
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Parent topic: When to Uninstall Your Product Software

Where to Get Help

If you need to contact Epson for technical support services, use the following support options.

Internet Support

Visit Epson's support website at epson.com/support (U.S.) or epson.ca/support (Canada) for solutions to
common problems. You can download drivers and documentation, get FAQs and troubleshooting
advice, or e-mail Epson with your questions.

Speak to a Support Representative

Before you call Epson for support, please have the following information ready:

* Product name

» Product serial number (located on a label on the product)

» Proof of purchase (such as a store receipt) and date of purchase

» Computer configuration

» Description of the problem

Then call:

» U.S.:(562) 276-4382, 6 AM to 8 PM, Pacific Time, Monday through Friday, and 7 AM to 4 PM, Pacific
Time, Saturday

» Canada: (905) 709-3839, 6 AM to 8 PM, Pacific Time, Monday through Friday, and 7 AM to 4 PM,
Pacific Time, Saturday

Days and hours of support are subject to change without notice. Toll or long distance charges may
apply.
Purchase Supplies and Accessories

You can purchase genuine Epson ink and paper at Epson Supplies Central at epson.com/ink3 (U.S.
sales) or epson.ca (Canadian sales). You can also purchase supplies from an Epson authorized reseller.
To find the nearest one, call 800-GO-EPSON (800-463-7766).

Parent topic: Solving Problems
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Technical Specifications

These sections list the technical specifications for your product.

Note: Epson offers a recycling program for end of life products. Please go to epson.com/recycle for
information on how to return your products for proper disposal.

Windows System Requirements
Mac System Requirements

Printing Specifications

Scanning Specifications

Automatic Document Feeder (ADF) Specifications
Fax Specifications

Paper Specifications

Printable Area Specifications

Ink Cartridge Specifications
Memory Card Specifications
Dimension Specifications

Electrical Specifications
Environmental Specifications
Interface Specifications

External USB Device Specifications
Network Interface Specifications
Safety and Approvals Specifications

Windows System Requirements

To use your product and its software, your computer should use one of these Microsoft operating
systems:

* Windows 8

* Windows 7

* Windows Vista

» Windows XP Professional x64 Edition
* Windows XP SP3
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Note: Visit Epson's support website at epson.com/support (U.S.) or epson.ca/support (Canada) for the
latest in compatibility and drivers for your product.

Parent topic: Technical Specifications

Mac System Requirements
To use your product and its software, your Mac should use one of these operating systems:
* Mac OS X 10.5.8
* Mac OS X 10.6.x
¢ Mac OS X 10.7.x
* Mac OS X 10.8.x

Note: Visit Epson's support website at epson.com/support (U.S.) or epson.ca/support (Canada) for the
latest in compatibility and drivers for your product.

Parent topic: Technical Specifications
Printing Specifications

Paper path Paper cassette 1 (upper) and cassette 2 (lower), front entry
Rear paper feed slot, top entry

Capacity 0.24 inch (6.0 mm) for cassette 1*
0.43 inch (11.0 mm) for cassette 2**

One sheet between 0.002 (0.05 mm) to 0.024 inch (0.6 mm)
thickness for the rear paper slot

* Approximately 100 sheets at 20 Ib (75 g/m?) in cassette 1
** Approximately 20 sheets of Epson Premium Photo Paper Glossy in cassette 2
Parent topic: Technical Specifications

Scanning Specifications

Scanner type Flatbed, color
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Photoelectric device CIs

Effective pixels 40800 x 56160 pixels at 4800 dpi
Document size Maximum: 8.5 x 11.7 inches (216 x 297 mm)
Scanner glass: US letter or A4
Scanning resolution 4800 dpi (main scan)
4800 dpi (sub scan)
Output resolution 50 to 4800, 7200, and 9600 dpi
(50 to 4800 dpi in 1 dpi increments)
Image data 16 bits per pixel per color internal

8 bits per pixel per color external (maximum)
Light source LED

Parent topic: Technical Specifications

Automatic Document Feeder (ADF) Specifications

Paper input Faceup loading

Paper output Facedown ejection

Paper size US letter, legal, or A4 size*
Paper type Plain paper

Paper weight 17 Ib (64 g/m?) to 24 Ib (95 g/m?)
Sheet feeding capacity Total thickness: 0.12 inch (3 mm)

Approximately 30 sheets (US letter or A4) or 10 sheets (legal)

* You cannot use the 2-sided scanning feature with legal size paper.
Parent topic: Technical Specifications

Fax Specifications

Fax type Black and white and color fax capability
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Support line Household phone line, PBX telephone system
Speed Up to 33.6 kbps
Resolution Monochrome

Standard: 200 x 100 dpi

Fine: 200 x 200 dpi

Photo: 200 x 200 dpi

Color

Fine: 200 x 200 dpi

Photo: 200 x 200 dpi
Error correction mode CCITU/ITU Group 3 fax with error correction mode
Speed dial/group dial numbers Up to 60 (combined)

Page memory Up to 180 (ITU-T No. 1 chart)
Redial 2 times (with 1 minute interval)
Interface RJ-11 Phone Line

RJ-11 Telephone set connection
Parent topic: Technical Specifications
Paper Specifications

Note: Since the quality of any particular brand or type of paper may be changed by the manufacturer at
any time, Epson cannot guarantee the quality of any hon-Epson brand or type of paper. Always test a
sample of paper stock before purchasing large quantities or printing large jobs.
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Single-sheets

Size

Paper types
Thickness
Weight

Envelopes

Size
Paper types
Weight

A4 (8.3 x 11.7 inches [210 x 297 mm])

A6 (4.1 x 5.8 inches [105 x 148 mm])

Letter (8.5 x 11 inches [216 x 279 mm])
Legal (8.5 x 14 inches [216 x 357 mm])

4 x 6 inches (102 x 152 mm)

5 x 7 inches (127 x 178 mm)

8 x 10 inches (203 x 254 mm)

3.5x 5inches (89 x 127 mm)

16:9 wide (4 x 7.1 inches [102 x 181 mm])
Half Letter (5.5 x 8.5 inches [140 x 279 mm])
Plain paper and paper distributed by Epson
0.003 inch (0.08 mm) to 0.004 inch (0.11 mm)
17 Ib (64 g/m?) to 24 Ib (90 g/m?)

No. 10 (4.1 x 9.5 inches [105 x 241 mm])
Plain bond paper
20 Ib (75 g/m?) to 24 Ib (90 g/m?)

Parent topic: Technical Specifications

Printable Area Specifications

Note: When printing borderless, quality may decline in the expanded printable area.
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Single sheets

_f__. _________ l

Top: 0.12 inch (3.0 mm) minimum
Left: 0.12 inch (3.0 mm) minimum
Right: 0.12 inch (3.0 mm) minimum
Bottom: 0.12 inch (3.0 mm) minimum

A W N PP

Envelopes

-y

i
F
L

Left: 0.12 inch (3.0 mm) minimum
Bottom: 0.20 inch (5.0 mm) minimum
Top: 0.20 inch (5.0 mm) minimum
Right: 0.83 inch (21.0 mm) minimum

A W N P
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CD/DVDs
12-cm CD/DVDs

=
. |

1 0.7 inch (18 mm) minimum inner margin
2 4.7 inch (120 mm) maximum outer margin

Note: Avoid printing in the clear plastic areas of discs to prevent staining the disc with ink.

Parent topic: Technical Specifications

Ink Cartridge Specifications

Note: We recommend that you use genuine Epson cartridges and do not refill them. The use of other
products may affect your print quality and could result in printer damage.

The cartridges included with the printer are designed for printer setup and not for resale. After some ink
is used for priming, the rest is available for printing. Yields vary considerably based on images printed,
print settings, paper type, frequency of use, and temperature. For print quality, a variable amount of ink
remains in the cartridge after the "replace cartridge" indicator comes on.

Color Black, Photo Black, Cyan, Magenta, Yellow

Cartridge life Opened package: 6 months
Unopened package: do not use if the date on the package has
expired

340



Temperature Storage: —4 to 104 °F (—20 to 40 °C)
1 month at 104 °F (40 °C)
Ink freezes at 3.2 °F (-16 °C)
Ink thaws and is usable after 3 hours at 77 °F (25 °C)

Note: For best printing results, use up a cartridge within 6 months of opening the package.

Parent topic: Technical Specifications

Related references
Ink Cartridge Part Numbers

Memory Card Specifications

Note: Cards marked with an asterisk (*) require an adapter; consult your adapter documentation for
details on using it.

Compatible types Memory Stick Duo
Memory Stick PRO Duo
Memory Stick PRO-HG Duo
Memory Stick Micro*
MagicGate Memory Stick Duo
SDXC
SDHC
SD
miniSDHC*
miniSD*
microSDXC*
microSDHC*
microSD*

Media format DCF DCF (Design rule for Camera File system) version 1.0 or 2.0
compliant
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Voltage requirements 3.3V

Parent topic: Technical Specifications

Related references
Memory Card File Specifications

Dimension Specifications

Height Stored: 7.5 inches (191 mm)
Printing: 8.1 inches (207 mm)
Width Stored: 15.4 inches (390 mm)
Printing: 17.2 inches (438 mm)
Depth Stored: 13.3 inches (339 mm)
Printing: 23.5 inches (598 mm)
Weight 18.11b (8.2 kg)

(without ink cartridges)
Parent topic: Technical Specifications

Electrical Specifications

Power supply rating 100to 120 V

Input voltage range 90to 132V

Rated frequency range 50/60 Hz

Input frequency range 49.5/60.5 Hz

Rated current 0.7A

Power consumption Standalone copying: 19 W (ISO/IEC24712)

Ready mode: 7.0 W
Sleep mode: 2.0 W
Power off mode: 0.2 W

342



Parent topic: Technical Specifications

Environmental Specifications

Temperature Operating: 50 to 95 °F (10 to 35 °C)
Storage: —4 to 104 °F (—20 to 40 °C)
1 month at 104 °F (40 °C)

Humidity Operating: 20 to 80% RH

(non-condensing) Storage: 5 to 85% RH

Parent topic: Technical Specifications

Interface Specifications

Interface type Hi-Speed USB (Device Class for computers)

Hi-Speed USB (for PictBridge compliant device/Mass storage class
for external storage)*

* Epson cannot guarantee the operation of externally connected devices.
Parent topic: Technical Specifications

External USB Device Specifications

Note: Use only external storage devices with independent AC power sources. External storage devices
that are powered via USB are not recommended.

CD-ROM/CD-R drive 700MB maximum capacity
CD-RW is not supported
DVD-ROM/DVD-R drive 4.7GB maximum capacity
DVD-RW, DVD+R, DVD+RW, and Blu-ray Disc are not supported
Magneto-optical drive 1.3GB
Hard disk and USB flash 2TB
drives

Formatted in FAT, FAT32, or exFAT.
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Parent topic: Technical Specifications

Network Interface Specifications

Wi-Fi
Standard IEEE 802.11 b/g/n
Security WPA-PSK (TKIP/AES); WPA2 compliant
WEP (64/128 bit)
Frequency band 2.4 GHz
Communication mode Infrastructure mode
Ad hoc mode
Wi-Fi Direct

Note: Wireless LAN standard complies with either IEEE 802.11 b/g or IEEE 802.11 b/g/n, depending on
purchase location.

Ethernet
Standard IEEE802.3i/u, IEEE802.3az*
Communication mode Ethernet 100BASE-TX/10BASE-T

* The connected device should be IEEE802.3az compliant.
Parent topic: Technical Specifications

Safety and Approvals Specifications

United States Safety: UL60950-1
EMC: FCC part 15 Subpart B class B
Canada Safety: CAN/CSA C22.2 No. 60950-1

EMC: CAN/CSA-CEI/IEC CISPR 22 Class B
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This equipment contains the following wireless module:
» Manufacturer: Askey Computer Corporation.
* Type: WLU6117-D69 (RoOHS)

This product conforms to Part 15 of FCC Rules and RSS-210 of the IC Rules. Epson cannot accept
responsibility for any failure to satisfy the protection requirements resulting from a non-recommended
modification of the product. Operation is subject to the following two conditions: (1) this device may not
cause harmful interference, and (2) this device must accept any interference received, including
interference that may cause undesired operation of the device.

To prevent radio interference to the licensed service, this device is intended to be operated indoors and
away from windows to provide maximum shielding. Equipment (or its transmit antenna) that is installed
outdoors is subject to licensing.

Parent topic: Technical Specifications
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Notices

Check these sections for important notices about your product.

Note: Epson offers a recycling program for end of life products. Please go to epson.com/recycle for
information on how to return your products for proper disposal.

Important Safety Instructions
FCC Compliance Statement
Software Notice
Trademarks

Copyright Notice

Important Safety Instructions

General Pr

Before using your Epson product, read and follow these safety instructions.

General Product Safety Instructions

Ink Cartridge Safety Instructions

LCD Screen Safety Instructions

Wireless Connection Safety Instructions
Telephone Equipment Safety Instructions

Parent topic: Notices

oduct Safety Instructions
» Be sure to follow all warnings and instructions marked on the product.
» Use only the type of power source indicated on the product's label.

» Use only the power cord that comes with the product. Use of another cord may cause fires or shock.
Do not use the cord with any other equipment.

» Place the product near a wall outlet where the plug can be easily unplugged.

» Avoid plugging the product into an outlet on the same circuit as a photo copier or air control system
that regularly switches on and off, or on an outlet controlled by a wall switch or timer.

» Do not let the power cord become damaged or frayed. Place it to avoid abrasions, cuts, fraying,
crimping, and kinking. Do not place objects on top of it and do not allow it to be stepped on or run over.
Be careful to keep the cord straight at each end.
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If you use an extension cord with the product, make sure the total ampere rating of the devices
plugged into the extension cord does not exceed the cord's ampere rating. Also, make sure the total
ampere rating of all devices plugged into the wall outlet does not exceed the wall outlet's ampere
rating.

Always turn off the product using the power button, and wait until the power light stops flashing before
unplugging the product or cutting off power to the electrical outlet.

If you will not be using the product for a long period, unplug the power cord from the electrical outlet.

Place the product on a flat, stable surface that extends beyond its base in all directions. It will not
operate properly if it is tilted or at an angle.

Make sure the back of the product is at least 4 inches (10 cm) away from the wall.

Allow space behind the product for the cables, and space above the product so that you can fully raise
the document cover.

Leave enough space in front of the product for the paper to be fully ejected.

Avoid locations that are subject to rapid changes in heat or humidity, shocks or vibrations, or dust.
Do not place or store the product outdoors.

Do not place the product near excessive heat sources or in direct sunlight.

Leave enough room around the product for sufficient ventilation. Do not block or cover openings in the
case or insert objects through the slots.

Keep the product away from potential sources of electromagnetic interference, such as loudspeakers
or the base units of cordless telephones.

When connecting the product to a computer or other device with a cable, ensure the correct
orientation of the connectors. Each connector has only one correct orientation. Inserting a connector
in the wrong orientation may damage both devices connected by the cable.

Do not touch the flat white cable inside the product.
Do not move the print head by hand; this may damage the product.
Do not spill liquid on the product or use the product with wet hands.

Do not use aerosol products that contain flammable gases inside or around the product. Doing so may
cause fire.

Do not press too hard on the document table when placing originals.

Do not open the scanner section while the product is copying, printing, scanning, or performing any
other functions.

Be careful not to trap your fingers when closing the document cover or scanner.
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Except as specifically explained in your documentation, do not attempt to service the product yourself.

Unplug the product and refer servicing to qualified service personnel under the following conditions: if
the power cord or plug is damaged,; if liquid has entered the product; if the product has been dropped
or the case damaged,; if the product does not operate normally or exhibits a distinct change in
performance. Adjust only those controls that are covered by the operating instructions.

Leave the ink cartridges installed. Removing the cartridges can dehydrate the print head and may
prevent the product from printing.

Before transporting the product, make sure that the print head is in the home (far right) position and
the ink cartridges are in place.

When storing or transporting the product, do not tilt it, stand it on its side, or turn it upside down;
otherwise ink may leak.

Parent topic: Important Safety Instructions

Ink Cartridge Safety Instructions

Keep ink cartridges out of the reach of children and do not drink the ink.

Be careful when you handle used ink cartridges; there may be ink remaining around the ink supply
port. If ink gets on your skin, wash it off with soap and water. If it gets in your eyes, flush them
immediately with water.

Do not put your hand inside the product or touch any cartridges during printing.

Install a new ink cartridge immediately after removing an expended one. Leaving cartridges
uninstalled can dry out the print head and may prevent the product from printing.

Do not touch the green IC chip on the side of the cartridge. This may prevent normal operation.
Do not shake cartridges after opening their packages; this can cause them to leak.

If you remove an ink cartridge for later use, recap the ink cartridge using the cap that came with it to
prevent the ink from drying out and to protect the surrounding area from getting smeared by ink.

Use an ink cartridge before the date printed on its package.
Do not dismantle an ink cartridge. This could damage the print head.
Store ink cartridges in a cool, dark place.

After bringing an ink cartridge inside from a cold storage site, allow it to warm up at room temperature
for at least three hours before using it.

Parent topic: Important Safety Instructions
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LCD Screen Safety Instructions
» Use only a dry, soft cloth to clean the LCD screen. Do not use liquid or chemical cleansers.

 Ifthe LCD screen is damaged, contact Epson. If the liquid crystal solution gets on your hands, wash
them thoroughly with soap and water. If the liquid crystal solution gets into your eyes, flush them
immediately with water. If discomfort or vision problems remain after a thorough flushing, see a doctor
immediately.

» Do not press too hard on the LCD screen.
» Do not use a pointy or sharp object, such as a pen or your fingernail, to operate the LCD screen.
Parent topic: Important Safety Instructions

Wireless Connection Safety Instructions

To avoid adversely affecting the operation of the following equipment and causing an accident, do not
use the product:

» Near medical equipment in a medical facility.

» Within 8.7 inches (22 cm) of a cardiac pacemaker.

» Near automatically controlled devices, such as automatic doors or fire alarms.
Parent topic: Important Safety Instructions

Telephone Equipment Safety Instructions

When using telephone equipment, you should always follow basic safety precautions to reduce the risk
of fire, electric shock, and personal injury, including the following:

» Do not use the Epson product near water.

» Avoid using a telephone during an electrical storm. There may be a remote risk of electric shock from
lightning.

» Do not use a telephone to report a gas leak in the vicinity of the leak.

Caution: To reduce the risk of fire, use only a No. 26 AWG or larger telecommunication line cord.

Parent topic: Important Safety Instructions
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FCC Compliance Statement

For United States Users

This equipment complies with Part 68 of the FCC rules and the requirements adopted by the
Administrative Council for Terminal Attachments ("ACTA") . On the surface of this equipment is a label
that contains, among other information, a product identifier in the format US:AAAEQ##TXXXX. If
requested, this number must be provided to the telephone company.

Applicable certification jack Universal Service Order Codes ("USOC") for the equipment: RJ11C.

A plug and jack used to connect this equipment to the premises wiring and telephone network must
comply with the applicable FCC Part 68 rules and requirements adopted by the ACTA. A compliant
telephone cord and modular plug is provided with this product. It is designed to be connected to a
compatible modular jack that is also compliant. See installation instructions for details.

The REN is used to determine the number of devices that may be connected to a telephone line.
Excessive RENs on a telephone line may result in the devices not ringing in response to an incoming
call. In most but not all areas, the sum of RENs should not exceed five (5.0). To be certain of the number
of devices that may be connected to a line, as determined by the total RENs, contact the local telephone
company. For products approved after July 23, 2001 , the REN for this product is part of the product
identifier that has the format US:AAAEQ##TXXXX. The digits represented by ## are the REN without a
decimal point (e.g., 03 is a REN of 0.3). For earlier products, the REN is separately shown on the label.

If this equipment causes harm to the telephone network, the telephone company will notify you in
advance that temporary discontinuance of service may be required. But if advance notice isn't practical,
the telephone company will notify the customer as soon as possible. Also, you will be advised of your
right to file a complaint with the FCC if you believe it is necessary.

The telephone company may make changes in its facilities, equipment, operations or procedures that
could affect the operation of the equipment. If this happens the telephone company will provide advance
notice in order for you to make necessary modifications to maintain uninterrupted service.

If you have problems with this product and require technical or customer support, please visit
www.epson.com for more information.

This product is not intended to be repaired by the customer. If you experience trouble connecting this
equipment to a telephone line, please contact:

Name: Epson America, Inc.
Address: 3840 Kilroy Airport Way, Long Beach, CA 90806 U.S.A.
Telephone: (562) 981-3840

If the equipment is causing harm to the telephone network, the telephone company may request that you
disconnect the equipment until the problem is resolved.
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This equipment may not be used on coin service provided by the telephone company. Connection to
party line service is subject to state tariffs. Contact the state public utility commission, public service
commission or corporation commission for information.

If your home has specially wired alarm equipment connected to the telephone line, ensure the
installation of this equipment does not disable your alarm equipment. If you have questions about what
will disable alarm equipment, consult your telephone company or a qualified installer.

The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to use a computer or
other electronic device, including fax machines, to send any message unless such message clearly
contains in a margin at the top or bottom of each transmitted page or on the first page of the
transmission, the date and time it is sent and an identification of the business or other entity, or other
individual sending the message and the telephone number of the sending machine or such business,
other entity, or individual. (The telephone number provided may not be a 900 number or any other
number for which charges exceed local or long-distance transmission charges.)

In order to program this information into your fax machine, follow the instructions in "Entering Fax
Header Information".

According to the FCC's electrical safety advisory, we recommend that you may install an AC surge
arrester in the AC outlet to which this equipment is connected. Telephone companies report that
electrical surges, typically lightning transients, are very destructive to customer terminal equipment
connected to AC power sources and that this is a major nationwide problem.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant
to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful
interference in a residential installation. This equipment generates, uses, and can radiate radio
frequency energy and, if not installed and used in accordance with the instructions, may cause harmful
interference to radio or television reception. However, there is no guarantee that interference will not
occur in a particular installation. If this equipment does cause interference to radio and television
reception, which can be determined by turning the equipment off and on, the user is encouraged to try to
correct the interference by one or more of the following measures:

» Reorient or relocate the receiving antenna.
* Increase the separation between the equipment and receiver.

Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

Consult the dealer or an experienced radio/TV technician for help.

WARNING

The connection of a non-shielded equipment interface cable to this equipment will invalidate the FCC
Certification or Declaration of this device and may cause interference levels which exceed the limits
established by the FCC for this equipment. It is the responsibility of the user to obtain and use a shielded
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equipment interface cable with this device. If this equipment has more than one interface connector, do
not leave cables connected to unused interfaces. Changes or modifications not expressly approved by
the manufacturer could void the user’s authority to operate the equipment.

For Canadian Users
1. This product meets the applicable Industry Canada technical specifications.

2. The Ringer Equivalence Number is an indication of the maximum number of devices allowed to be
connected to a telephone interface. The termination on an interface may consist of any combination of
devices subject only to the requirement that the sum of the RENSs of all the devices does not exceed five.
CAN ICES-3(B)/NMB-3(B)

Le présent matériel est conforme aux spécifications techniques applicables d’Industrie Canada.

L’indice d'équivalence de la sonnerie (IES) sert a indiquer le nombre maximal de terminaux qui peuvent
étre raccordés a une interface téléphonique. La terminaison d’une interface peut consister en une
combinaison quelcongue de dispositifs, a la seule condition que la somme d’indices d’équivalence de la
sonnerie de tous les dispositifs n’excéde pas 5.

CAN ICES-3(B)/NMB-3(B)

Parent topic: Notices

Software Notice

1. This printer product includes open source software programs listed in Section 6) according to the
license terms of each open source software program.

2. We provide the source code of the GPL Programs, LGPL Programs, Apache License Program and
ncftp license Program (each is defined in Section 6) until five (5) years after the discontinuation of
same model of this printer product. If you desire to receive the source code above, please contact the
customer support of your region. You shall comply with the license terms of each open source
software program.

3. The open source software programs are WITHOUT ANY WARRANTY:; without even the implied
warranty of MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. See the license
agreements of each open source software program for more details, which are described in OSS.pdf
on your Printer Software CD.

4. OpenSSL toolkit

This printer product includes software developed by the OpenSSL project for use in the OpenSSL
Toolkit (http://www.openssl.org/).

This product includes cryptographic software written by Eric Young (eay@cryptsoft.com).
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5. The license terms of each open source software program are described in OSS.pdf on your Printer
Software CD.

6. The list of open source software programs which this printer product includes are as follows.
GNU GPL

This printer product includes the open source software programs which apply the GNU General Public
License Version 2 or later version ("GPL Programs").

The list of GPL Programs:
linux-2.6.35-arm1-epson12
busybox-1.17.4

udhcp 0.9.8cvs20050124-5
ethtool-2.6.35

GNU LGPL

This printer product includes the open source software programs which apply the GNU Lesser General
Public License Version 2 or later version ("LGPL Programs").

The list of LGPL Programs:
uclibc-0.9.32

libusb-1.0.8

zeroconf 0.6.1-1
iksemel-rev25

Apache License

This printer product includes the open source software program "Bonjour" which apply the Apache
License Version2.0 ("Apache License Program").

Bonjour License

This printer product includes the open source software program "Bonjour " which applies the terms and
conditions provided by owner of the copyright to the "Bonjour ".

Net-SNMP license

This printer product includes the open source software program "Net-SNMP" which applies the terms
and conditions provided by owner of the copyright to the "Net-SNMP".

OpenSSL License/Original SSLeay License
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This printer product includes t he open source software program "OpenSSL toolkit" which applies the
license terms of OpenSSL License and Original SSLeay License.

BSD License (Berkeley Software Distribution License)

This printer product includes the open source software program "busybox-1.17.4 " which apply the
Berkeley Software Distribution License ("BSD Program").

Sun RPC License

This printer product includes the open source software program "busybox-1.17.4 " which apply the Sun
RPC License ("Sun RPC Program").

ncftp license

This printer product includes the open source software program "ncftp-3.2.4 " which applies the terms
and conditions provided by owner of the copyright to the "ncftp ".

ARCA4 license

This printer product includes the open source software program "ARC4" which applies the terms and
conditions provided by owner of the copyright to the "ARC4".

json_parserlicense

This printer product includes the open source software program "json_parser" which applies the terms
and conditions provided by owner of the copyright to the " json_parser ".

MDS5 license

This printer product includes the open source software program "MD5" which applies the terms and
conditions provided by owner of the copyright to the " MD5 ".

AES license

This printer product includes the open source software program "AES" which applies the terms and
conditions provided by owner of the copyright to the "AES".

SHAI1 license

This printer product includes the open source software program "SHAL" which applies the terms and
conditions provided by owner of the copyright to the "SHA1".

Parent topic: Notices

Trademarks

EPSON® and Supplies Central® are registered trademarks; EPSON Exceed Your Vision is a registered
logomark; and Epson Connect™, Epson iPrint™, and Remote Print™ are trademarks of Seiko Epson
Corporation.
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Epson Store®" is a service mark of Epson America, Inc.

Apple, iPad, iPhone, iPod touch, Mac, and Mac OS are trademarks of Apple Inc., registered in the U.S.
and other countries. AirPrint is a trademark of Apple Inc.

General Notice: Other product names used herein are for identification purposes only and may be
trademarks of their respective owners. Epson disclaims any and all rights in those marks.

EPSON

EXCEED YOUR VISION

Parent topic: Notices

Copyright Notice

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or
transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise,
without the prior written permission of Seiko Epson Corporation. The information contained herein is
designed only for use with this Epson product. Epson is not responsible for any use of this information as
applied to other products.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third
parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of:
accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to this
product, or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation's operating and
maintenance instructions.

Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any
options or any consumable products other than those designated as Original Epson Products or Epson
Approved Products by Seiko Epson Corporation.

Seiko Epson Corporation shall not be held liable for any damage resulting from electromagnetic
interference that occurs from the use of any interface cables other than those designated as Epson
approved Products by Seiko Epson Corporation.

This information is subject to change without notice.

libTIFF Software Acknowledgment

A Note Concerning Responsible Use of Copyrighted Materials
Default Delay Times for Power Management for Epson Products
Copyright Attribution

Parent topic: Notices
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libTIFF Software Acknowledgment
Copyright © 1988-1997 Sam Leffler
Copyright © 1991-1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose
is hereby granted without fee, provided that () the above copyright notices and this permission notice
appear in all copies of the software and related documentation, and (ii) the names of Sam Leffler and
Silicon Graphics may not be used in any advertising or publicity relating to the software without the
specific, prior written permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EXPRESS,
IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL,
INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES
WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT
ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT
OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

Parent topic: Copyright Notice

A Note Concerning Responsible Use of Copyrighted Materials

Epson encourages each user to be responsible and respectful of the copyright laws when using any
Epson product. While some countries' laws permit limited copying or reuse of copyrighted material in
certain circumstances, those circumstances may not be as broad as some people assume. Contact your
legal advisor for any questions regarding copyright law.

Parent topic: Copyright Notice

Default Delay Times for Power Management for Epson Products

This product will enter sleep mode after a period of nonuse. This is to ensure that the product meets
Energy Star standards of energy efficiency. More energy savings can be achieved by setting the time to
sleep to a shorter interval.

Parent topic: Copyright Notice

Copyright Attribution
© 2014 Epson America, Inc.
2/14
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CPD-39348R1
Parent topic: Copyright Notice
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